Proficy* HMI/SCADA - iFIX

Understanding iFIX

Version 5.5
January 2012
Disclaimer of Warranties and Liability

The information contained in this manual is believed to be accurate and reliable. However, GE Intelligent Platforms, Inc. assumes no responsibilities for any errors, omissions or inaccuracies whatsoever. Without limiting the foregoing, GE Intelligent Platforms, Inc. disclaims any and all warranties, expressed or implied, including the warranty of merchantability and fitness for a particular purpose, with respect to the information contained in this manual and the equipment or software described herein. The entire risk as to the quality and performance of such information, equipment and software, is upon the buyer or user. GE Intelligent Platforms, Inc. shall not be liable for any damages, including special or consequential damages, arising out of the use of such information, equipment and software, even if GE Intelligent Platforms, Inc. has been advised in advance of the possibility of such damages. The user of the information contained in the manual and the software described herein is subject to the GE Intelligent Platforms, Inc. standard license agreement, which must be executed by the buyer or user before the use of such information, equipment or software.

Notice

©2012 GE Intelligent Platforms, Inc. All rights reserved. *Trademark of GE Intelligent Platforms, Inc.

Microsoft® is a registered trademark of Microsoft Corporation, in the United States and/or other countries.

All other brands or names are property of their respective holders.

We want to hear from you. If you have comments, questions, or suggestions about our documentation, send them to the following email address:

doc@ge.com
# Table of Contents

About This Guide .............................................................................................................................. 1  
Reference Documents .................................................................................................................. 1  
Introduction to iFIX ............................................................................................................................ 3  
iFIX Components .................................................................................................................................. 3  
Using iFIX with Other Proficy Applications ............................................................................... 4  
Enabling Technologies ................................................................................................................. 5  
OLE for Process Control (OPC) ............................................................................................... 5  
Visual Basic for Applications (VBA) .......................................................................................... 5  
ActiveX...................................................................................................................................... 6  
System Architecture ......................................................................................................................... 7  
Understanding the iFIX Nodes ..................................................................................................... 8  
Nodes in iFIX ............................................................................................................................ 8  
Universal Data Access ................................................................................................................. 9  
OLE, OPC, and ActiveX Support ............................................................................................ 10  
Open Database Connectivity (ODBC) Support ............................................................................ 10  
I/O Drivers................................................................................................................................... 10  
Data Flow................................................................................................................................ 10  
Process Database ....................................................................................................................... 11  
Scan, Alarm, and Control Program............................................................................................. 12  
Time-Based Processing .............................................................................................................. 13  
Exception-Based Processing ..................................................................................................... 13  
One-Shot Processing .................................................................................................................. 13  
Scheduler.................................................................................................................................... 13  
Distributed Networking ............................................................................................................ 14  
Distributed Processing .............................................................................................................. 14  
On Demand Data Transfer ....................................................................................................... 15
| Understanding the System Tree                                                                 | 32 |
| Understanding the Work Area                                                                       | 33 |
| Using the Virtual Keyboard                                                                         | 34 |
| Locating Classic View Menu Commands in Ribbon View                                                 | 36 |
| Using the System Tree                                                                               | 44 |
| Understanding System Tree Paths                                                                     | 46 |
| Showing and Hiding the System Tree                                                                   | 46 |
| Navigating the System Tree                                                                          | 47 |
| Opening and Closing Folders                                                                         | 48 |
| Right-Clicking the System Tree                                                                       | 49 |
| Dragging and Dropping Files                                                                         | 49 |
| Starting Applications from the System Tree                                                          | 50 |
| Understanding WorkSpace Environments                                                                | 50 |
| Displaying the WorkSpace Full-Screen                                                                | 50 |
| Enabling Environment Protection                                                                     | 51 |
| Disabling Error Dialog Boxes                                                                        | 51 |
| Disabling Proficy Historian Errors in the WorkSpace                                                 | 51 |
| Working with Documents                                                                               | 52 |
| Opening Documents                                                                                    | 52 |
| Deleting and Renaming Documents                                                                     | 52 |
| Using Word and Excel in the WorkSpace                                                               | 53 |
| Understanding Toolbars                                                                               | 53 |
| Showing and Hiding Toolbars                                                                         | 54 |
| Understanding Toolbar Owners                                                                        | 54 |
| Customizing Toolbars                                                                                 | 55 |
| Creating Toolbars                                                                                    | 55 |
| Creating Buttons                                                                                    | 56 |
| Sharing Toolbars and Toolbar Buttons                                                                | 57 |
# Table Of Contents

Get Project Dialog Box ........................................................................................................... 98
Import Toolbars Dialog Box ..................................................................................................... 99
Modify Server Dialog Box ...................................................................................................... 100
Multiple Command Script Wizard Dialog Box ....................................................................... 100
Proficy iFIX Project Backup Dialog Box ................................................................................ 101
Proficy iFIX Project Backup Wizard ...................................................................................... 102
Proficy iFIX Restore Wizard .................................................................................................. 103
Task Wizard Dialog Box ......................................................................................................... 105
Toolbars Dialog Box ............................................................................................................... 105
User Preferences Dialog Box ................................................................................................. 106

How Do I... ................................................................................................................................ 126

Using the System Tree ............................................................................................................ 126
Working with Files ................................................................................................................. 127
Starting Applications and Experts ......................................................................................... 131
Working with the WorkSpace Environments ......................................................................... 132
Customizing the Ribbon User Interface ................................................................................. 135
Setting Preferences ............................................................................................................... 140
Selecting Data Sources and Building Expressions ............................................................... 146
Managing Files and Nodes ................................................................................................. 149
Installing the Proficy Historian Server ................................................................................. 155
Working with Toolbars ...................................................................................................... 162
Installing a Third-Party OPC Server .................................................................................... 169
Managing iFIX Nodes ........................................................................................................... 173
Configuring the Local Computer ......................................................................................... 173
Sharing Files .......................................................................................................................... 173
Configuring the Picture Path ............................................................................................... 174
Finding and Replacing Data ................................................................................................. 174
Using Wildcards ................................................................................................................... 176
Running the Sample System with iFIX ............................................................... 218
Using the Sample System with a Terminal Server ........................................... 218
Using the Sample System with Picture Caching ............................................... 218
Starting the Sample System ............................................................................... 219
Accessing Other Desktop Applications ............................................................ 220
Using the Sample System Help ......................................................................... 220
Getting Help for an Object or Picture ............................................................... 220
Displaying ToolTips ......................................................................................... 220
Clicking the Help File Button from a Picture .................................................. 220
Working with the Sample System Demos .......................................................... 220
Understanding the Alarm Summary, Trending Chart, and Reporting Screens ...... 220
Using Configure and Run Modes ..................................................................... 221
Navigating through the Demos ......................................................................... 221
Parts of the Demos ......................................................................................... 221
Parts of the Water & Wastewater Demo ............................................................ 222
Parts of the Discrete Manufacturing Demo ........................................................ 223
Parts of the Specialty Chemical Demo ............................................................... 224
Parts of the Pharmaceutical Manufacturing Demo ......................................... 226
Quick Tour of the Discrete Manufacturing Demo ............................................ 229
  The Annealing Process .................................................................................. 229
  Manufacturing Step Indicator ........................................................................ 229
  Alarm Summary Object ................................................................................. 229
Quick Tour of the Water & Wastewater Demo ............................................... 229
  Exploring Tag Groups and Pop-up Pictures ..................................................... 230
Quick Tour of the Chemical Demo ................................................................. 231
  Exploring Picture Layers ............................................................................... 231
  Exploring ToolTips ...................................................................................... 232
  Exploring VisiconX ....................................................................................... 232
Quick Tour of the Pharmaceutical Demo ................................................................. 234
Signing When Starting and Stopping the Mixer ...................................................... 235
Signing When Using an Expert .............................................................................. 236
Signing When Acknowledging Alarms ................................................................. 236
Viewing the Audit Trail from a Relational Database ............................................ 236
Exploring Trending ............................................................................................... 236
Exploring Alarms and Alarm Counters ............................................................... 238
About This Guide

The Understanding iFIX manual is intended for all iFIX® users. It provides an overview of the structure and functions of iFIX, the Proficy iFIX WorkSpace, the iFIX Help and electronic books, and the iFIX Sample System.

Reference Documents

For related information on subjects discussed in this manual, refer to the following documents:

- Setting up the Environment
- Building a SCADA System
- Implementing Alarms and Messages
- Configuring Security Features
- Using Electronic Signatures
- Creating Pictures
- Writing Scripts
- Trending Historical Data
- Mastering iFIX
Introduction to iFIX

iFIX® is a Windows-based HMI/SCADA component of the Proficy family of software automation products. Based on open, component-based technology, iFIX is designed to allow easy integration and interoperability between your plant floor and business systems. It includes functional and architectural features that reduce the design time for automation projects, allow simple system upgrades and maintenance, provide seamless integration with third-party applications, and increase productivity.

The SCADA portion of iFIX provides monitoring, supervisory control, alarming, and control functions. It guarantees the absolute integrity of data and provides complete distributed networking capabilities.

The HMI portion of iFIX is the window into your process. It provides all the tools you need to develop pictures that operators can use to monitor your process.

This manual covers several fundamental concepts in iFIX:

- For information on the structure and capability of iFIX, refer to the System Architecture and the System Functions chapters.
- For information on the Proficy iFIX WorkSpace, refer to the Using the Proficy iFIX WorkSpace chapter.
- For information on managing your nodes, refer to the Managing iFIX Nodes chapter.
- For information on the electronic books, refer to the Using the Electronic Books chapter.
- For information on the Sample System provided with your iFIX software, refer to the Using the iFIX Sample System chapter.

iFIX Components

At the heart of iFIX is an enabling technology that provides a distributed architecture. iFIX is built on standard technologies, such as ActiveX, OPC, VBA, and Component Object Model (COM), to provide easy integration of third-party applications across wide area networks and the Internet. The iFIX platform hosts a number of GE Intelligent Platforms and third-party application components, some of which are illustrated in the following figure.
Understanding iFIX

An important component of iFIX is the Proficy iFIX WorkSpace. This interface organizes all system components into one integrated development environment (IDE). The Proficy iFIX WorkSpace allows you to navigate through, access, and manipulate all the components of your system.

The Proficy iFIX WorkSpace includes two fully-integrated environments known as configuration and runtime. The configuration environment provides all of the graphic, text, data, animation, and charting tools necessary to create displays that are attractive, organized, and easy to use and understand. The run-time environment provides the means necessary to view these displays in real-time. Switching between the run-time and configuration environments allows you to quickly test changes to displays while real-time alarming and data acquisition continue.

It is important to note that while you are in the configuration environment, there is no interruption to your process. All the functions that control and monitor your system, such as alarming, reporting, and scheduling, continue to run in the background. For more information on creating and viewing displays in the Proficy iFIX WorkSpace, refer to the Creating Pictures manual.

Using iFIX with Other Proficy Applications

iFIX works with the following Proficy software applications, as well as many third-party applications.

**Proficy Historian for SCADA**

Proficy Historian for SCADA is a high performance data archiving system designed to collect, store, and retrieve time-based information efficiently.

**Proficy Real-Time Information Portal**

Proficy Real-Time Information Portal is a web-based product for the visualization and analysis of the data within your plant. Proficy Portal allows users to make business sense out of plant data by providing a personalized web environment where information from the Proficy Historian can be analyzed, trended, and reported on.

**Proficy Batch Execution**

Proficy Batch Execution is the high-performance automation application that lets you model your plant, manage recipes, execute batches, create electronic batch records, and generate reports based on
any batch process. With Batch Execution, you'll have the tools necessary to reduce cycle time, increase flexibility, comply with regulatory demands, and track batch production.

**Proficy Plant Applications**

Equipment use and downtime are typically tracked and reported as key performance indicators in manufacturing companies. Proficy Plant Applications allows you to accurately report equipment efficiency, and extends your ability to analyze, understand, and address each source of downtime.

**Proficy View - Machine Edition**

The Proficy View - Machine Edition OPC Server can provide data directly into iFIX. You can display this data in your iFIX pictures, as you would with any other OPC data.

---

**Enabling Technologies**

As the solutions required by end users and system integrators become more complex, it becomes increasingly difficult to anticipate the individual needs of each customer. With this in mind, we incorporated the following industry-standard technologies into iFIX to provide a development environment that you can tailor to meet your specific requirements:

- OLE for Process Control (OPC)
- Visual Basic for Applications (VBA)
- ActiveX

**OLE for Process Control (OPC)**

OPC is a software standard designed to provide automation applications with easy access to industrial plant floor data. We have led the development of OPC through our active role in the founding of the OPC Task Force, a consortium of leading industrial automation suppliers formed to speed the development of an OLE-based communication standard. The goal of OPC is to define a standard interface based on Microsoft's Component Object Model (COM) technology that allows greater interoperability between automation and control applications; control devices; and business and office applications.

Using OPC, the Proficy iFIX WorkSpace can communicate directly with any OPC server. You can add an OPC server to your iFIX node using the Data Server Installer program. This utility, located in the Tools sub-folder of your Proficy iFIX Windows program folder, lets you add, modify, and remove OPC servers from the list of data servers available to iFIX. For more information about the Data Server Installer, refer to the Data Server Installer Dialog Box topic.

If you need to communicate with a remote OPC server, specify the machine where the remote server resides in the Machine Name field when you add an OPC Server using the Data Server Installer. Alternatively, you can also use the OPC Client driver to communicate with a remote OPC server. This driver lets you communicate with any local or remote OPC server and store the information in the process database.

**Visual Basic for Applications (VBA)**

VBA is a powerful scripting tool that is fully integrated into iFIX to let you quickly and easily
Understanding iFIX

automate operator tasks and create automation solutions. VBA scripts can be as simple or complex as you need them to be, allowing you to add custom functionality and extend iFIX as needed to accommodate your automation strategy. Its powerful and easy-to-use development environment allows you to reuse existing Visual Basic code.

VBA replaces the scripting engine used in previous versions of FIX to provide a complete, integrated development environment that is familiar to millions of developers already using Visual Basic. It provides virtually unlimited power and extensibility for accessing other iFIX components and external objects and data. The GE Intelligent Platforms implementation of VBA provides:

- Access to all exposed properties, methods, and events for iFIX objects
- Support for multiple data sources, including the iFIX process database, any OPC server, properties of other objects, and SQL databases
- ODBC support
- Support for ActiveX controls
- Script Authoring Wizards and iFIX commands to help you write scripts for common tasks
- Secure Containment™ for third-party ActiveX controls

The Proficy iFIX WorkSpace provides access to the Visual Basic Editor (VBE), a built-in editor and debugger that allows you to view, halt, suspend, and resume active scripts. In the VBE, you can write scripts for all iFIX objects, create VBA forms, access any available data source, display objects using the Object Browser, and debug your scripts. You can also use VBA to write scripts for toolbar buttons and write scripts for entries in the Scheduler.

iFIX exposes a global library of common global subroutines that can be easily changed in one place. It provides full support for thousands of commercially available objects and ActiveX controls.

This implementation of VBA includes a powerful find and replace feature, a high speed persistence feature that greatly reduces file retrieval time, and an enhanced cut and paste feature that copies all forms, modules, and scripts associated with a selected object. These enhancements significantly reduce development time and increase your system's overall performance. The unique architecture of iFIX has also allowed us to dramatically increase the speed and performance of VBA.

ActiveX

ActiveX is a set of programming technologies created by Microsoft that enables software components created in different languages to interact with one another in a networked environment. It evolved from the OLE development standard, which in recent years has expanded far beyond the concepts of object linking and embedding that formed the original acronym. iFIX is a container for ActiveX controls.

Like OLE, ActiveX is built on the COM programming model to support the full integration of software components. It supports Distributed COM (DCOM) for the transparent integration of those same components across distributed networks, including the Internet and intranets. However, ActiveX has been optimized for size and speed to allow developers to use subsets of the complex OLE interface to create highly interactive applications. ActiveX allows any OCX (ActiveX control) developed by a third-party to behave just like any object created by GE Intelligent Platforms.

To protect your system from possible problems with ActiveX controls, iFIX provides Secure Containment. Unlike most systems that support ActiveX controls, if an ActiveX control crashes while iFIX is running, it is sealed off and your system continues to run normally. With Secure Containment, there is no loss of data or interruption to your control process.
System Architecture

This chapter describes the system architecture of iFIX. It includes information about:

- Understanding the iFIX Nodes
- Universal Data Access
- Scan, Alarm, and Control Program
- Scheduler
- Distributed Networking
- Alarming
- Security
Understanding the iFIX Nodes

A node is any computer running iFIX. An actual node can be any of the node types described in the following section. To learn more about iFIX nodes, refer to the chapter Managing iFIX Nodes.

Nodes in iFIX

There are several types of nodes available using iFIX.
### Types of Nodes

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local and Remote</td>
<td>When working with a distributed iFIX system, local refers to the node on which you are currently working and remote refers to any node that you need a communication link to access.</td>
</tr>
<tr>
<td>Stand Alone</td>
<td>When working with a centralized iFIX SCADA system, stand alone refers to a node that performs all functions. Stand alone nodes do not use a network.</td>
</tr>
<tr>
<td>SCADA Server</td>
<td>A SCADA Server (or SCADA node) runs the data acquisition and management component of iFIX. Usually, a SCADA node resides on the plant floor and has direct connections to the process hardware.</td>
</tr>
<tr>
<td>Blind SCADA Server</td>
<td>A blind SCADA Server (or blind SCADA node) uses no graphics display. This configuration frees up more of a computer's resources for data acquisition and network management functions. Graphics can be viewed using an iClient.</td>
</tr>
<tr>
<td>Run-time</td>
<td>A run-time node does not let you modify graphic displays or the process database. Pre-configured files are installed on these nodes so that you can monitor the process, change process settings, and acknowledge alarms.</td>
</tr>
<tr>
<td>iClient</td>
<td>An iClient (or view node) is the most common type of node. View nodes display the real-time graphics that come with iFIX. The term view node means that the node runs the graphics display program, but the node can run other applications, as well.</td>
</tr>
<tr>
<td>iClient Read Only</td>
<td>The iClient Read Only has the same functionality as an iClient, except that you cannot write to the iFIX database or to OPC servers. You also cannot construct SQL Insert or Update commands in an iClient Read Only node. You can, however, write to a relational database. The iClient Read Only is similar in functionality to PlantTV® for FIX, with the added benefit of leveraging the iClient features, such as the event scheduler, VBA, and ActiveX controls.</td>
</tr>
</tbody>
</table>

### Universal Data Access

Typically, a plant is controlled through a network of sensors and controls connected to I/O devices, such as programmable logic controllers (PLCs). Although this type of system provides the automatic control that keeps the plant running, it is often difficult for plant personnel to see what's actually going on in the control process at any time. iFIX solves this problem by making data from various sources available to plant workers and managers in formats that are useful and easy to understand.

A data source includes the data you want to access and the information needed to get that data. The data sources available with iFIX include tags, I/O addresses, object properties, historical data, picture properties, VBA events, global variables, and expressions.
Understanding iFIX

With the open architecture of iFIX, data can be accessed from a wide variety of sources using OLE, OPC, ActiveX, and ODBC. With comprehensive client and server support for these object technologies, iFIX is able to read data from and write data to the following sources:

- Third-party applications
- Other iFIX databases
- I/O drivers

It is this ability to access data universally that gives iFIX its remarkable power and versatility.

**OLE, OPC, and ActiveX Support**

iFIX includes comprehensive OLE, OPC, and ActiveX client and server support as the foundation for providing an integrated plug and solve architecture. This technology is the primary mechanism that lets you easily integrate third-party objects and controls into iFIX and embed iFIX objects into other applications.

OLE Automation server support allows you to expose the properties of iFIX components. For example, it allows you to generate pictures without accessing the software's user interface.

**Open Database Connectivity (ODBC) Support**

ODBC support allows iFIX to access data from a database using Structured Query Language (SQL) as a standard language. Each database management system (DBMS) requires an ODBC driver, which is a dynamic-link library (DLL) used to gain access to a data source.

Among the database management systems used by iFIX are Microsoft Access (local install only), Microsoft SQL Server, and Oracle. Refer to the Using SQL manual and Writing Scripts manual for more information on ODBC support.

**I/O Drivers**

GE Intelligent Platforms provides a wide variety of high-performance I/O drivers that support best-selling and specialty I/O devices. We also offer the OPC Toolkit, a plug-in component to iFIX that lets you easily write high performance, reliable I/O servers that communicate between your process hardware and your iFIX, OLE Automation, and OPC client applications.

High performance I/O drivers provide such capabilities as automatic communication error detection, reporting, and recovery; built-in datascopes; and support for redundant communications. Receiving information from third-party servers is also supported, but typically does not offer any of the high data integrity of a high-performance I/O driver from GE Intelligent Platforms.

**Data Flow**

The flow of process data is summarized as follows:

1. iFIX reads data from various data sources.
2. Internal iFIX database access functions read the data from local or remote databases and transfer it to the requesting software applications. This transfer occurs without any operator interaction. For example, the Scan, Alarm, and Control (SAC) program processes the data and transfers the data to the process database or the Historical Chart presents the data directly to
you.

Data may also be written to the data sources by executing these steps in reverse.

Typical Data Flow Diagram

**Process Database**

The iFIX process database is a representation of the process created by linking together blocks of process control logic. The process database consists of blocks and chains. A block (also called a tag) is a coded set of process control instructions provided by GE Intelligent Platforms that perform a specific task. Most blocks can hold only one data point. Each block requires you to provide several parameters. In general, there are two types of blocks:

**Primary blocks** – start a logical chain and provide the scheduling for the chain. Typically have a scan time and handle all input and output from the database.

**Secondary blocks** – take data from the upstream block and perform some type of action or calculation.

A chain is a series of connected blocks that create a control or monitoring loop. For example, in a particular control loop, you need to read a data point, manipulate it with a standard formula, and write it out. The chain that executes this control strategy might consist of an Analog Input block connected to a Calculation block connected to an Analog Output block.

In iFIX, calculations needed for scaling or combining multiple I/O data points can also be handled directly in the graphics dynamic links. The following figure displays both control strategies.
Database Control Strategies

For complete information on creating and maintaining a database, refer to the Building a SCADA System manual.

Scan, Alarm, and Control Program

The Scan, Alarm, and Control program (SAC) is a system application that runs on a SCADA node. This program is responsible for executing the logic of the database chains. SAC performs the following functions:

- Retrieves data from various data sources
- Translates the data into the format expected by the database
- Checks the data against the alarm limits and generates alarm messages
- Executes the control logic
- Detects exceptions
- Makes requested writes to the database

Each database chain also contains the information that determines whether SAC processes the chain based on time-based, exception-based, or one-shot processing. A node can perform both time-based and exception-based processing simultaneously. This feature gives you the ability to use the best
processing strategy for each data point in your system.

**Time-Based Processing**

Most applications work by acquiring and calculating data at regular intervals, defined in seconds, minutes, or hours. iFIX can perform any combination of time-based processing. This allows you to balance system resources between data that needs to be acquired quickly and data that can be acquired over longer intervals.

SAC can perform time-based processing in:

- Subseconds (0.05 seconds to 0.95 seconds)
- Seconds
- Minutes
- Hours

The frequency with which SAC retrieves data is called the scan time. For more information on scan times, refer to the Building a SCADA System manual.

**Exception-Based Processing**

Often, it is more efficient to process data after key events occur, such as the changing of a set point or the closing of a contact. Processing that is triggered by events rather than time is known as exception-based processing.

Exception-based processing is essential for true distributed SCADA applications that monitor a large number of I/O devices. For example, an oil field may be monitoring pipelines through a large network of remote terminal units (RTUs). The data from the RTUs changes infrequently, so there's no need to acquire data at a fixed interval. However, when the data does change, oil field operators need to know about it immediately. iFIX senses the changed value and processes it immediately.

SAC can perform exception-based processing on the following events:

- Data changes in the database.
- Unsolicited messages from the process hardware.
- Operator actions.
- Instructions from software applications.

**One-Shot Processing**

When the first block in a chain has a scan time of zero, SAC processes the chain only when the primary block goes on scan. This is known as one-shot processing.

**Scheduler**

There are certain tasks that you will want to perform at a specified time or interval or when a change occurs in the process. To schedule these tasks, you will need to define the time or event that triggers the action that you want to occur. The Scheduler is a iFIX application that runs in the foreground or
Understanding iFIX

background, monitoring the system and triggering actions based on timers or events. It can be run as a service under Windows, allowing you to log in and out of a Windows node without affecting or triggering scheduled events regardless of whether or not the iFIX WorkSpace is running.

The spreadsheet design of the Scheduler lets you easily create and edit schedules in the configuration environment and view the status and statistics in the run-time environment. It provides you with the ability to create as many schedules as you need to organize your work logically and efficiently, and to run multiple schedules at the same time. Within each schedule you can create as many tasks, known as entries, as you need to run as often as you require. The Scheduler can trigger actions based on five events. These events can use most available data sources as a trigger. Time-based entries are not tied to data sources, and actions are triggered based on a monthly, daily, continuous, or one-shot basis.

Script Authoring Experts are provided for common events, such as opening a picture, running a report, or closing a contact. These Experts prompt you for information pertinent to the operation, generate a Visual Basic script, and tie the script to the appropriate event. For complete information on using the Scheduler, refer to the Scheduler section in the Mastering iFIX manual. For more information on VBA scripting, refer to the Writing Scripts manual.

Distributed Networking

iFIX networking design incorporates two basic principles: true distributed processing and on-demand data transfer. The following sections provide more information on:

- Distributed Processing
- On Demand Data Transfer
- Centralized Processing

Distributed Processing

Many systems operate in a hierarchical fashion that leave individual computers vulnerable to system failures anywhere on the network. The architecture of iFIX allows plants to distribute critical functions among all nodes on the network.

In a distributed processing network, each node independently executes the tasks assigned to it. One advantage of this strategy is that nodes can be taken off-line without bringing the whole network down. When a node looks for data from an off-line node, the networking application notifies the requesting node, so that the node handles the missing data gracefully. Even though each node has integrity as an independent station, nodes can also access data anywhere on the network. For example, an iClient can display a picture with links to many different SCADA nodes without requiring additional configuration work or the need to have a local copy of the database.

Sessions

With iFIX, you can selectively configure which nodes can access data from a SCADA node on the network. A communication link between two nodes over a network is called a session. When a node establishes a session with a SCADA node, data and alarms can be sent between the nodes. The following figure illustrates session communication.
Dynamic Connections

You can also configure your node to automatically make connections online to remote SCADA nodes that are not specifically configured on your node. These connections, called dynamic connections, are described in more detail in the Configuring Remote Nodes section in the Setting up the Environment manual.

On Demand Data Transfer

Most industrial automation software systems require every node that uses data from a SCADA node to have a copy of the entire database stored locally. The resulting network traffic can use significant system resources. To conserve system resources for local tasks, iFIX reads and writes data on demand and only moves requested data over the network.

File Storing and Sharing

Using iFIX and the built-in file sharing capabilities of Windows, you can store data that is needed by several nodes in one convenient location. Using the Windows Explorer, you can establish a networked drive connection to any other node in your local network. Once established, you have instant access to any shared files on that node, including databases, pictures, schedules, and other important iFIX files. Access to shared iFIX files by other computers can be controlled by implementing Windows security features. Refer to your Windows documentation for more information on file sharing and security.
Centralized Processing

Some applications only need one node to perform the required functions. It is easy to convert a distributed node to a stand alone node or a stand alone node to a distributed node. iFIX operates just as smoothly in a single computer environment as it does in a distributed computer environment. The following figure shows a distributed and centralized process.

Alarming

iFIX has a sophisticated system for generating, displaying, and storing alarms and messages. You may selectively route alarms and messages to the following:

- Any node on the network.
- Printers connected to a node.
- Disk-based files.
- Alarm summary displays.
- Alarm history windows.
• Relational databases.

For more information, refer to Alarm Routing.

On a local node, the programs that perform these alarm functions are called alarm tasks. iFIX also provides built-in support for the following functions:

• Acknowledging remote alarms.
• Suspending alarms (for example, during startup).
• Delaying alarms.
• Triggering scripts based on alarms.
• Filtering alarms based on type, priority, sender, etc.

Types of Alarms and Messages

iFIX generates one type of alarm and four types of messages:

Block Alarm – database blocks generate alarms when block values fall outside pre-defined limits, when a change of state occurs, or when communication errors occur.

Event Message – blocks can also send messages to printers and the alarm history file to indicate that an event occurred at that block. These messages do not appear in operator displays and do not require operator acknowledgment.

Operator Message – applications generate messages that create a history of important operator actions. These include messages that are generated by electronic signatures.

System Message – applications generate alarm messages that track system alerts and problems.

Application Message – applications, such as Recipe and Historical Collect, can also send messages to printers and the alarm history file to provide records of activity on that application.

Alarm Routing

iFIX uses a selective alarm configuration based on alarm areas, which are physical or functional divisions of your plant. An unlimited number of alarm areas are provided to serve as distribution points for alarms and messages. Each of these alarm areas can be custom named to easily identify it within your system. The first 16 alarm areas in iFIX are labeled A through P by default. Each alarm area can then be routed to send alarms and messages to selected alarm destinations.

For example, suppose you have two production lines and want to show all the alarms generated on these lines. You also want to show a separate alarm whenever the level of the tank in either production line falls below a certain level. One way to do this is to create two separate alarm areas called LINES and TANKS. Assign all the blocks that monitor these production lines to LINES and only the blocks that monitor the tanks to TANKS, as shown in the following figure. If an alarm occurs on either line, but not in the tanks, only NODE1 would receive the alarm.
Understanding iFIX

Alarm Areas

For detailed information about alarm routing refer to the Implementing Alarms and Messages manual.

Operator and Application Message Routing

Operator and application messages can be independently routed to alarm areas. This feature allows you to separate operator and application messages from alarms.

SCADA nodes act as alarm servers and distribute alarms and messages over the network. Other nodes act as alarm clients and receive alarms. When you set up a SCADA node to distribute alarms over the network, it sends the alarms and messages to every node that has a session established with it.

A non-SCADA node that generates operator messages and system alarms directs those messages to its respective SCADA nodes.

Security

iFIX provides a powerful and sophisticated user-based security system which allows you to protect against unauthorized:

- Access to iFIX applications.
- Access to critical application functions.
- Access to operator display files (pictures) and recipes.
- Write access to database blocks.

Security Areas

To protect database blocks from unauthorized writes, iFIX employs security areas. You can think of a security area as a group of database blocks with the same security level. Operators with rights to a particular security area can write to any database block that is a member of that security area.

The following figure illustrates how iFIX uses security areas.
In this example, there are two security areas known as LINE1 and LINE2. All four database blocks shown belong to LINE1, but only the two database blocks on the right belong to LINE2. The Engineering group is assigned rights to LINE1 and the Operations group is assigned rights to LINE2. Since all database blocks belong to LINE1, the Engineering group can write to all four database blocks. The Operations group is assigned rights to LINE2, but not to LINE1. Therefore, the Operations group can only write to the two database blocks on the right.

Security Application

The Security application consists of two parts: Security Configuration and Login. For complete information on configuring security and logging in, refer to the Configuring Security Features manual.

Security Configuration

The Security Configuration program allows you to do the following:

- Enable or disable security on a node.
- Create and edit user and group accounts.
- Establish automatic login at startup.
- Assign users rights to use programs and program functions, as well as write access to database blocks.
- Assign user names and passwords.
- Assign security area names.
NOTE: You can assign security protection to individual pictures in the iFIX WorkSpace and recipes in Recipe Builder.

Login

Once a node has security protection, operators must access the Login program and enter their user name and password. After logging in, operators can access the protected features of the node to which they have rights.
System Functions

iFIX provides real-time data to plant personnel and to other software applications throughout a plant. This real-time data presentation is the key to more efficient use of resources and personnel, and ultimately, to more automation.

SCADA functions include:

- Basic Functions
- HMI and SCADA Functions
- Reporting Functions
- Open Architecture Functions
- Application Functions

Basic Functions

iFIX performs basic functions that enable specific applications to perform their assigned tasks. The two most basic functions are data acquisition and data management. The following figure illustrates the basic functions of iFIX.

Data acquisition is the ability to retrieve data from the plant floor and process that data into a usable form. Data can also be written to the plant floor, thereby establishing the critical two-way link required by control software. iFIX uses OPC to request and utilize plant floor data. OPC is a client/server model with a common interface that allows iFIX to communicate with standard objects, methods, and properties. For additional information on OPC, refer to the OLE for Process Control (OPC) section.

iFIX requires no proprietary hardware to acquire data. It communicates directly with I/O devices already in place through a software interface called an I/O driver. In most cases, iFIX can work with the I/O hardware installed in your plant. Even if your plant has I/O devices from different manufacturers on the same network, I/O drivers can access and work with all of them.

We currently offer an extensive catalog of I/O drivers that support best-selling and specialty I/O devices. We also offer the OPC Toolkit, a development tool that allows you to quickly and easily write
Understanding iFIX

high performance, reliable OPC enabled I/O servers. Any server written with the toolkit can talk to OLE automation or OPC client applications. The toolkit includes an online training session, online help, and universal OLE Automation interfaces. Servers written with the OPC toolkit are open, reliable and high performing servers that incorporate multi-threading, queue-based messaging, and event-based processing.

Once data is acquired, it is manipulated and channeled according to requests from your application software. This process is known as data management.

HMI and SCADA Functions

One of the most important goals of automation is to use plant resources more efficiently. Traditionally, plant floor operations have been monitored and controlled through control room panels. iFIX can enhance or replace many of these traditional control room functions, including:

- Monitoring
- Supervisory Control
- Alarming
- Control

The following figure illustrates the HMI and SCADA functions.

Monitoring

Monitoring is the ability to gather and display real-time plant-floor data to all relevant personnel. Powerful numeric, text, and graphical formats are available to make real-time data more accessible, easier to read, and easier to understand.
Supervisory Control

Supervisory control is the ability to monitor real-time data coupled with the ability to change set points and other key values directly from your computer.

With iFIX, you can easily control who has access rights to this data and which data points can be changed.

Alarming

Alarming is the ability to recognize exceptional events within your process and immediately report those events to the appropriate personnel. Alarms are generated based on the control limits you establish and can be reported in a variety of ways.

For additional information refer to the Implementing Alarms and Messages manual.

Control

Control is the ability to automatically apply algorithms that adjust process values and thereby maintain those values within set limits. Control goes one step beyond supervisory control by removing the need for human interaction.

iFIX includes continuous control, batch control, and statistical process control capabilities. It can be used to control your whole process or part of your process.

Reporting Functions

Real-time data is only one level of information processing. Many plants require the ability to report or store real-time data for later analysis. iFIX allows you to use any third-party reporting application that supports ODBC queries to create reports based on critical system and process information. The following figure illustrates the reporting functions.
Data Archiving

Any data point in the system can be sampled and stored in data files at operator-specified rates. This archived data represents a powerful tool for process optimization and correction.

At any time, the data can be retrieved from the data files to create trend displays of historical data. Managers and engineers can use this data to examine the events leading up to a critical event after addressing more immediate problems.

Reports

Detailed reports are important tools for reviewing the performance of a process. They allow you to quickly grasp the relationships between specific pieces of manufacturing process data so that you can make effective decisions. Using any third-party reporting application that supports ODBC queries, you can create customized reports based on iFIX real-time and historical data. When you use iFIX real-time data, you generate the report with current data extracted from the iFIX database. When you create a report using iFIX historical data, you generate the report based on data gathered over a period of time.

For example, suppose you are the production manager of a cookie factory. At the end of each shift you want to generate a customized report that shows the amount of down time on each production line. You would use the Scheduler to request this report at certain times using iFIX historical data. In addition, if a failure occurs on a particular line you want to have your system automatically generate a report showing the tank level of each ingredient, the state of the mixer and dropper, and the temperature of the oven at the time of the failure. When a failure occurs, the requested iFIX real-time data is extracted from the iFIX database and displayed in a report. The data in this report can then be analyzed to help prevent future failures.
For your reporting solution, we recommend using Crystal Reports® XI. This reporting application uses ODBC to access iFIX data sources, allowing you to create professional, customized reports. The Crystal Report wizards make the process of defining your query and designing the layout of your report quick and easy. Crystal Reports also provides superior sorting capabilities and lets you insert informative graphs that help you to effectively analyze your process data. Once created, your queries can be saved so you can quickly generate future reports based on these predefined queries.

For complete information on using Crystal Reports, refer to the Crystal Reports help. If you plan to create Crystal Reports run-time files so that you can run reports on a target node without a full development copy of the product, refer to the Crystal online help. Licensing restrictions apply. The Business Objects™ web page provides more information on licensing: http://www.businessobjects.com/products/reporting/crystalreports/licensing/default.asp.

Open Architecture Functions

Many plants have unique needs that can be solved through access to real-time data. iFIX provides read and write access to any data point in the system. This open architecture allows you to use custom and third-party applications to resolve your unique automation needs. The following figure illustrates the open architecture functions.

The iFIX architecture also allows you to write scripts that provide key real-time data. Visual Basic® for Applications is integrated directly into iFIX to allow you to quickly and easily develop scripts that interact with plant-floor data. For more information, refer to the Writing Scripts manual.
Application Functions

iFIX is a multi-tasking system. Each node can run several different applications simultaneously. Internally, critical programs have priority access to system resources and applications may be preempted to respond to a more critical resource request.

All iFIX applications can be classified into three types:

- User configuration applications
- System applications
- User applications

User Configuration Applications

User configuration applications allow you to create the instructions and logic that monitor and control your process. These applications create configuration files. When started, system applications read the configuration files and use the information found here to execute the assigned tasks.

The Event Scheduler is an example of a user configuration application. In the Event Scheduler, you define the event that triggers an action (for example the time of day or a change in your process) and the action that you want to occur. Once the event is scheduled, the action automatically triggers when the event occurs. No further interaction is required.

System Applications

System applications work with your process in real-time. These applications receive instructions from configuration files and require little or no interaction. In general, system applications have priority access to system resources.

Historical Collect is an example of a system application. Once started, it retrieves data and stores it in the Historical Data directory defined in the SCU. It requires no interaction and the system can be configured to automatically start Historical Collect when iFIX starts up.

User Applications

User applications are programs that you interact with in order to work with the process or process data. User applications also create and use configuration files.

The Alarm Summary Object (OCX) is an example of a user application. It requires you to interact with the system by manipulating the Alarm Summary Object that is embedded in your picture.

Some programs may serve as more than one kind of application. For example, the Database Manager is a user configuration application for creating process databases. However, Database Manager also acts as a user application because it allows you to display real-time data in spreadsheet form.
Using the Proficy iFIX WorkSpace

The Proficy iFIX WorkSpace is your starting point for using iFIX. It provides an integrated and flexible configuration environment that lets you create and modify documents for the local node. As part of this environment, the Proficy iFIX WorkSpace also launches and is integrated with iFIX applications, eliminating the need to switch to other programs. Instead the Proficy iFIX WorkSpace provides a work area with all the necessary tools to add a picture, create a schedule, or change a script.

Using the Proficy iFIX WorkSpace, you can also integrate ActiveX documents from other programs, such as Word and Excel, with your iFIX files. Like iFIX documents, ActiveX documents appear in the work area that the Proficy iFIX WorkSpace supplies. And if you create your own custom ActiveX documents, the WorkSpace automatically displays the menus and toolbars that these documents define when you open them.

You can display a hierarchical view of your files with the Proficy iFIX WorkSpace. This view serves as a navigational tool to help you locate iFIX documents and acts as a launch pad for iFIX and third-party applications.

The Proficy iFIX WorkSpace also lets you access the Visual Basic Editor (VBE). This editor lets you integrate Visual Basic for Applications (VBA) scripts into your iFIX files. By writing a VBA script, you can customize and automate the behavior of iFIX. For example, you can write a script to handle custom run-time data entry instead of using the data entry mechanisms provided with iFIX.

But the Proficy iFIX WorkSpace is not only a configuration tool. It also provides a run-time environment as well that lets operators display and run your iFIX documents. This environment lets you enable security restrictions that lock operators into a pre-defined set of pictures.

This chapter discusses how to use the Proficy iFIX WorkSpace and navigate the system tree. It also explains the available options and describes the two Proficy iFIX WorkSpace environments.

Understanding the Proficy iFIX WorkSpace

Before you begin using the Proficy iFIX WorkSpace, you should understand certain key concepts. Within the WorkSpace are the system tree and the work area.

Before you use either one, you should use the System Configuration Utility (SCU) to properly configure the nodes on which you will use the WorkSpace. To learn more about the SCU, refer to the Setting up the Environment manual.

Starting the Proficy iFIX WorkSpace

After you install and configure iFIX, you can begin using the Proficy iFIX WorkSpace.

In Configure Mode

By default, the WorkSpace starts when you start iFIX. This is because the WorkSpace is configured to run as a startup task, by default. When the iFIX WorkSpace opens in the default mode, it starts in configure mode.
Understanding iFIX

You can also start the WorkSpace in configure mode by clicking Start and pointing to Programs, Proficy HMI SCADA - iFIX, and then the iFIX WorkSpace.

Additionally, you can start the Proficy iFIX WorkSpace in configure mode using this command line:

```
WORKSPACE "C:\My Path\Filename.grf"
```

Use this command to open a specified picture on startup. For more information on configuring startup tasks, refer to the iFIX Background Tasks section.

**In Run Mode**

You can start the iFIX WorkSpace in run mode by using additional command line parameters. For example, here you use the /fo command to specify a picture that you want to open in run mode:

```
WORKSPACE /fo "C:\My Path\Filename.grf"
```

For more information, refer to the Command Line Parameters for the iFIX WorkSpace section.

Once you start the WorkSpace, you can toggle between configure mode and run mode by using the Ctrl+W shortcut, or by clicking WorkSpace and then Switch to Run (or Switch to Configure) (Classic view) or on the Home tab, in the WorkSpace group, click Switch to Run (or Switch to Configure) (Ribbon view).

**Command Line Parameters for Starting the iFIX WorkSpace**

You can start the iFIX WorkSpace (WorkSpace.exe) in run mode, from a command line, by using the parameters listed in the following table. To open a specific picture within the WorkSpace use the /FileOpen or /FO command. Additionally, you can use other command line parameters to specify the size of the WorkSpace window, and whether the menu and status bar display when the WorkSpace opens. For example:

```
workspace /fo "C:\Program Files\Proficy\Proficy iFIX\PIC\filename.grf" /WL 50
/WT 100 /WB 700 /WR 800 /MT n
```

Be aware that if you use these command line parameters to open an iFIX WorkSpace picture on startup, the command line parameters override the settings defined in the StartUp Pictures tab of the User Preferences dialog box. These settings also override any configured Window Properties (Title Bar, Resizable, Always on Top fields) in the Picture Preferences tab of the User Preferences dialog box. It does not change the User Preferences; it just overrides them.

*NOTE:* Do not use startup commands after the iFIX WorkSpace is already running.

**FIX Desktop and WSPROXY Commands**

Be aware that the /FileOpen and /FO commands, as well as the other commands listed in the table below, are iFIX WorkSpace start up commands only. In FIX Desktop Draw and View, if you want to use any other WSPROXY commands along with the WorkSpace command line parameters, make sure that the WSPROXY commands appear after the WorkSpace command line.

For example, if you want to open a picture in the iFIX WorkSpace, you can use command line parameters to define how you want the WorkSpace window to appear when it opens. You can then use the WSPROXY OPENPIC command to open the actual picture, as demonstrated in this example:
RUNTASK WORKSPACE "/WL 50 /WT 100 /WB 700 /WR 800 /MT n"
RUNTASK WSPROXY "OPENPIC {C:\My Path\FILENAME.grf}"

By using the WorkSpace command line parameters before the WSPROXY command, you can designate how you want the WorkSpace window to appear when it opens the picture. This is called a pop-up window.

Be aware that if the picture path contains spaces, and you are using the WORKSPACE startup command in the Command Language Editor in the FIX Desktop environment, enclose the path and picture name in brackets {} like this:

RUNTASK workspace "/fo {C:\Temp Files\MyPicture.grf} /WL 50 /WT 100 /WB 700 /WR 800 /MT n"

Do not use WorkSpace startup commands, like the one illustrated above from the Command Language Editor, after the iFIX Workspace is already running. Use WSPROXY instead, as described in the previous example.

**List of Command Line Parameters**

The following table lists the command line parameters available for starting the iFIX WorkSpace.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Alternative</th>
<th>Description</th>
</tr>
</thead>
</table>
| /FileOpen filename | /FO filename | Opens a specified iFIX picture in run mode, where `filename` is the path and file name of the picture you want to open. Use the full path when specifying the picture name to open. Use quotes to surround a path with spaces. For example:  

```
workspace /fo "C:\Program Files\Proficy\Proficy iFIX\PIC\filename.grf"
```

If you do not specify a file name, the Open dialog box appears when the WorkSpace opens, so you can browse and select a file to open.  

**NOTE:** When you use the /FileOpen command line parameter, the WorkSpace starts up without using the settings saved in the UserPreferences.ini file. Instead, the WorkSpace starts with the attributes provided by the command line parameters of the /FileOpen command. |
| /WindowLeft num | /WL num | Indicates the x-coordinate of the screen's top left corner, where `num` is the number of pixels between the left-side of the desktop screen and the left-side of the Workspace window you open. |
## iFIX WorkSpace Command Line Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Alternative</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/WindowTop num</td>
<td>/WT num</td>
<td>Indicates the y-coordinate of the screen's top left corner, as a positive number, where num is the number of pixels between the top of the desktop screen and the top of the Workspace window you open.</td>
</tr>
<tr>
<td>/WindowBottom num</td>
<td>/WB num</td>
<td>Indicates the y-coordinate of the screen's bottom right corner, as a positive number, where num is the number of pixels from the top of the desktop screen to the bottom of the Workspace window you open.</td>
</tr>
<tr>
<td>/WindowRight num</td>
<td>/WR num</td>
<td>Indicates the x-coordinate of the screen's bottom right corner, where num is the number of pixels from the left-side of the desktop screen to the right-side of the Workspace window you open.</td>
</tr>
<tr>
<td>/MenuAndTitleBar (y</td>
<td>n)</td>
<td>/MT (y</td>
</tr>
<tr>
<td>/StatusBar (y</td>
<td>n)</td>
<td>/SB (y</td>
</tr>
<tr>
<td>/Help</td>
<td>/?</td>
<td>Displays a help dialog with all the supported options for the /FileOpen command. For example, this command would display the help dialog box: workspace /?</td>
</tr>
</tbody>
</table>

### Example

This example uses the command-line options to open the iFIX WorkSpace in run mode:

```
workspace.exe /FO "C:\Program Files\Proficy\Proficy iFIX\PIC\ChartGroupDemo.grf" /WL 50 /WT 100 /WB 700 /WR 800 /MT n
```

In this example, the iFIX Workspace displays the picture's top left corner at 50 pixels across, 100 pixels down. The width of the WorkSpace is 750 pixels (WindowRight - WindowLeft). The height of the WorkSpace is 600 pixels (WindowBottom-WindowTop).
The following figure illustrates the WindowTop, WindowLeft, WindowBottom, and WindowRight values for this example.

![Diagram showing WindowTop, WindowLeft, WindowBottom, and WindowRight values]

**Shut Down the iFIX WorkSpace with a VBA Script**

When the iFIX WorkSpace is open in run mode, one way to close the WorkSpace window is through a VBA command script using the Quit Method. This method is helpful when you restrict other portions of the WorkSpace window, such as the title bar and menus, that you would normally use to exit the WorkSpace application in run mode.

For instance, if environment protection is enabled with menu and title bar restrictions, you may want to provide a button that closes the open WorkSpace window in run mode.

Another example would be from View, if you open a pop-up window of the iFIX WorkSpace in run mode that does not include the menu or title bar. In this scenario, you may also want to include a button in your picture that you can click to close the WorkSpace window.

Be aware that if security is enabled, the user profile should not restrict the "WorkSpace Runtime Exit" feature. For more information about configuring security features, refer to the Application Features section of the Configuring Security Features manual.

*TIP:* You can also close an open WorkSpace window in run mode by using the `ALT+F4` keyboard shortcut, provided your security is configured to allow the user to shut down the WorkSpace.

**Example**

The following script uses the Quit method from a push button in an iFIX picture. The push button includes a caption "Close Window" within the picture. When the Close Window button is clicked in run mode, the script displays a message box indicating whether you want to close the WorkSpace.
Click Yes to close the WorkSpace window.

Private Sub CommandButton1_Click()
    Dim lAccess As Long
    Dim Msg, Style, Title, Response
    Msg = "Are you SURE you want to exit the workspace?"
    Style = vbYesNo + vbQuestion
    Title = "Workspace Exit"
    Response = MsgBox(Msg, Style, Title)
    If Response = vbYes Then
        Application.Quit 3
    End If
End Sub

NOTE: It is not required to include a message box with a confirmation when you create this script. You can use the Quit method without a message box.

Understanding the System Tree

Your main navigational tool for locating files is the system tree. This tool appears as a hierarchical display of folders, as the following figure shows. By opening and closing folders, you can locate and display your documents in one step.
The system tree also acts as a program launcher. By double-clicking an application in the system tree, you can start any iFIX or third-party application.

**Understanding the Work Area**

The work area, shown in the following figure, is the window that displays your iFIX and ActiveX documents. Whenever you open a document, the Proficy iFIX WorkSpace displays the file in the work area and automatically activates the tools needed to modify it.
For example, when you double-click a picture, it appears in the work area window and all the tools associated with modifying a picture become active. It's almost as if you started a separate graphics program and opened the picture. This feature makes creating and modifying iFIX documents fast and easy because you do not need to leave the Proficy iFIX WorkSpace or search for the appropriate application to launch. All of the tools you need are built-in and ready to use.

**Using the Virtual Keyboard**

iFIX provides a virtual alpha-numeric keyboard that installs with iFIX installation. This keyboard allows you to work in touch-screen environments or to use a mouse to enter passwords and other data. When you activate the virtual keyboard, it is available by clicking the following button:

This button is on the right side of the current window's title bar. Clicking the button brings up the keyboard, as shown in the following figure.
Virtual Keyboard

To resize the keyboard and configure keyboard options:

- Use the SzUp and SzDn buttons to resize the keyboard to one of the twelve available sizes.
- Use the minimize button to dock the keyboard on the right side of the current application window's title bar.
- Use the Kybd, Help, Edit, Info, Num, Win, Mag, Macro and Calc buttons to toggle display of the options.
- Click and drag any non-button area of the keyboard to move the keyboard on your desktop.
- Access the Help and the tutorial for the virtual keyboard, as well as general setup and configuration information, through the Menu button on the keyboard.

To use the virtual keyboard, you must have a valid hardware key for iFIX 3.0 or higher. If you are using Terminal Server, each licensed client has access to a copy of the virtual keyboard.

Activating the Keyboard

It is recommended that you activate the virtual keyboard by adding it to your Windows Startup folder.

To activate the virtual keyboard from the Windows Startup folder:

1. In your Proficy iFIX directory, right-click on the MYTSOFT.EXE file and select Copy.
2. In Explorer, navigate to the C:\Documents and Settings folder.
3. If you are not using Windows Vista or Windows Server 2008, drill down to the following folder:
   C:\Documents and Settings\All Users\Start Menu\Programs\Startup
   If you are using Windows Vista or Windows Server 2008, drill down to this folder instead:
   C:\Users\Administrator\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup
4. Right-click the white space area of the Startup folder, and select Paste Shortcut.
Understanding iFIX

5. If you want, rename the shortcut.

The next time you start your computer, the keyboard will activate automatically.

NOTES:

- If you want to start the virtual keyboard when you start iFIX on Windows XP machines, in the SCU in the Task Configuration dialog box, add the Mytsoft2.exe application (startup mode Normal). The next time you start iFIX, the My-T-Soft virtual keyboard appears.

- If you want to display the My-T-Soft startup screen when you start iFIX, in the SCU in the Task Configuration dialog box, add the MTSOPEN.EXE application (startup mode Normal). The next time you start iFIX, the My-T-Soft screen appears and you can click Run My-T-Soft to launch the virtual keyboard. Do not add MYTSOFT.EXE to the startup task list in the SCU. If you do so, errors display when you start iFIX.

- For Windows XP, you can also use Mytsoft2.exe.

- The MTSTUTOR program can only be run as an Administrator. When logged on as another user, including an Administrator with a different user name, you must right-click the shortcut and choose "Run as Administrator."

- Be aware that if you try to run DVTKINST.EXE more than once a unzipping error message will appear.

Locating Classic View Menu Commands in Ribbon View

If you are switching from using Classic view to Ribbon view, you will notice that the location of many of the commands is different. As an aid, use the following table to determine the locations of Classic view menu items in Ribbon view.

<table>
<thead>
<tr>
<th>Classic View Menu Item</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td></td>
</tr>
<tr>
<td>New</td>
<td></td>
</tr>
<tr>
<td>Picture</td>
<td>WorkSpace button, select New, or Home tab, New group</td>
</tr>
<tr>
<td>Schedule</td>
<td>WorkSpace button, select New, or Home tab, New group</td>
</tr>
<tr>
<td>Dynamo Set</td>
<td>WorkSpace button, select New, or Home tab, New group</td>
</tr>
<tr>
<td>Others</td>
<td>WorkSpace button, select New, or Home tab, New group</td>
</tr>
<tr>
<td>Open</td>
<td>WorkSpace button</td>
</tr>
<tr>
<td>Close</td>
<td>WorkSpace button</td>
</tr>
</tbody>
</table>
## Classic View Menu Item

<table>
<thead>
<tr>
<th>Classic View Menu Item</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>WorkSpace button</td>
</tr>
<tr>
<td>Save As</td>
<td>WorkSpace button</td>
</tr>
<tr>
<td>Print</td>
<td>WorkSpace button</td>
</tr>
<tr>
<td>Recent File</td>
<td>WorkSpace button, Recent</td>
</tr>
<tr>
<td></td>
<td>Documents list</td>
</tr>
<tr>
<td>Exit</td>
<td>WorkSpace button</td>
</tr>
<tr>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>Home tab, Editing group</td>
</tr>
<tr>
<td>Cut</td>
<td>Home tab, Clipboard group</td>
</tr>
<tr>
<td>Copy</td>
<td>Home tab, Clipboard group</td>
</tr>
<tr>
<td>Copy as Bitmap</td>
<td>Home tab, Clipboard group</td>
</tr>
<tr>
<td>Paste</td>
<td>Home tab, Clipboard group,</td>
</tr>
<tr>
<td></td>
<td>Paste list</td>
</tr>
<tr>
<td>Paste Special</td>
<td>Home tab, Clipboard group,</td>
</tr>
<tr>
<td></td>
<td>Paste list</td>
</tr>
<tr>
<td>Delete</td>
<td>Home tab, Editing group</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Home tab, Editing group</td>
</tr>
<tr>
<td>Select All</td>
<td>Home tab, Editing group</td>
</tr>
<tr>
<td>Find and Replace</td>
<td>Home tab, Editing group</td>
</tr>
<tr>
<td>Animations</td>
<td>Tools tab</td>
</tr>
<tr>
<td>Picture</td>
<td>Home tab, Editing group,</td>
</tr>
<tr>
<td></td>
<td>Properties list, or</td>
</tr>
<tr>
<td></td>
<td>Format tab, Picture group,</td>
</tr>
<tr>
<td></td>
<td>Edit Picture</td>
</tr>
</tbody>
</table>
### Classic View Menu Item

<table>
<thead>
<tr>
<th>Classic View Menu Item</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>WorkSpace</td>
<td>Switch to Run</td>
</tr>
<tr>
<td></td>
<td>Home tab, WorkSpace group</td>
</tr>
<tr>
<td>System Tree</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Home tab, WorkSpace group, Show/Hide list, or View tab, Show/Hide group</td>
</tr>
<tr>
<td>Status Bar</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Home tab, WorkSpace group, Show/Hide list, or View tab, Show/Hide group</td>
</tr>
<tr>
<td>Toolbox</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Home tab, WorkSpace group, Show/Hide list</td>
</tr>
<tr>
<td>Visual Basic Editor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Home tab, WorkSpace group, or Tools tab</td>
</tr>
<tr>
<td>User Preferences</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Home tab, WorkSpace group, Settings list</td>
</tr>
<tr>
<td>Toolbars</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Home tab, WorkSpace group, Settings list</td>
</tr>
<tr>
<td>Full Screen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Home tab, WorkSpace group</td>
</tr>
</tbody>
</table>

### Object

<table>
<thead>
<tr>
<th>Object</th>
<th>Resize</th>
<th>Right-click object</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Object</th>
<th>Rotate</th>
<th>Right-click object</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Fill Style</th>
<th>Solid</th>
<th>Format tab, Styles group, Fill Style gallery</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Hollow</td>
<td>Format tab, Styles group, Fill Style gallery</td>
</tr>
<tr>
<td></td>
<td>Horizontal</td>
<td>Format tab, Styles group, Fill Style gallery</td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
<td>Format tab, Styles group, Fill Style gallery</td>
</tr>
<tr>
<td>Classic View Menu Item</td>
<td>Ribbon View Location</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Downward Diagonal</td>
<td>Format tab, Styles group, Fill Style gallery</td>
<td></td>
</tr>
<tr>
<td>Upward Diagonal</td>
<td>Format tab, Styles group, Fill Style gallery</td>
<td></td>
</tr>
<tr>
<td>Cross Hatch</td>
<td>Format tab, Styles group, Fill Style gallery</td>
<td></td>
</tr>
<tr>
<td>Diagonal Cross Hatch</td>
<td>Format tab, Styles group, Fill Style gallery</td>
<td></td>
</tr>
<tr>
<td>Gradient</td>
<td>Format tab, Styles group, Fill Style gallery</td>
<td></td>
</tr>
<tr>
<td>Solid</td>
<td>Format tab, Styles group, Edge Style gallery</td>
<td></td>
</tr>
<tr>
<td>Dash</td>
<td>Format tab, Styles group, Edge Style gallery</td>
<td></td>
</tr>
<tr>
<td>Dot</td>
<td>Format tab, Styles group, Edge Style gallery</td>
<td></td>
</tr>
<tr>
<td>Dash Dot</td>
<td>Format tab, Styles group, Edge Style gallery</td>
<td></td>
</tr>
<tr>
<td>Dash Dot Dot</td>
<td>Format tab, Styles group, Edge Style gallery</td>
<td></td>
</tr>
<tr>
<td>No Edge</td>
<td>Format tab, Styles group, Edge Style gallery</td>
<td></td>
</tr>
<tr>
<td>Inside Frame</td>
<td>Format tab, Styles group, Edge Style gallery</td>
<td></td>
</tr>
<tr>
<td>Opaque</td>
<td>Format tab, Styles group, Background Style gallery</td>
<td></td>
</tr>
<tr>
<td>Transparent</td>
<td>Format tab, Styles group, Background Style gallery</td>
<td></td>
</tr>
<tr>
<td>Classic View Menu Item</td>
<td>Ribbon View Location</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------</td>
<td></td>
</tr>
<tr>
<td>Fade Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linear</td>
<td>Format tab, Styles group, Fade Type gallery</td>
<td></td>
</tr>
<tr>
<td>Reflected</td>
<td>Format tab, Styles group, Fade Type gallery</td>
<td></td>
</tr>
<tr>
<td>Radial</td>
<td>Format tab, Styles group, Fade Type gallery</td>
<td></td>
</tr>
<tr>
<td>Concentric</td>
<td>Format tab, Styles group, Fade Type gallery</td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50%</td>
<td>Format tab, Picture group, or View tab, Zoom group</td>
<td></td>
</tr>
<tr>
<td>100%</td>
<td>Format tab, Picture group, or View tab, Zoom group</td>
<td></td>
</tr>
<tr>
<td>150%</td>
<td>Format tab, Picture group, or View tab, Zoom group</td>
<td></td>
</tr>
<tr>
<td>200%</td>
<td>Format tab, Picture group, or View tab, Zoom group</td>
<td></td>
</tr>
<tr>
<td>Default View</td>
<td>View, Picture group, View list</td>
<td></td>
</tr>
<tr>
<td>Full View</td>
<td>View, Picture group, View list</td>
<td></td>
</tr>
<tr>
<td>Fit Picture to Window</td>
<td>View, Picture group, Window list</td>
<td></td>
</tr>
<tr>
<td>Fit Window to Picture</td>
<td>View, Picture group, Window list</td>
<td></td>
</tr>
<tr>
<td>Update Window Location</td>
<td>View, Picture group, Window list</td>
<td></td>
</tr>
<tr>
<td>Refresh</td>
<td>View, Picture group, View list</td>
<td></td>
</tr>
<tr>
<td>Color Selections</td>
<td>Format tab, Styles group</td>
<td></td>
</tr>
<tr>
<td>Property Window</td>
<td>View, Window group</td>
<td></td>
</tr>
<tr>
<td>Screen Regions</td>
<td>View, Picture group</td>
<td></td>
</tr>
<tr>
<td>Classic View Menu Item</td>
<td>Ribbon View Location</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------</td>
<td></td>
</tr>
<tr>
<td>Insert OLE Object</td>
<td>Insert tab, Objects/Links group, Object/Links list</td>
<td></td>
</tr>
<tr>
<td>Rectangle</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Rounded Rectangle</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Oval</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Line</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Polyline</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Polygon</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Arc</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Chord</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Pie</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>Insert tab, Shapes group, Shapes list</td>
<td></td>
</tr>
<tr>
<td>Chart Standard Chart</td>
<td>Insert tab, Charts group</td>
<td></td>
</tr>
<tr>
<td>Line Multiline Chart</td>
<td>Insert tab, Charts group</td>
<td></td>
</tr>
<tr>
<td>SPC - X-Bar Chart</td>
<td>Insert tab, Charts group</td>
<td></td>
</tr>
<tr>
<td>SPC - R-BarChart</td>
<td>Insert tab, Charts group</td>
<td></td>
</tr>
<tr>
<td>SPC - S-Bar Chart</td>
<td>Insert tab, Charts group</td>
<td></td>
</tr>
<tr>
<td>Histogram Chart</td>
<td>Insert tab, Charts group</td>
<td></td>
</tr>
<tr>
<td>Classic View Menu Item</td>
<td>Ribbon View Location</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Bitmap</td>
<td>Insert tab, Objects/Links group, Object/Links list</td>
<td></td>
</tr>
<tr>
<td>Datalink</td>
<td>Insert tab, Objects/Links group, Object/Links list</td>
<td></td>
</tr>
<tr>
<td>Pipe</td>
<td>Insert tab, Objects/Links group, Object/Links list</td>
<td></td>
</tr>
<tr>
<td>Current Time</td>
<td>Insert tab, Objects/Links group, Object/Links list</td>
<td></td>
</tr>
<tr>
<td>Current Date</td>
<td>Insert tab, Objects/Links group, Object/Links list</td>
<td></td>
</tr>
<tr>
<td>Alarm Summary</td>
<td>Insert tab, Objects/Links group, Object/Links list</td>
<td></td>
</tr>
<tr>
<td>Push Button</td>
<td>Insert tab, Objects/Links group, Object/Links list</td>
<td></td>
</tr>
<tr>
<td>Proficy Portal Control</td>
<td>Insert tab, Objects/Links group, Object/Links list</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bring to Front</td>
<td>Format tab, Arrange group</td>
<td></td>
</tr>
<tr>
<td>Send to Back</td>
<td>Format tab, Arrange group</td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td>Format tab, Arrange group</td>
<td></td>
</tr>
<tr>
<td>Align</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Top</td>
<td>Format tab, Arrange group, Arrange list</td>
<td></td>
</tr>
<tr>
<td>Bottom</td>
<td>Format tab, Arrange group, Arrange list</td>
<td></td>
</tr>
<tr>
<td>Vertical Center</td>
<td>Format tab, Arrange group, Arrange list</td>
<td></td>
</tr>
<tr>
<td>Left</td>
<td>Format tab, Arrange group, Arrange list</td>
<td></td>
</tr>
<tr>
<td>Classic View Menu Item</td>
<td>Ribbon View Location</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------</td>
<td></td>
</tr>
<tr>
<td>Right</td>
<td>Format tab, Arrange group, Arrange list</td>
<td></td>
</tr>
<tr>
<td>Horizontal Center</td>
<td>Format tab, Arrange group, Arrange list</td>
<td></td>
</tr>
<tr>
<td>Flip</td>
<td>Format tab, Arrange group, Flip list</td>
<td></td>
</tr>
<tr>
<td>Vertical</td>
<td>Format tab, Arrange group, Flip list</td>
<td></td>
</tr>
<tr>
<td>Space Evenly</td>
<td>Format tab, Arrange group, Space Evenly list</td>
<td></td>
</tr>
<tr>
<td>Horizontal</td>
<td>Format tab, Arrange group, Space Evenly list</td>
<td></td>
</tr>
<tr>
<td>Vertical</td>
<td>Format tab, Arrange group, Space Evenly list</td>
<td></td>
</tr>
<tr>
<td>Make Space Even</td>
<td>Format tab, Arrange group, Make Space Even list</td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>Format tab, Arrange group, Make Space Even list</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>Format tab, Arrange group, Make Space Even list</td>
<td></td>
</tr>
<tr>
<td>Both</td>
<td>Format tab, Arrange group, Make Space Even list</td>
<td></td>
</tr>
<tr>
<td>Snap to Grid</td>
<td>Format tab, Arrange group, Grid list</td>
<td></td>
</tr>
<tr>
<td>Grid Settings</td>
<td>Format tab, Arrange group, Grid list</td>
<td></td>
</tr>
<tr>
<td>Snap Objects to Grid</td>
<td>Format tab, Arrange group, Grid list</td>
<td></td>
</tr>
<tr>
<td>Window</td>
<td>View tab, Window group</td>
<td></td>
</tr>
<tr>
<td>Cascade</td>
<td>View tab, Window group</td>
<td></td>
</tr>
<tr>
<td>Tile Horizontal</td>
<td>View tab, Window group</td>
<td></td>
</tr>
<tr>
<td>Tile Vertical</td>
<td>View tab, Window group</td>
<td></td>
</tr>
<tr>
<td>Close All</td>
<td>View tab, Window group</td>
<td></td>
</tr>
<tr>
<td>Switch Windows</td>
<td>View tab, Window group</td>
<td></td>
</tr>
</tbody>
</table>
### Using the System Tree

The system tree provides a hierarchical view of the files on the local node. When you first start the Proficy iFIX WorkSpace, the system tree shows the local node name at the top of the tree and the following folders and applications:

<table>
<thead>
<tr>
<th>System Tree Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm History</td>
<td>Lets you display the last 200 alarms and messages received by the local computer.</td>
</tr>
<tr>
<td>Database Manager</td>
<td>Lets you create and modify process databases.</td>
</tr>
<tr>
<td>Documents folder</td>
<td>Lets you create any Word and Excel documents. If you save these documents in the Application path, they appear in the system tree. Only Word files with the extension .DOC and Excel files with the extension .XLS appear.</td>
</tr>
</tbody>
</table>
## System Tree Item

<table>
<thead>
<tr>
<th>System Tree Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamo Sets folder</td>
<td>Contains Dynamo sets.</td>
</tr>
<tr>
<td>FIX Recipes folder</td>
<td>Contains your control and master recipes.</td>
</tr>
<tr>
<td>Globals folder</td>
<td>Contains global variables, user-defined variables, and threshold tables.</td>
</tr>
<tr>
<td>Help &amp; Information folder</td>
<td>Contains iFIX Help and electronic books.</td>
</tr>
<tr>
<td>Historical Assignment</td>
<td>Lets you create historical collection groups.</td>
</tr>
<tr>
<td>I/O Drivers folder</td>
<td>Contains I/O drivers configured for the local node.</td>
</tr>
<tr>
<td>Mission Control</td>
<td>Lets you monitor background tasks. These tasks include: Historical Collect, I/O Control, Auto Alarm Manager, Alarm ODBC services, and the Scan, Alarm, and Control (SAC) program.</td>
</tr>
<tr>
<td>Pictures folder</td>
<td>Contains your pictures.</td>
</tr>
<tr>
<td>Reports folder</td>
<td>Contains reports generated by your reporting package.</td>
</tr>
<tr>
<td>Schedules folder</td>
<td>Contains your schedules.</td>
</tr>
<tr>
<td>Security folder</td>
<td>Contains the Security Configuration and Login programs. These programs let you define your security configuration and login to the local node once security is enabled.</td>
</tr>
<tr>
<td>System Configuration</td>
<td>Lets you configure the local node.</td>
</tr>
</tbody>
</table>

If your computer has Proficy Batch Execution or greater installed, you will also see the following items:
### Understanding iFIX

<table>
<thead>
<tr>
<th>System Tree Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Execution Books</td>
<td>Opens the Batch Execution electronic books.</td>
</tr>
<tr>
<td>Batch Execution Configuration</td>
<td>Lets you configure Batch Execution.</td>
</tr>
<tr>
<td>Batch Execution Equipment</td>
<td>Contains your equipment database.</td>
</tr>
<tr>
<td>Batch Execution Recipes</td>
<td>Contains the Batch Execution procedures, unit procedures, and operations.</td>
</tr>
</tbody>
</table>

### Understanding System Tree Paths

Associated with each application and folder in the system tree is an iFIX path. These paths show where the files reside on your computer and are defined in the System Configuration Utility (SCU).

To learn how to change an iFIX path, refer to the Setting up the Environment manual.

### Showing and Hiding the System Tree

By default, the system tree is docked on the left side of the screen. You can dock it on the other side of the screen by dragging it. Likewise, if you want more screen space for your pictures and schedules, you can set the system tree to float on top of your open documents by dragging it away from the sides of the screen. You can resize the system tree while it floats by dragging its edges.

When the system tree is docked, you can only resize its width, as the following figure shows.
Resizing the System Tree

If resizing the system tree does not give you the space you need, you can hide the tree completely.

Navigating the System Tree

You can move up and down the system tree by selecting items with the mouse or by using the following keys:

<table>
<thead>
<tr>
<th>Use the...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up arrow key</td>
<td>Move up the system tree.</td>
</tr>
<tr>
<td>Down arrow key</td>
<td>Move down the system tree.</td>
</tr>
<tr>
<td>Page Up key</td>
<td>Move up through the system tree quickly. If you have resized the system tree, you can move over the visible portion of the system tree with the Page Up key.</td>
</tr>
</tbody>
</table>
Understanding IFIX

<table>
<thead>
<tr>
<th>Use the...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Down key</td>
<td>Page down through the system tree quickly. If you have resized the system tree, you can move over the visible portion of the system tree with the Page Up key.</td>
</tr>
<tr>
<td>Left arrow key</td>
<td>Close a folder.</td>
</tr>
<tr>
<td>Right arrow key</td>
<td>Open a folder.</td>
</tr>
<tr>
<td>Home key</td>
<td>Move to the top of the tree.</td>
</tr>
<tr>
<td>End key</td>
<td>Move to the bottom of the tree.</td>
</tr>
</tbody>
</table>

Opening and Closing Folders

Opening and closing folders is similar to using Windows Explorer, as the following figure shows:
Right-Clicking the System Tree

You can right-click any item in the system tree to display a pop-up menu. The contents of the menu depends on the item you select. For example, the pop-up menu of the Picture folder lets you create a new picture and display the folder's path. The pop-up menu of a rectangle, on the other hand, lets you edit the object's scripts, change the object's properties, and modify the object by cutting, copying, pasting, deleting, and duplicating it.

Dragging and Dropping Files

With the Proficy iFIX WorkSpace, you can copy and move objects by dragging and dropping them into open documents. In general, you can drag an object, such as a Dynamo object, from an open picture, an open Dynamo set, or the system tree and drop it into:

- An open picture.
- An open Dynamo set.
- A user-defined global file.

For more information on Dynamo objects, refer to the Creating Pictures manual. For information on user-defined variables and the global page, refer to the Writing Scripts manual.
Starting Applications from the System Tree

You can start any application in the system tree by double-clicking its icon. The Proficy iFIX WorkSpace starts the associated application and, when possible, displays the application in the workarea. In some cases, the application opens in its own window on top of the Proficy iFIX WorkSpace.

Understanding WorkSpace Environments

The WorkSpace provides both a configuration and a run-time environment. The configuration environment provides all necessary development tools, including access to toolbars and the files in the system tree. In addition, any process-monitoring background tasks that may be running, such as your I/O drivers, Historical Collect, and enabled alarm services, continue to run while the configuration environment is active.

The run-time environment, on the other hand, is designed for operators. With this environment, operators can display pictures and monitor your process. Typically, the run-time environment is configured to restrict operator access to other parts of iFIX by hiding menu bars and disabling the ability to task switch.

You can toggle between the two environments to test and run your pictures and schedules. As you switch environments, the status bar updates. In the configuration environment, the text Configure appears. When you switch to the run-time environment, the text changes to Run.

Documents open in one environment remain open even when you switch to the other environment. For example, if you have two pictures and one schedule open in the configuration environment, these files remain open when the run-time environment becomes active. If you close one of the pictures in the run-time environment and switch back, the picture that you closed is now closed in the configuration environment. The other picture and the schedule both remain open.

You cannot switch to the configuration environment in the Proficy iFIX WorkSpace while a script is running. Similarly, you cannot exit the application. Once the script completes, you can switch environments and exit normally.

The same restrictions apply to scripts running in pictures. You cannot close a picture until all running scripts complete.

Switching to the run-time environment also hides the system tree, if it is displayed, and your toolbars. Switching back reverses the process.

**NOTE:** To improve performance, close unnecessary, open documents before switching between environments to test a picture.

Displaying the WorkSpace Full-Screen

You can display the WorkSpace full-screen in either or both of its environments. Displaying the WorkSpace full-screen lets you see the exact same scale and display sizes that operators will experience.

When you display the WorkSpace full-screen, it hides its menu bar and any docked toolbars. Floating toolbars remain visible. The WorkSpace also hides the system tree in the configuration environment if it is docked. In the run-time environment, the system tree and all toolbars are always hidden.
Enabling Environment Protection

You can restrict operator access to the menu bar and pop-up menus, and prevent task switching by enabling environment protection. Once enabled, environment protection takes effect when you switch to the run-time environment.

For a detailed description of environment protection and how to enable it, refer to the Setting Up the Environment manual.

Disabling Error Dialog Boxes

If an error occurs in the run-time environment, an error dialog box displays requiring user intervention. You can disable error dialog boxes for particular errors by editing the FILTEREDERRORS.INI file in the Local path. For example, you may want to suppress the error dialogs when network sessions are lost. In order to do this, add the error codes you want filtered in the INI file as follows:

```plaintext
; To add an error code to be filtered increment the count and set
; the Error equal to the return code
[ErrorCodes]
Count = 4
Error1 = 1620
Error2 = 1914
Error3 = 1915
Error4 = 8517
```

In this example, all typical network session errors are suppressed.

After you edit the FILTEREDERRORS.INI file, restart the WorkSpace to ensure your changes take effect.

Disabling Proficy Historian Errors in the WorkSpace

To suppress the Proficy Historian errors, you need to edit the filterederrors.ini file found in the C:\Program Files\Proficy\Proficy iFIX\local path and add the Historian error codes you want filtered.

To edit the filterederrors.ini file:

1. Add a new section [iHistErrorCodes] if it is not already present in the .ini file.
2. Add a new key Count = the number of error codes you want to suppress.
3. Add a new key iHistError and set it equal to the return code.

Examples

If you want to suppress two Historian errors, you would modify the filterederrors.ini file as follows:

```plaintext
[iHistErrorCodes]
Count =2
iHistError1 = -3
iHistError2 = -2
```
If you want to suppress additional errors, increment the key value of Count as follows:

\[ \text{Count} = 3 \]

Add a new iHistError3, and set it equal to the error code.

**Historian Server Connection Time-out**

During a failed write attempt to the Proficy Historian Server, the iFIX WorkSpace becomes inactive. You can control how long this lasts by setting the number of seconds you allow for the connection time-out. The default is 90 seconds.

To configure the time-out, add this setting to the FixUserPreferences.ini file in the iFIX Local folder:

```
[Historian]
TimeoutSecs=10
```

Here, the time-out is set to 10 seconds. The valid range is 5 to 300 seconds, though not enforced.

---

**Working with Documents**

Once the Proficy iFIX WorkSpace starts and the system tree appears, you can create and open documents. The Proficy iFIX WorkSpace Standard toolbar provides buttons for creating new pictures, schedules, and Dynamo sets. In Classic view, you can create other types of ActiveX documents with the New command from the File menu. Or, in Ribbon view, you can access these functions by clicking the WorkSpace button and selecting New.

**Opening Documents**

To open a document, double-click the document's icon in the system tree. The Proficy iFIX WorkSpace activates the associated tools or starts the required application depending on the selected document.

If you want to open a document that is not in the system tree, click the Open button from the Standard toolbar (Classic view) or click the WorkSpace button and click Open (Ribbon view) and select the file you want to open.

**Deleting and Renaming Documents**

You can delete or rename any closed document in the system tree by right-clicking it and selecting Delete or Rename from the pop-up menu.

When you rename a document, the Proficy iFIX WorkSpace prompts you for the new name. Once you enter a name, it appears in the system tree.

**IMPORTANT:** Only 31 characters are allowed when renaming (and naming) files in the Documents folder in the system tree in the iFIX WorkSpace.
Using the Proficy iFIX WorkSpace

Using Word and Excel in the WorkSpace

Using the Proficy iFIX WorkSpace, you can integrate documents from Word and Excel with your iFIX files. When you open the documents, they appear in the iFIX WorkSpace.

In Classic view, you can perform all of the functions associated with each application directly in the WorkSpace. However, in Ribbon view, there are some limitations. They include:

- Global commands, which are those that apply to any open document, such as Print, are not accessible. However, all formatting commands are available.
- When working in Full Screen mode, you must have a picture open so that you can activate it, which allows you to access the WorkSpace menu and keyboard shortcuts.

Understanding Toolbars

With the Proficy iFIX WorkSpace, you can customize the toolbars provided with iFIX. You can also create custom toolbars and toolbar buttons, and share them among multiple computers. This section explains how to complete these tasks.

NOTES:

- Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
- In Ribbon view, toolbars cannot be docked.
- In Ribbon view, if you open an MS Word or Excel document in the WorkSpace, some of the menu items associated with those documents will not appear in the WorkSpace. If you need to edit an MS Word or Excel document, we recommend that you do so in Classic view.

Toolbars provides buttons for common operations. For example, the Standard toolbar, shown in the following figure, lets you create, open, and print documents.

![Proficy iFIX WorkSpace Standard Toolbar](image)

The Application toolbar also lets you complete common tasks. The buttons on this toolbar allow you to launch iFIX applications without the system tree and to access information from the iFIX electronic books and the GE Intelligent Platforms web site.
The other WorkSpace toolbar, the Utilities toolbar, lets you complete common database operations without Database Manager, as the following figure shows. You can update the connection between a picture's I/O points and the process database. This process is called resolving your pictures. You can also export pictures to use in the Proficy Portal application.

Showing and Hiding Toolbars

You can show or hide any toolbar by selecting or deselecting it from the Toolbars dialog box in the configuration environment. Switching to the run-time environment hides all toolbars displayed in the configuration environment.

Understanding Toolbar Owners

All toolbars are owned by an application or a document. The toolbar's owner defines when the toolbar appears. For example, WorkSpace toolbars appear while the WorkSpace runs, picture toolbars appear only while the WorkSpace displays one or more pictures, and Scheduler toolbars are available when you open a schedule. If you switch from a picture to a schedule, the WorkSpace hides the picture toolbars and displays the Scheduler toolbars.

**NOTE:** Picture toolbars are available to all pictures and Scheduler toolbars are available to all schedules. You cannot assign specific toolbars to individual pictures or schedules.
Customizing Toolbars

The Proficy iFIX WorkSpace provides toolbars with buttons that provide access to frequently-used functions, such as creating pictures and starting iFIX applications. You can customize the toolbars by arranging or removing these buttons as needed. Typically, you should remove buttons that you do not need. For example, if you set up a workstation dedicated to creating pictures and Dynamo objects, you may want to remove the New Schedule button from the Standard toolbar.

Once you remove a button, you can always add it back. Adding a button requires you to select a toolbar category. A toolbar category is a logical grouping of buttons. For example, the Standard category contains the buttons on the Standard WorkSpace toolbar and the CreateObjects category contains the buttons on the Shapes toolbar.

The Proficy iFIX WorkSpace provides many toolbar categories from which you can select buttons. These categories cannot be renamed or deleted. Likewise, the buttons in these categories cannot be modified or deleted. However, you can modify any button you add to a toolbar. The WorkSpace treats the added button as a copy of the original and lets you modify the new button in the toolbar with the Visual Basic Editor. Any changes to the copy do not affect the original.

Docking Toolbars

In addition to adding, removing, and arranging buttons, you can customize a toolbar by enabling or disabling a toolbar's docking option. When enabled, this option lets you dock a toolbar by dragging it to any edge of the screen. To keep the toolbar floating regardless of its screen position, you can disable the option.

*NOTE:* In Ribbon view, toolbars cannot be docked.

Resetting Toolbars

You can restore any standard iFIX toolbar to its default state using the Reset button. Typically, these toolbars should be reset if you have customized the standard toolbars and you want to undo these changes. When you reset a toolbar, the WorkSpace:

- Deletes any custom buttons you have added.
- Adds any standard buttons you have deleted.
- Resets the toolbar's docking option back to its default state. This means if you reset a toolbar that has the docking option disabled, the WorkSpace enables the option.
- Moves the toolbar back to its default screen position. Consequently, if you reset a floating toolbar that is docked by default the toolbar, the WorkSpace docks the toolbar when you reset it.

*NOTE:* Resetting a standard toolbar does not affect any custom toolbar you have created.

Creating Toolbars

While you can customize the toolbars supplied with the Proficy iFIX WorkSpace, you cannot modify their properties. In addition, WorkSpace toolbars cannot be renamed or deleted. To eliminate these restrictions, you can create your own toolbars.

Creating a toolbar is similar to customizing one. Both tasks require you to click and drag the buttons
you want onto your toolbar. However, when you create a toolbar, you also define its properties. These properties include the toolbar's owner and name.

The owner identifies the document or application that owns the toolbar. This owner must be active for the toolbars it owns to appear. For example, picture toolbars appear while you have one or more pictures open. If you subsequently open a schedule, the WorkSpace hides the picture toolbars and shows the Scheduler toolbars. The Proficy iFIX WorkSpace, pictures, and schedules are the available owners.

A toolbar name conforms to VBA naming conventions. These rules require the first character to begin with a letter, prohibit the use of a space, period (.), exclamation mark (!), or the characters @, &, $, # in the name. The name is limited to 31 characters. In addition, toolbar names cannot match the name of any other toolbar, category, picture, schedule, or Dynamo set.

However, it is possible to create a toolbar with the name of a closed document. Similarly, you can save a picture or schedule with the name of a hidden toolbar. When either situation occurs, the WorkSpace can only open one of these items at a time. For example, if you open a picture named ALARMS.GRF, the WorkSpace cannot show a toolbar named Alarms. You must close the picture first. Once the toolbar is displayed, you cannot open the picture until you hide the toolbar.

Creating Toolbars with VBA

iFIX does not contain the automation interfaces necessary to create toolbars. Do not use VBA to create toolbars in the WorkSpace. Doing so causes unpredictable results.

NOTE: The WorkSpace saves the position of top left corner of the each floating and docked toolbar on the screen. If you move a toolbar outside the 800x600 portion of the screen, you may not be able to see it if you reduce the screen resolution or move the toolbar to another computer. Consequently, it is recommended that you keep your toolbars within the 800x600 portion of your screen.

In addition, the Proficy iFIX WorkSpace does not wrap docked toolbars. Consequently, if you dock a large toolbar, it appears as a long line of buttons. Depending on the toolbar's size, some buttons may not be visible and may move other toolbars beyond the visible portion of the screen.

Creating Buttons

You can create custom buttons with the Proficy iFIX WorkSpace. Typically, these buttons provide custom features. For example, you could create a button to launch a custom application.

Creating a button requires you to create a category for it. Remember, categories supplied with the Proficy iFIX WorkSpace cannot be modified.

You can create a new category by entering a name for it. Like toolbar names, category names must conform to VBA conventions. These rules require that the first character begin with a letter, prohibit the use of a space, period (.), exclamation mark (!), or the characters @, &, $, # in the name, and limits the name to 255 characters. In addition, category names cannot match the name of another toolbar, category, picture, schedule, or Dynamo set.

However, it is possible to create a category with the name of a closed document. Similarly, you can save a picture or schedule with the name of an existing category. When either situation occurs, the WorkSpace can only display one of these items at a time. For example, if you open a picture named OVERVIEW.GRF, the category Overview does not appear in the WorkSpace category list. To display it, close the picture. When you finish modifying the category, you can re-open the picture.
You can make button categories appear in the Task Wizard by including the text "tasks" to the end of the name. For example, a category called Sample displays in the Task Wizard when you create a category with the name SampleTasks; the category's buttons also appear as tasks you can perform.

Once you create a category, you can add custom buttons to it. Each button you add has properties that you can configure. These properties include the button's name, description, and ScreenTips. You can also edit the button's script. For more information on writing scripts for custom buttons, refer to the Writing Scripts manual.

Modifying Buttons

When you drag a button to a toolbar, the Proficy iFIX WorkSpace duplicates the button and its properties. However, no association exists between the two buttons. As a result, if you modify either button, the other is not updated. However, if you modify the button in the category, all future buttons you create with it will contain your changes.

Sharing Toolbars and Toolbar Buttons

You can share any custom toolbar among your iFIX nodes. Using the WorkSpace, you can share them by:

- Importing a toolbar's TBX file.
- Copying a toolbar category's TBC file.

Typically, you import a toolbar when you want to add toolbars created by a toolbar developer but you do not want others to reuse the toolbar's buttons. Copying a toolbar category, on the other hand, is done when you want to create one or more toolbars locally from the buttons in the toolbar category.

Each TBX and TBC file defines a toolbar or a toolbar category, respectively. These files reside in the Local path on the source computer. You can share the TBX and TBC files by copying them to the target computer's Local path. When sharing toolbars, you must subsequently import the TBX file with the WorkSpace. Toolbar files (*.TBX, *.TBC, *.XBT, ASSOCIATION.DAT) saved as read-only cannot be used in the Proficy iFIX WorkSpace.

**NOTE:** If you use a toolbar button to launch a custom ActiveX control, the OCX must be installed and registered on the target computer.

Using Experts and the Task Wizard

iFIX provides many Experts that automate the configuration of objects in pictures or the creation of an object's script. For example, the Foreground Color Expert can dynamically change the foreground color of an object. The Enable Alarm Expert, on the other hand, adds a script to the selected object. The script enables alarms for the data source you specify.

You can access many Experts from picture toolbars (Classic view) or on the Tools tab in the Animations and Tasks/Experts group (Ribbon view) or the Toolbox. However, with the Task Wizard, you can access every Expert through an easy-to-use menu that does not require toolbars. Consequently, if your toolbars occupy valuable screen space, you can hide them without losing functionality.

You can also use multiple Experts to create a scripted command sequence with the Multiple Command Script Wizard. The script can be triggered by a mouse click on an object, a Scheduler entry, or a keyboard macro.
Understanding iFIX

For more information on Experts, the Task Wizard, and the Multiple Command Script Wizard, refer to the Creating Pictures ebook.

Locating Toolbar Functions in Ribbon View

In Ribbon view, all functions, with the exception of Translation and Migration, are available directly from the Ribbon. This makes the use of toolbars, in Ribbon view, virtually unnecessary.

The following sections detail the locations of the various toolbar functions in Ribbon view.

- Application Toolbar
- CAD Toolbar
- Chart Group Toolbar
- Dynamo Toolbar
- Edit Toolbar
- Expert Toolbar
- Shapes Toolbar
- Standard Toolbar
- Toolbox Toolbar
- Tools Toolbar
- Utilities Toolbar
- VisiconX Toolbar

Locating Application Toolbar Functions in Ribbon View

The following table details the location of the various Application functions in Ribbon view.

**NOTES:**

- The following table includes only the default functions available on the Application toolbar.

- Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

- You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Key Macro Editor</td>
<td>Applications tab, Utilities group</td>
</tr>
<tr>
<td></td>
<td>Tag Group Editor</td>
<td>Applications tab, Utilities group</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Function</td>
<td>Ribbon View Location</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Database Manager</td>
<td>Applications tab, Process Database group</td>
</tr>
<tr>
<td></td>
<td>Historical Trend Assign</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td>System Configuration Utility</td>
<td>Applications tab, System &amp; Security group</td>
</tr>
<tr>
<td></td>
<td>Security Configuration Utility</td>
<td>Applications tab, System &amp; Security group, Security list</td>
</tr>
<tr>
<td></td>
<td>Security Login</td>
<td>Applications tab, System &amp; Security group, Security list</td>
</tr>
<tr>
<td></td>
<td>Mission Control</td>
<td>Applications tab, Utilities group</td>
</tr>
<tr>
<td></td>
<td>Alarm History</td>
<td>Applications tab, Utilities group</td>
</tr>
<tr>
<td></td>
<td>Cross Reference Tool</td>
<td>Applications tab, Utilities group, Utilities list</td>
</tr>
<tr>
<td></td>
<td>Electronic Books</td>
<td>Help button</td>
</tr>
<tr>
<td></td>
<td>GE Intelligent Platforms Home Page</td>
<td>WorkSpace button, Options, Resources page</td>
</tr>
<tr>
<td></td>
<td>Technical Support</td>
<td>WorkSpace button, Options, Resources page</td>
</tr>
<tr>
<td></td>
<td>Silence Alarm Horn</td>
<td>Applications tab, Utilities group, Utilities list</td>
</tr>
<tr>
<td></td>
<td>Startup Profile Manager</td>
<td>Applications tab, Utilities group, Utilities list</td>
</tr>
</tbody>
</table>

**Locating CAD Toolbar Functions in Ribbon View**

The following table details the location of the CAD toolbar functions in Ribbon view.

**NOTES:**

- The following table includes only the default functions available on the CAD toolbar.
- Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

- You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAD</td>
<td>Extend Lines</td>
<td>Format tab, Picture group, Drawing Tools list</td>
</tr>
<tr>
<td></td>
<td>Trim Lines</td>
<td>Format tab, Picture group, Drawing Tools list</td>
</tr>
<tr>
<td></td>
<td>Convert Lines to Polyline</td>
<td>Format tab, Picture group, Drawing Tools list</td>
</tr>
<tr>
<td></td>
<td>Make Lines Horizontal</td>
<td>Format tab, Picture group, Drawing Tools list</td>
</tr>
<tr>
<td></td>
<td>Make Lines Vertical</td>
<td>Format tab, Picture group, Drawing Tools list</td>
</tr>
<tr>
<td></td>
<td>Convert Lines and Polylines to Pipe</td>
<td>Format tab, Picture group, Drawing Tools list</td>
</tr>
<tr>
<td></td>
<td>Modify Pipe</td>
<td>Format tab, Styles group, Pipe Styles gallery</td>
</tr>
<tr>
<td></td>
<td>Add Connection Point</td>
<td>Format tab, Picture group, Drawing Tools list</td>
</tr>
<tr>
<td></td>
<td>Delete Connection Point</td>
<td>Format tab, Picture group, Drawing Tools list</td>
</tr>
<tr>
<td></td>
<td>Line Connector Tool</td>
<td>Format tab, Insert group, Connectors list</td>
</tr>
<tr>
<td></td>
<td>Right Angle Line Connector Tool</td>
<td>Format tab, Insert group, Connectors list</td>
</tr>
<tr>
<td></td>
<td>Pipe Connector</td>
<td>Format tab, Insert group, Connectors list</td>
</tr>
</tbody>
</table>

**Locating Chart Group Toolbar Functions in Ribbon View**

The following table details the location of the Chart Group toolbar functions in Ribbon view.
NOTES:

- The following table includes only the default functions available on the Chart Group toolbar.

- Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

- You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Group</td>
<td>Apply Chart Group Wizard to Chart</td>
<td>Tools tab, Charts Group, Chart Groups list</td>
</tr>
<tr>
<td></td>
<td>Apply Chart Group File</td>
<td>Tools tab, Charts Group, Chart Groups list</td>
</tr>
<tr>
<td></td>
<td>Configure Chart Group Files</td>
<td>Tools tab, Charts Group, Chart Groups list</td>
</tr>
</tbody>
</table>

Locating Dynamo Toolbar Functions in Ribbon View

The following table details the location of the Dynamo toolbar functions in Ribbon view.

NOTES:

- The following table includes only the default functions available on the Dynamo toolbar.

- Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

- You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamo</td>
<td>Build Dynamo</td>
<td>Tools tab, Dynamos Group, Dynamos list</td>
</tr>
<tr>
<td></td>
<td>Quick Dynamo Updater</td>
<td>Tools tab, Dynamos Group, Dynamos list</td>
</tr>
<tr>
<td></td>
<td>Dynamo Updater Wizard</td>
<td>Tools tab, Dynamos Group, Dynamos list</td>
</tr>
</tbody>
</table>
Understanding iFIX

Locating Edit Toolbar Functions in Ribbon View

The following table details the location of the Edit toolbar functions in Ribbon view.

**NOTES:**

- The following table includes only the default functions available on the Edit toolbar.

- Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

- You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Copy</td>
<td>Home tab, Clipboard group</td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>Home tab, Clipboard group</td>
</tr>
<tr>
<td></td>
<td>Paste</td>
<td>Home tab, Clipboard group, Paste list</td>
</tr>
<tr>
<td></td>
<td>Undo</td>
<td>Home tab, Editing group</td>
</tr>
</tbody>
</table>

Locating Expert Toolbar Functions in Ribbon View

The following table details the location of the Expert toolbar functions in Ribbon view.

**NOTES:**

- The following table includes only the default functions available on the Expert toolbar.
Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expert</td>
<td>Fill</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Rotate</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Position</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Scale</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Visibility</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Edge Color</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Foreground Color</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Background Color</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Data Entry Expert</td>
<td>Tools tab, Tasks/Experts group</td>
</tr>
<tr>
<td></td>
<td>Create Picture</td>
<td>Tools tab, Tasks/Experts group, Picture list</td>
</tr>
<tr>
<td></td>
<td>Open Picture</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
<tr>
<td></td>
<td>Close Picture</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
<tr>
<td></td>
<td>Replace Picture</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
<tr>
<td></td>
<td>Open Digital Tag</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
<tr>
<td></td>
<td>Close Digital Tag</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
<tr>
<td></td>
<td>Toggle Digital Tag</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
<tr>
<td></td>
<td>Acknowledge Alarm</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
</tbody>
</table>
### Locating Shapes Toolbar Functions in Ribbon View

The following table details the location of the Shapes toolbar functions in Ribbon view.

**NOTES:**

- *The following table includes only the default functions available on the Shapes toolbar.*

- *Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.*

- *You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.*

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shapes</td>
<td>Object Selection Tool</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Rectangle</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Oval</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Arc</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Rounded Rectangle</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Polygon</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Polyline</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Chord</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Pie</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Function</td>
<td>Ribbon View Location</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Pipe</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>Chart</td>
<td>Insert tab, Charts group</td>
<td></td>
</tr>
<tr>
<td>Bitmap</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>Datalink Stamper</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>Alarm Summary</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>Push Button</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>Variable</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>OLE Object</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>Timer</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>Event</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
<td></td>
</tr>
</tbody>
</table>

**Locating Standard Toolbar Functions in Ribbon View**

The following table details the location of the Standard toolbar functions in Ribbon view.

**NOTES:**

- *The following table includes only the default functions available on the Standard toolbar.*

- *Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.*

- *You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.*
### Locating Toolbox Toolbar Functions in Ribbon View

The following table details the location of the Toolbox toolbar functions in Ribbon view.

- **NOTES:**
  1. The following table includes only the default functions available on the Toolbox toolbar.
  2. Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
  3. You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.
<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbox</td>
<td>Object Selection Tool</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>Home tab, Clipboard group</td>
</tr>
<tr>
<td></td>
<td>Copy</td>
<td>Home tab, Clipboard group</td>
</tr>
<tr>
<td></td>
<td>Paste</td>
<td>Home tab, Clipboard group, Paste list</td>
</tr>
<tr>
<td></td>
<td>Time</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>Date</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>Rectangle</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Rounded Rectangle</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Oval</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Chord</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Polygon</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Pie</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Pipe</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Arc</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Polyl ine</td>
<td>Insert tab, Shapes group, Shapes gallery</td>
</tr>
<tr>
<td></td>
<td>Text</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>Push Button</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>OLE Object</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Function</td>
<td>Ribbon View Location</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Datalink Stamper</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>Alarm Summary</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>Variable</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>Timer</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>Event</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>Chart</td>
<td>Insert tab, Charts group</td>
</tr>
<tr>
<td></td>
<td>Bitmap</td>
<td>Insert tab, Objects/Links group, Objects/Links list</td>
</tr>
<tr>
<td></td>
<td>Color</td>
<td>Format tab, Styles group</td>
</tr>
<tr>
<td></td>
<td>Font</td>
<td>Format tab, Font group</td>
</tr>
<tr>
<td></td>
<td>Toggle Grid</td>
<td>Format tab, Arrange group, Grid list</td>
</tr>
<tr>
<td></td>
<td>Space Evenly Vertical</td>
<td>Format tab, Arrange group, Space Evenly list</td>
</tr>
<tr>
<td></td>
<td>Space Evenly Horizontal</td>
<td>Format tab, Arrange group, Space Evenly list</td>
</tr>
<tr>
<td></td>
<td>Align Top</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
<tr>
<td></td>
<td>Align Left</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
<tr>
<td></td>
<td>Align Bottom</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
<tr>
<td></td>
<td>Align Right</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
<tr>
<td></td>
<td>Align Horizontal Center</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
<tr>
<td></td>
<td>Align Vertical Center</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Function</td>
<td>Ribbon View Location</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Group</td>
<td>Format tab, Arrange group</td>
</tr>
<tr>
<td></td>
<td>Ungroup</td>
<td>Format tab, Arrange group</td>
</tr>
<tr>
<td></td>
<td>Bring to Front</td>
<td>Format tab, Arrange group</td>
</tr>
<tr>
<td></td>
<td>Send to Back</td>
<td>Format tab, Arrange group</td>
</tr>
<tr>
<td></td>
<td>Set Layer</td>
<td>Format tab, Picture group, Layers list</td>
</tr>
<tr>
<td></td>
<td>Display Layer</td>
<td>Format tab, Picture group, Layers list</td>
</tr>
<tr>
<td></td>
<td>Foreground Color Expert</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Fill Expert</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Rotate Expert</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Position Expert</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Scale Expert</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Visibility Expert</td>
<td>Tools tab, Animation group, Animations list</td>
</tr>
<tr>
<td></td>
<td>Create Picture Expert</td>
<td>Tools tab, Tasks/Experts group, Picture list</td>
</tr>
<tr>
<td></td>
<td>Open Picture Expert</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
<tr>
<td></td>
<td>Close Picture Expert</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
<tr>
<td></td>
<td>Replace Picture Expert</td>
<td>Tools tab, Tasks/Experts group, Commands list</td>
</tr>
<tr>
<td></td>
<td>Refresh Rate Expert</td>
<td>Tools tab, Tasks/Experts group, Picture list</td>
</tr>
<tr>
<td></td>
<td>Data Entry Expert</td>
<td>Tools tab, Tasks/Experts group</td>
</tr>
</tbody>
</table>
Locating Tools Toolbar Functions in Ribbon View

The following table details the location of the Tools toolbar functions in Ribbon view.

NOTES:

- The following table includes only the default functions available on the Tools toolbar.

- Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

- You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools</td>
<td>Align Top</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
<tr>
<td></td>
<td>Align Left</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
<tr>
<td></td>
<td>Align Bottom</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
<tr>
<td></td>
<td>Align Right</td>
<td>Format tab, Arrange group, Align list</td>
</tr>
</tbody>
</table>
### Locating Utilities Toolbar Functions in Ribbon View

The following table details the location of the Utilities toolbar functions in Ribbon view.

**NOTES:**

- *The following table includes only the default functions available on the Utilities toolbar.*
- *Although hidden by default, you can access and use toolbars in Ribbon view. To access a*
Understanding IFIX

toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

- You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Utilities</td>
<td>Add Database Block</td>
<td>Applications tab, Process Database group, Blocks list</td>
</tr>
<tr>
<td></td>
<td>Modify Database Block</td>
<td>Applications tab, Process Database group, Blocks list</td>
</tr>
<tr>
<td></td>
<td>Database Save</td>
<td>Applications tab, Process Database group</td>
</tr>
<tr>
<td></td>
<td>Database Reload</td>
<td>Applications tab, Process Database group</td>
</tr>
<tr>
<td></td>
<td>Resolve Files</td>
<td>Application tab, Utilities group, Utilities list</td>
</tr>
<tr>
<td></td>
<td>Export Picture</td>
<td>Application tab, Utilities group, Utilities list</td>
</tr>
<tr>
<td></td>
<td>Find Mouse Coordinates</td>
<td>Application tab, Utilities group, Utilities list</td>
</tr>
<tr>
<td></td>
<td>Save Files with Thumbnail</td>
<td>Application tab, Utilities group, Utilities list</td>
</tr>
<tr>
<td></td>
<td>Preferences</td>
<td>Application tab, Utilities group, Utilities list</td>
</tr>
</tbody>
</table>

Locating VisiconX Toolbar Functions in Ribbon View

The following table details the location of the VisiconX toolbar functions in Ribbon view.

**NOTES:**

- The following table includes only the default functions available on the VisiconX toolbar.

- Although hidden by default, you can access and use toolbars in Ribbon view. To access a toolbar in Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

- You can also open a toolbar from the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking the toolbar you want to open.
## Using the Proficy iFIX WorkSpace

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
<th>Ribbon View Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>VisiconX</td>
<td>VisiconX Data Control</td>
<td>Insert tab, VisiconX group, VisiconX list</td>
</tr>
<tr>
<td></td>
<td>VisiconX Grid Control</td>
<td>Insert tab, VisiconX group, VisiconX list</td>
</tr>
<tr>
<td></td>
<td>VisiconX List Box Control</td>
<td>Insert tab, VisiconX group, VisiconX list</td>
</tr>
<tr>
<td></td>
<td>VisiconX Combo Box Control</td>
<td>Insert tab, VisiconX group, VisiconX list</td>
</tr>
</tbody>
</table>

### Understanding the Ribbon

Beginning with iFIX 5.0, you can choose either Classic view or Ribbon view for your user interface.

The Ribbon contains all of the commands associated with the menus in Classic view, as well as almost all of the options previously only available on the toolbar. Not only does this make toolbars almost unnecessary in Ribbon view, it makes the Ribbon easier to use than Classic view.

### Ribbon Structure

The Ribbon is organized in tabs. Each tab contains groups, as the following figure illustrates.

![iFIX Ribbon - Tabs and Groups](image-url)
### Quick Access Toolbar and WorkSpace Button

The Ribbon has a customizable Quick Access toolbar, which allows you to easily access the commands you use most often with just the click of the mouse. The Quick Access toolbar is located in the upper left corner of the toolbar, as seen in the following figure.
Quick Access Toolbar – default commands include the following:

- Switch modes
- Save
- Activate Visual Basic Editor
- Full Screen
- Create a new picture

The WorkSpace button, illustrated in the preceding figure, provides access to commands as well as options for customizing the user interface.

**Understanding the Quick Access Toolbar**

The Quick Access toolbar provides a way to quickly execute frequently used commands. The Quick Access toolbar is customizable, allowing you to add as many or as few commands to the toolbar as you want.

In the following figure, nine commands have been added to the Quick Access toolbar, indicated by the number one. Typically, the five default commands that appear on toolbar are those listed in the toolbar list, indicated by number two.

To use the commands on the Quick Access toolbar, click the desired command on the toolbar or click the Customize Quick Access Toolbar list and click one of the default commands listed there.

**Understanding the WorkSpace Button**

The WorkSpace button, located in the upper left corner of the WorkSpace, provides access to commands located on the File menu in Classic view, such as New, Open, and Save. It also provides
**Understanding iFIX**

access to further options, such as ways to customize the user interface in Ribbon view, or contact Technical Support.

**Understanding KeyTips**

In Ribbon view, KeyTips replace underlined menu letters as indicators of keys to press to invoke a command. They appear when you press the ALT or F10 key.

In the following figure, the KeyTips are circled in red. Each KeyTip corresponds to the command, tab or button to which it is closest. Notice that in the Quick Access toolbar that numbers 3, 5, and 6 are unavailable, indicating those commands cannot be accessed at the time.

To access a command, tab or button, press <ALT>+<KeyTip>. For example, to access the Administration tab using the KeyTips illustrated in the following figure, you would press <ALT>+<D>.

![iFIX Ribbon - KeyTips](image)

**The Ribbon at Run Time**

In run mode, you can access the Ribbon, which displays the Historical tab and the Global Time Control, as seen in the following figure. By default, the Ribbon is minimized in run mode, which allows for a larger display area for pictures. To display the Ribbon, click the Historical tab.

![The Ribbon in Run Mode](image)

If the Ribbon is hidden and you want to use the Global Time Control or any other feature available on the Ribbon at run time, you only need to clear the Minimize the Ribbon option on the Quick Access Tool list while in run mode, as illustrated in the following figure.
Using the Proficy iFIX WorkSpace

**The Minimize the Ribbon Option for the Ribbon in Run Mode**

**The Ribbon in Full Screen Run Mode**

While in full screen run mode, the Ribbon is not visible, by default. However, you can use the Alt key to display it. Clicking on a picture causes the Ribbon, if it is visible, to return to a non-visible state. To always display the Ribbon when in full screen run mode, clear both the Auto Hide the Ribbon and the Minimize the Ribbon options on the Quick Access Tool list while in run mode, as illustrated in the following figure.

**The Quick Access Tool list in Full Screen Run Mode**

**Setting User Preferences**

The Proficy iFIX WorkSpace provides several options that you can configure. These options include:

- Picture, shape, drawing, and chart preferences. Refer to the Understanding Picture, Shape, Drawing, and Chart Preferences section for more information.
- Save preferences. Refer to the Saving Back-up Files section for more information.
- Run-time preferences. Refer to the Configuring Run-time Preferences section for more information.
- The iFIX WorkSpace's start-up environment. Refer to the Changing the Start-up Environment section for more information.
- OPC connection (animation error) preferences. Refer to the Animation Error Preferences section for more information.
- Monitor preferences. Refer to the Multiple Monitors and iFIX section for more information.
Understanding Picture, Shape, Drawing, and Chart Preferences

Picture preferences include the default size and background color, and whether the picture includes a title bar, system bar, and the ability to resize. You can also specify whether your pictures will use a gradient fill, will save a thumbnail, can be cached, and can be auto scaled.

Shape preferences let you specify the default colors of new objects in a picture and default styles, such as fill and edge style. If the fill style is Gradient, you can specify fade type. You can define default pipe properties, and the default font name, point size, and styles.

Drawing preferences let you specify the line extension and line trimming options and whether or not to display connection nodes on objects.

Chart preferences let you select the defaults for Standard Chart objects only. These defaults include the number of ticks per axis, the number of labels per axis, the direction in which the chart scrolls, and the length of time the chart displays. To learn more about all picture, shapes, drawing, and chart preferences, refer to the Creating Pictures manual.

Saving Back-up Files

Each time you save a file, the Proficy iFIX WorkSpace copies the previous version to a back-up subfolder and saves the new version. If a back-up file already exists for the current file, the new back-up replaces it.

Back-up subfolders reside inside the system tree folders but do not appear in the system tree. For example, the Pictures back-up subfolder resides inside the Pictures folder and contains back-ups of modified pictures.

Depending on the amount of free disk space you have and the size of your pictures, you may want to disable the back-up option to save space.

Configuring Run-time Preferences

The Proficy iFIX WorkSpace has several run-time preferences, which include:

- Saving your open documents automatically when you switch to the run-time environment. Using this feature, you can toggle between the two environments without worrying about saving your changes. By default, this option is disabled. If you enable it and you want to test a change to a picture or schedule without saving the modification, you must disable the preference before switching to the run-time environment. If you do not, the WorkSpace automatically saves the change.

- Displaying the Proficy iFIX WorkSpace full-screen. This feature provides maximum screen space for creating and displaying pictures. When you display the WorkSpace full-screen, it hides its menu bar, system tree, and any docked toolbars. Floating toolbars remain visible.

- Opening specific pictures automatically when the Proficy iFIX WorkSpace starts in the run-time environment. Use this option to define the specific files you want to open automatically for your operators.

- Opening specific schedules you want to open in the background. Use this option to indicate the specific files you want the FixBackgroundServer task to load on start-up.
Changing the Start-up Environment

The start-up environment option lets you specify the environment in which the Proficy iFIX WorkSpace starts. By default, the Proficy iFIX WorkSpace starts in the configuration environment.

However, when you have finished configuring each node, you may want to configure the Proficy iFIX WorkSpace to start up in the run-time environment automatically.

Animation Error Preferences

Each animated object in a picture uses OPC protocols to receive data and report errors. The animation error preferences define the default error strings and values that the object uses when an error occurs. For example, by default, when a communication error occurs, Data links display the text "@@@@".

You can customize the animation error defaults by entering new values in the Animations Data Error Defaults tab. By changing the defaults, you make the default error messages more intuitive for your industry. For example, when a communication error occurs, you can have Data links display the following text by entering it into the Comm field of the Format Animation Object Defaults area:

```
Cannot communicate with server
```

Choosing the User Interface

The Proficy iFIX WorkSpace provides two options for user interfaces. They are:

- Classic view – this user interface was the only one available prior to iFIX 5.0. It uses a number of toolbars in addition to menu driven commands.
- Ribbon view – this user interface is available beginning with iFIX 5.0. Almost all functions previously available in Classic view via the toolbar can now be accessed on the Ribbon, without opening or importing toolbars.

Customizing the Ribbon User Interface

In Ribbon view, you can customize the look and feel of the user interface. Customization choices include:

- Changing the color scheme of the WorkSpace.
- Determining how ScreenTips are displayed.
- Customizing the Quick Access toolbar.
- Creating and customizing keyboard shortcuts.
- Deciding whether or not to show KeyTips.

Displaying the Visual Basic Editor

You can write Visual Basic for Applications scripts for any picture, toolbar button, schedule, or iFIX object. Using VBA gives you complete control over your process automation solution because it lets you create custom scripts and automate iFIX for your needs.
Understanding iFIX

You can begin writing scripts by displaying the Visual Basic Editor. The VBE provides access to all the available methods, properties, and events for your iFIX objects.

You can display the VBE in many ways, such as by selecting Visual Basic Editor from the WorkSpace menu (Classic view) or on the Home tab, in the WorkSpace group, click Visual Basic Editor (Ribbon view), or right-clicking an object and selecting Edit Script from the pop-up menu, and creating a schedule and clicking VB Editor from the Add Event Entry or Add Timer Entry dialog box.

To learn how to use the VBE, refer to its online Help. To learn how to write scripts for iFIX objects, buttons, pictures, and schedules, refer to the Writing Scripts manual. For information on iFIX methods, properties, and events, refer to the iFIX Automation Interfaces Help file.

Multiple Monitors and iFIX

The iFIX WorkSpace supports the use of multiple monitors for displaying pictures in an expanded space. You must configure your video driver (following the instructions from your hardware vendor) to enable your desktop space to span all your monitors. However, if you are using true multi-monitor settings where you can have multiple monitors with independent resolutions, WorkSpace supports this, too.

After you configure the monitor settings for your computer, you can enable the iFIX User Preference to allow for the multiple monitors. For multiple monitors to work properly with iFIX, you must have the identical resolution set on all monitors. The primary monitor (Monitor 1) should always be set to the topmost, and leftmost area in the Windows Display Properties dialog box.

Valid Monitor Settings Example

The following figures display valid dual monitor settings for the iFIX WorkSpace, as shown in the Windows Display Properties dialog box:

Invalid Monitor Settings Example

The following graphics display invalid dual monitor settings the iFIX WorkSpace, as shown in the Windows Display Properties dialog box:
Configuration in iFIX

After you configure the overall monitor settings for your computer, you can configure iFIX to display multiple monitors.

To configure multiple monitors in iFIX, in the User Preferences dialog box, on the General tab, select the Extend WorkSpace to support multiple monitors check box and click OK. Be aware that if you later disable this user preference, the WorkSpace shrinks to one monitor (Monitor 1), but it does not move any child windows back into the single monitor view. The child windows remain in the same location; you need to scroll and drag them back into the Monitor 1 area to view them again.

For help with opening pictures across multiple monitors, you can use the Track Mouse Coordinates Tool in the iFIX WorkSpace. For more information, refer to the Using the Find Mouse Coordinates Tool section in the Creating Pictures e-book. This tool will help you quickly locate the coordinates of the upper left corner where you want a picture to open.

WorkSpace Dialog Boxes

The WorkSpace application includes the following dialog boxes (listed in alphabetical order):

- Add Server Dialog Box
- Button Properties Dialog Box
- Customize Toolbars Dialog Box
- Data Server Installer Dialog Box
- Expression Builder Dialog Box
- Find and Replace Dialog Box
- Get Project Dialog Box
- Import Toolbars Dialog Box
- Modify Server Dialog Box
- Proficy iFIX Project Backup Dialog Box
- Proficy iFIX Project Backup Wizard
- Proficy iFIX Restore Wizard
- Task Wizard Dialog Box
- Toolbars Dialog Box
- User Preferences Dialog Box

Add Server Dialog Box

The Add Server dialog box displays the following items:

Data Server

Specifies a name for the OPC driver. This name identifies the driver to iFIX and is used in data sources to access the selected OPC driver. Make sure the name you enter contains no spaces and is not
already used by another data server.

**OPC Server**

Specifies the OPC driver you want use.

**Machine Name**

Specifies the local computer name, or the remote computer name that the OPC Server resides on.

**Set As Default Server**

Select this check box to set the current OPC server as the default server. iFIX will use this server when you do not explicitly enter a server name in a data source.

**Button Properties Dialog Box**

The Button Properties dialog box displays the following items:

**Bitmaps List Box**

Displays a list of bitmaps in the iFIX Local path. You can select one of these bitmaps for the button or you can select a custom bitmap of your own by browsing to it. If you select a custom bitmap, the image can be no more than 20 x 20 pixels and use no more than 16 colors.

**Preview**

Displays a preview of the bitmap highlighted in the Current Directory bitmap list.

**Category**

Specifies the current category.

**Name**

Specifies the name of the button you are configuring. You can edit this name by entering the text you want.

**Description**

Lets you enter a text description for the button you are configuring. This text appears on the Buttons tab when you select the button.

**Screentip**

Lets you enter a text description of up to 128 characters for the button you are configuring. This text pops up when you place the cursor over the button.
**Edit Script**

Lets you open the Visual Basic Editor, and enter or edit the current button's script.

**Configure the Proficy Historian Server(s) Dialog Box**

The Configure the Proficy Historian Server(s) dialog box displays the following items:

**Alias Name/Server Name List**

Lists the alias and server name of the configured Historian.

**Set Default**

Use this button to set the server selected in the Alias Name/Server Name list as the default Historian server.

**Add Server**

Use this button to add a Historian server.

**Modify**

Use this button to modify server characteristics.

**Delete**

Use this button to delete the selected server from the Alias Name/Server Name list.

**Alias Name**

Enter the alias name in this field. This field is unavailable if the default server is selected. Do not use special characters, such as @, $, or #, in this field.

**Server Name**

Enter the server name in this field.

**User Name**

Enter the user name for the Historian server.

**Password**

Enter the password for the Historian server.

**Close**

Use this button to close the Configure the Proficy Historian Server(s) dialog box.
Understanding iFIX

Get Collectors

Use this button to populate the Collector Name list.

Collector Name List

Lists only the collectors that use iFIX EDA, which includes the following:

- iFIX Native Collector
- OPC EDA Collector
- iFIX OPC Collector

NOTE: The Collector Name List only displays local collectors, even if you set a remote server as the default server.

Set Default

Use this button to set the collector in the Collector Name list as the default.

Customize Toolbars Dialog Box

The Customize Toolbars dialog box displays the following items:

Toolbars Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Lets you select a toolbar owner. Only active owners appear in the list.</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Lets you show and hide the selected toolbar.</td>
</tr>
<tr>
<td>Enable Docking for Selected Toolbar</td>
<td>Lets you enable or disable toolbar docking.</td>
</tr>
<tr>
<td>Show ScreenTips on Toolbars</td>
<td>Lets you enable or disable text descriptions for every button on every toolbar. When enabled, you can display a description by placing the cursor over a button.</td>
</tr>
<tr>
<td>Add Toolbar</td>
<td>Lets you create a toolbar.</td>
</tr>
<tr>
<td>Modify Properties</td>
<td>Lets you modify the properties of the selected toolbar. Toolbars supplied with iFIX cannot be modified.</td>
</tr>
<tr>
<td>Delete Toolbar</td>
<td>Lets you delete the selected toolbar. Toolbars supplied with iFIX cannot be deleted.</td>
</tr>
</tbody>
</table>
Using the Proficy iFIX WorkSpace

**Item** | **Description**
--- | ---
Reset | Lets you reset the selected toolbar to its default state. Any buttons removed from the toolbar and supplied by default are added back. All buttons not supplied with the toolbar are removed. Resetting a toolbar affects toolbars supplied with iFIX; toolbars you create are not affected.

Import | Lets you import custom toolbars shared among your iFIX nodes or created by a toolbar developer.

### Buttons Tab

**Item** | **Description**
--- | ---
Categories | Lets you select a toolbar category.
Add Category | Lets you add a toolbar category.
Rename Category | Lets you rename the selected toolbar category. Categories supplied with iFIX cannot be renamed.
Delete Category | Lets you delete the selected toolbar category. Categories supplied with iFIX cannot be deleted.
Buttons Area | Drag and drop a button from this group box onto a toolbar, or double-click a button in the toolbar to edit the VBA script.
Description | Displays a description of the selected button.
Add Button | Lets you add a button to the selected category.
Modify Button | Lets you modify the selected button's properties. You cannot modify a button supplied with iFIX.
Delete Button | Lets you delete the selected toolbar button. Buttons supplied with iFIX cannot be deleted.

### Data Server Installer Dialog Box

The Data Server Installer dialog box displays the following items:
Understanding IFIX

Data Servers
Displays the available OPC servers and lets you select the server you want to modify or delete.

OPC Server
Specifies the OPC driver of the selected server.

Machine Name
Specifies the local computer name, or the remote computer name that the OPC Server resides on.

Add
Use this button to add (install) an OPC server.

Remove
Use this button to delete the selected OPC server.

Modify
Use this button to modify the selected OPC server.

Expression Builder Dialog Box
The Expression Builder dialog box displays the following items:

NOTE: If a tab is not displayed, you can click the Available Data Sources drop-down to select the applicable one that you want to bring into view. The following figure illustrates where the Available Data Sources drop-down appears in the Expression Builder dialog box.

FIX Database Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Names List Box</td>
<td>Displays a filtered list of SCADA servers that the local node is communicating with. By default, all SCADA servers are displayed.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Node Names Filter</td>
<td>Specifies the current SCADA server filter. You can edit the filter or select one from the list. You can also include in the filter the wildcards ? (to represent a single character) or * (to represent two or more characters).</td>
</tr>
<tr>
<td>Node Names Filter Button</td>
<td>Use this button to update the list of nodes based on the current SCADA server filter.</td>
</tr>
<tr>
<td>Tag Names List Box</td>
<td>Displays a filtered list of database blocks (tags) on the selected SCADA server. By default, all blocks are displayed.</td>
</tr>
<tr>
<td>Tag Names Filter</td>
<td>Specifies the current block name filter. You can edit the filter or select one from the list. You can also include in the filter the wildcards ? (to represent a single character) or * (to represent two or more characters).</td>
</tr>
<tr>
<td>Tag Names Filter Button</td>
<td>Use this button to update the list of blocks based on the current block filter.</td>
</tr>
<tr>
<td>Field Names List Box</td>
<td>Displays a filtered list of fields available from the selected block. By default, all blocks are displayed.</td>
</tr>
<tr>
<td></td>
<td>You can receive help on any field displayed in this list box by using the Block Field Reference and selecting the field's block from the list that appears.</td>
</tr>
<tr>
<td>A_* Button</td>
<td>Use this button to change the block field filter to display all A_ fields and selects the A_CV field, if available.</td>
</tr>
<tr>
<td>F_* Button</td>
<td>Use this button to change the block field filter to display all F_ fields and selects the F_CV field, if available.</td>
</tr>
<tr>
<td>E_* Button</td>
<td>Use this button to change the block field filter to display all E_ fields and selects the E_CV field, if available.</td>
</tr>
<tr>
<td>Block Field Filter</td>
<td>Specifies the current block field filter. You can edit the filter or select one from the list. You can also include in the filter the wildcards ? (to represent a single character) or * (to represent two or more characters).</td>
</tr>
<tr>
<td>Block Field Filter Button</td>
<td>Use this button to update the list of fields based on the current block field filter.</td>
</tr>
</tbody>
</table>
### Current Expression Box

Specifies the current expression. You can enter the expression directly or build it by making selections from the other fields and buttons on the tabbed page.

**Valid Characters:** all alphanumeric characters, hyphen (-), underscore (_), exclamation point (!), less than (<), greater than (>), pound (#), percent (%), dollar sign ($), ampersand (&), forward slash (/), backslash (\), pipe (|), opening bracket ([), closing bracket (]), and single quote (').

If a single quote (') or a backslash (\) is a literal part of the addressing string syntax, it must be preceded by a backslash (\) in order for the character to be passed to the server as part of the address. For example, to enter a tag with the name 'TEST', you would enter the data source \\FIX32.THISNODE.\'TEST\'.F_CV.

### Tolerance

Specifies the current connection's rounding factor. Typically, iFIX uses this value when comparing a process value to a target value. If the process value is within the specified tolerance, iFIX assumes the two values are equal. For example, if the target value is 1.0, the tolerance is 0.1, and the current value of a data source is 0.8, iFIX does not assume the two values are equal because the data source is not within the specified tolerance. The value must be within the range 0.9 to 1.1 to equal the target value. Seven digits of precision are allowed for accuracy.

### Deadband

Specifies the maximum fluctuation you want for the current connection before iFIX updates it. By entering a dead band value, you create a +/- dead zone around the connection's current value. As long as the value is within this range, iFIX does not update the value. However, once the value exceeds the maximum or minimum dead band, the value is updated. Seven digits of precision are allowed for accuracy.

### Refresh Rate

Specifies the rate at which iFIX updates the current connection. iFIX updates the connection no faster than the specified speed. For speeds less than 1 second, iFIX updates no faster than once every 50 milliseconds. For speeds greater than 60 seconds, iFIX updates no faster than once every 60 seconds.

### Check Syntax Button

Use this button to check the syntax of your expression. A valid expression displays the message "Syntax check successful!" An error message appears if the syntax is invalid.

### Mathematical Functions Button

Use this button to show or hide a keypad of numbers, and mathematical and Boolean operators you can use in your expressions.
# Using the Proficy iFIX WorkSpace

## Pictures and Globals Tabs

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objects List Box</td>
<td>Displays a list of the open pictures (Pictures tab) or the global objects (Globals tab) available on this node. By expanding a picture or the user globals, you can display a filtered list of objects in the pictures or in the User Globals folder.</td>
</tr>
<tr>
<td>Object Filter</td>
<td>Specifies the current filter for the selected item. You can edit the filter or select one from the filter list. You can also include in the filter the wildcards ? (to represent a single character) or * (to represent two or more characters).</td>
</tr>
<tr>
<td>Object Filter Button</td>
<td>Use this button to update the item list based on the current filter.</td>
</tr>
<tr>
<td>Properties List Box</td>
<td>Specifies the properties for the currently selected picture or object.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> If you have created an object-to-object connection, such as the fill percentage of one tank to another, or created a connection to a data source, the animated properties display in boldface.</td>
<td></td>
</tr>
<tr>
<td>Properties Filter</td>
<td>Specifies the current property filter. You can edit the filter or select one from the list. You can also include in the filter the wildcards ? (to represent a single character) or * (to represent two or more characters).</td>
</tr>
<tr>
<td>Properties Filter Button</td>
<td>Use this button to update the list of properties based on the current property filter.</td>
</tr>
<tr>
<td>Current Expression Box</td>
<td>Specifies the current expression. You can enter the expression directly or build it by making selections from the other fields and buttons on the tabbed page.</td>
</tr>
<tr>
<td><strong>Valid Characters:</strong> all alphanumeric characters, hyphen (-), underscore (_), exclamation point (!), less than (&lt;), greater than (&gt;), pound (#), percent (%), dollar sign ($), ampersand (&amp;), forward slash (/), backslash (), pipe (</td>
<td>), opening bracket ([), closing bracket (]), and single quote (').</td>
</tr>
<tr>
<td>If a single quote (') or a backslash () is a literal part of the addressing string syntax, it must be preceded by a backslash () in order for the character to be passed to the server as part of the address. For example, to enter a tag with the name 'TEST', you would enter the data source FIX32.THISNODE.'TEST'.F_cv.</td>
<td></td>
</tr>
</tbody>
</table>
Understanding iFIX

### Item | Description
--- | ---
Tolerance | Specifies the current connection's rounding factor. Typically, iFIX uses this value when comparing a process value to a target value. If the process value is within the specified tolerance, iFIX assumes the two values are equal. For example, if the target value is 1.0, the tolerance is 0.1, and the current value of a data source is 0.8, iFIX does not assume the two values are equal because the data source is not within the specified tolerance. The value must be within the range 0.9 to 1.1 to equal the target value.

Deadband | Specifies the maximum fluctuation you want for the current connection before iFIX updates it. By entering a dead band value, you create a +/- dead zone around the connection's current value. As long as the value is within this range, iFIX does not update the value. However, once the value exceeds the maximum or minimum dead band, the value is updated.

Refresh Rate | Specifies the rate at which iFIX updates the current connection. iFIX updates the connection no faster than the specified speed. For speeds less than 1 second, iFIX updates no faster than once every 50 milliseconds. For speeds greater than 60 seconds, iFIX updates no faster than once every 60 seconds.

Check Syntax Button | Use this button to check the syntax of your expression. A valid expression displays the message "Syntax check successful!" An error message appears if the syntax is invalid.

Mathematical Functions Button | Use this button to show or hide a keypad of numbers, and mathematical and Boolean operators you can use in your expressions.

### Data Servers Tab

#### Item | Description
--- | ---
Data Servers Box | Displays a list of the SCADA servers collecting historical data for the local node (Historical tab) or the third-party OPC servers that support browsing (Data Servers tab). By expanding a node, you can display a filtered list of the historical values being collected or the I/O points being monitored. Refer to the Entering Data Source Syntax section in the Creating Pictures electronic book for additional information about using third-party OPC servers.

Data Servers Filter | Specifies the current filter for the selected item. You can edit the filter or select one from the filter list. You can also include in the filter the wildcards ? (to represent a single character) or * (to represent two or more characters).
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Servers Filter Button</td>
<td>Use this button to update the item list based on the current filter.</td>
</tr>
</tbody>
</table>
| Current Expression Box       | Specifies the current expression. You can enter the expression directly or build it by making selections from the other fields and buttons on the tabbed page.  
**Valid Characters:** all alphanumeric characters, hyphen (-), underscore (_), exclamation point (!), less than (<), greater than (>), pound (#), percent (%), dollar sign ($), ampersand (&), forward slash (/), backslash (\), pipe (|), opening bracket ([), closing bracket (]), and single quote (').  
If a single quote ('') or a backslash (\) is a literal part of the addressing string syntax, it must be preceded by a backslash (\) in order for the character to be passed to the server as part of the address. For example, to enter a tag with the name 'TEST', you would enter the data source FIX32.THISNODE.'TEST'.F_CV.  
**Note on Tag Group Substitution and your Expression**  
If you use tag group substitution and the object of your substitution is an element in an OPC server address that includes double quotes surrounding its data items, it is recommended that you add single quotes surrounding the tag group symbol. For example, the following substitution for the PDS driver will fail:  
'PDS.<Item Project=@PRJT@ Device="Device1" id="%R00001" dataType="VT_12" FGUSpan="0.00" EGULow="0.00"/>'  
However, the modified string ('@PRJT@') in this example, is one that will resolve properly:  
'PDS.<Item Project="@PRJT@" Device="Device1" id="%R00001" dataType="VT_12" FGUSpan="0.00" EGULow="0.00"/>' |
| Tolerance                    | Specifies the current connection's rounding factor. Typically, iFIX uses this value when comparing a process value to a target value. If the process value is within the specified tolerance, iFIX assumes the two values are equal. For example, if the target value is 1.0, the tolerance is 0.1, and the current value of a data source is 0.8, iFIX does not assume the two values are equal because the data source is not within the specified tolerance. The value must be within the range 0.9 to 1.1 to equal the target value. |
| Deadband                     | Specifies the maximum fluctuation you want for the current connection before iFIX updates it. By entering a dead band value, you create a +/- dead zone around the connection's current value. As long as the value is within this range, iFIX does not update the value. However, once the value exceeds the maximum or minimum dead band, the value is updated. |
### Understanding iFIX

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Rate</td>
<td>Specifies the rate at which iFIX updates the current connection. iFIX updates the connection no faster than the specified speed. For speeds less than 1 second, iFIX updates no faster than once every 50 milliseconds. For speeds greater than 60 seconds, iFIX updates no faster than once every 60 seconds.</td>
</tr>
<tr>
<td>Check Syntax Button</td>
<td>Use this button to check the syntax of your expression. A valid expression displays the message &quot;Syntax check successful!&quot; An error message appears if the syntax is invalid.</td>
</tr>
<tr>
<td>Mathematical Functions Button</td>
<td>Use this button to show or hide a keypad of numbers, and mathematical and Boolean operators you can use in your expressions.</td>
</tr>
</tbody>
</table>

### Alarm Counters Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Names List Box</td>
<td>Displays a filtered list of SCADA servers that the local node is communicating with. By default, all SCADA servers are displayed.</td>
</tr>
<tr>
<td>Node Names Filter</td>
<td>Specifies the current SCADA server filter. You can edit the filter or select one from the list. You can also include in the filter the wildcards ? (to represent a single character) or * (to represent two or more characters).</td>
</tr>
<tr>
<td>Node Names Filter Button</td>
<td>Use this button to update the list of nodes based on the current SCADA server filter.</td>
</tr>
<tr>
<td>Alarm Area Tag Names List Box</td>
<td>Displays a filtered list of alarm areas on the selected SCADA server. Also displays the alarm counter (ALARMCOUNTERS) tag. By default, all areas are displayed.</td>
</tr>
<tr>
<td>Alarm Area Tag Names Filter</td>
<td>Specifies the current area name filter. You can edit the filter or select one from the list. You can also include in the filter the wildcards ? (to represent a single character) or * (to represent two or more characters).</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Alarm Area Tag Names Filter Button</td>
<td>Use this button to update the list of areas based on the current area filter.</td>
</tr>
<tr>
<td>Alarm Counter Field Names List Box</td>
<td>Displays a filtered list of fields available from the selected area. By default, all fields are displayed.</td>
</tr>
<tr>
<td>A_* Button</td>
<td>Use this button to change the field filter to display all A_ fields.</td>
</tr>
<tr>
<td>F_* Button</td>
<td>Use this button to change the field filter to display all F_ fields.</td>
</tr>
<tr>
<td>Alarm Counter Field Names Filter</td>
<td>Specifies the current area field filter. You can edit the filter or select one from the list. You can also include in the filter the wildcards ? (to represent a single character) or * (to represent two or more characters).</td>
</tr>
<tr>
<td>Alarm Counter Field Names Filter Button</td>
<td>Use this button to update the list of fields based on the current field filter.</td>
</tr>
</tbody>
</table>
| Current Expression Box | Specifies the current expression. You can enter the expression directly or build it by making selections from the other fields and buttons on the tabbed page.  

**Valid Characters:** all alphanumeric characters, hyphen (-), underscore (_), exclamation point (!), less than (<), greater than (>), pound (#), percent (%), dollar sign ($), ampersand (&), forward slash (/), backslash (\), pipe (|), opening bracket ([), closing bracket (]), and single quote (’).  
If a single quote (’ or a backslash (\) is a literal part of the addressing string syntax, it must be preceded by a backslash (\) in order for the character to be passed to the server as part of the address. For example, to enter a tag with the name 'TEST', you would enter the data source FIX32.THISNODE."TEST".F_CV. |
### Understanding iFIX

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tolerance</td>
<td>Specifies the current connection's rounding factor. Typically, iFIX uses this value when comparing a process value to a target value. If the process value is within the specified tolerance, iFIX assumes the two values are equal. For example, if the target value is 1.0, the tolerance is 0.1, and the current value of a data source is 0.8, iFIX does not assume the two values are equal because the data source is not within the specified tolerance. The value must be within the range 0.9 to 1.1 to equal the target value.</td>
</tr>
<tr>
<td>Deadband</td>
<td>Specifies the maximum fluctuation you want for the current connection before iFIX updates it. By entering a dead band value, you create a +/- dead zone around the connection's current value. As long as the value is within this range, iFIX does not update the value. However, once the value exceeds the maximum or minimum dead band, the value is updated.</td>
</tr>
<tr>
<td>Refresh Rate</td>
<td>Specifies the rate at which iFIX updates the current connection. iFIX updates the connection no faster than the specified speed. For speeds less than 1 second, iFIX updates no faster than once every 50 milliseconds. For speeds greater than 60 seconds, iFIX updates no faster than once every 60 seconds.</td>
</tr>
<tr>
<td>Check Syntax Button</td>
<td>Use this button to check the syntax of your expression. A valid expression displays the message &quot;Syntax check successful!&quot; An error message appears if the syntax is invalid.</td>
</tr>
<tr>
<td>Mathematical Functions Button</td>
<td>Use this button to show or hide a keypad of numbers, and mathematical and Boolean operators you can use in your expressions.</td>
</tr>
</tbody>
</table>

### Proficy Historian Tab

**NOTE:** This tab only appears if the data source selected permits historical data.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Servers</td>
<td>Displays a selection list of servers.</td>
</tr>
<tr>
<td>Display Collector Name Check Box</td>
<td>Allows you to select whether Collector names are displayed.</td>
</tr>
<tr>
<td>Node Names List Box</td>
<td>Displays a filtered list of SCADA servers that the local node is communicating with. By default, all SCADA servers are displayed.</td>
</tr>
<tr>
<td>Tag Names List Box</td>
<td>Displays a filtered list of database blocks (tags) on the selected SCADA server. By default, all blocks are displayed.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description List Box</td>
<td>Displays a filtered list of descriptors of the selected SCADA server. By default, all descriptions are displayed.</td>
</tr>
<tr>
<td>Collector Names List Box</td>
<td>Displays a filtered list of Collector Names for the selected SCADA server. By default, all Collector Names are displayed.</td>
</tr>
<tr>
<td>Filter fields</td>
<td>Displays four drop-down lists that you can use filter what displays in the tag list. Any combination of four filters can be selected at one time:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Node</strong> - Specifies the current node name for the SCADA server you want to filter on. Leave it set to All (*), or enter a node name or expression to filter by.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Tag</strong> - Specifies the current description filter. Leave it set to All (*), or enter a tag name or expression to filter by.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Description</strong> - Specifies the current description filter. Leave it set to All (*), or enter a tag description or expression to filter by.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Collector Type</strong> - Specifies the current collector type filter. You can select a collector type from this list, such as: All, CalcEngine, File, iFIX, LabData, Manual, OPC, Other, ServerToServer, and Simulation. The default is All.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Engineering Units</strong> - Specifies the engineering units filter. Leave it set to All (*), or enter a type of units or expression to filter by.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Data Type</strong> - Specifies the current tag name filter. You select a data type from the list, such as: All, Double Float, Double Integer, Scaled, Single Float, or Single Integer.</td>
</tr>
</tbody>
</table>

For all fields, except Collector Type and Data Type, when building a filter expression, you can include a wildcard ? (to represent a single character) or * (to represent two or more characters) in the filter.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Filter Button</td>
<td>Use this button to apply the selected filter to the item list.</td>
</tr>
<tr>
<td>Reset Filter Button</td>
<td>Use this button to reset the item list based on the current filter.</td>
</tr>
<tr>
<td>Filtered Tag Count</td>
<td>Displays the number of tags found that meet filter criteria.</td>
</tr>
<tr>
<td>Maximum Count</td>
<td>Displays the maximum number of tags that the search can return from Proficy Historian.</td>
</tr>
</tbody>
</table>
Understanding iFIX

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Current Expression Box| Specifies the current expression. You can enter the expression directly or build it by making selections from the other fields and buttons on the tabbed page.  
Valid Characters: all alphanumeric characters, hyphen (-), underscore (_), exclamation point (!), less than (<), greater than (>), pound (#), percent (%), dollar sign ($), ampersand (&), forward slash (/), backslash (\), pipe (|), opening bracket ([), closing bracket (]), and single quote (').  
If a single quote (') or a backslash (\) is a literal part of the addressing string syntax, it must be preceded by a backslash (\) in order for the character to be passed to the server as part of the address. For example, to enter a tag with the name 'TEST', you would enter the data source FIX32.THISNODE.\'TEST\'.F_CV. |
| Check Syntax Button   | Use this button to check the syntax of your expression. A valid expression displays the message "Syntax check successful!" An error message appears if the syntax is invalid.                                               |

Find and Replace Dialog Box

The Find and Replace dialog box displays the following items:

Find Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find What</td>
<td>Specifies the text you want to search for (the search string).</td>
</tr>
<tr>
<td>Match Case</td>
<td>Select this check box to limit your search to only the values that match the exact case of the search string.</td>
</tr>
<tr>
<td>Whole Word Only</td>
<td>Select this check box to limit your search to only whole words that match the search string. A whole word is any text delimited by a carriage return, a line feed, a space, a hyphen (-), a semi-colon (;), a colon (:), a comma (,), a period (.), an underscore (_), an exclamation point (!), quotation marks (&quot;), an apostrophe ('), or the following characters: (, ), {, }, [, ]</td>
</tr>
<tr>
<td>Data Source Only</td>
<td>Select this check box to limit your search to only data sources that match the search string.</td>
</tr>
<tr>
<td>Include Scripts</td>
<td>Select this check box to expand your search to include the scripts associated with the current picture or schedule.</td>
</tr>
</tbody>
</table>
### Using the Proficy iFIX WorkSpace

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Find Button</strong></td>
<td>Use this button to display any value that matches the search string. On the Replace tab, only values you can modify appear. These values can be picture and scheduler properties, or property values of objects in your pictures.</td>
</tr>
<tr>
<td><strong>Match List</strong></td>
<td>Displays the properties and property values that match the search string after you click the Find button. On the Replace tab, a preview of the replaced text also appears when you click Replace Preview. You can jump to the current picture, schedule, or one of the objects in the list by double-clicking it.</td>
</tr>
<tr>
<td><strong>Stop Button</strong></td>
<td>Use this button to stop the search or replace in progress.</td>
</tr>
<tr>
<td><strong>Go To Button</strong></td>
<td>Use this button to jump to the object, picture, or schedule selected in the Match List list box. Before jumping, the Proficy iFIX WorkSpace closes the Find and Replace dialog box. If you jump to an object, the Proficy iFIX WorkSpace selects it after the dialog box closes.</td>
</tr>
</tbody>
</table>

### Replace Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Find What</strong></td>
<td>Specifies the text you want to search for (the search string).</td>
</tr>
<tr>
<td><strong>Replace With</strong></td>
<td>Specifies the text you want to substitute for the search string.</td>
</tr>
<tr>
<td><strong>Match Case</strong></td>
<td>Select this check box to limit your search to only the values that match the exact case of the search string.</td>
</tr>
<tr>
<td><strong>Whole Word Only</strong></td>
<td>Select this check box to limit your search to only whole words that match the search string. A whole word is any text delimited by a carriage return, a line feed, a space, a hyphen (-), a semi-colon (;), a colon (:), a comma (,), a period (.), an underscore (_), an exclamation point (!), quotation marks (&quot;), an apostrophe ('), or the following characters: :, { }, [ ].</td>
</tr>
<tr>
<td><strong>Data Source Only</strong></td>
<td>Select this check box to limit your search to only data sources that match the search string.</td>
</tr>
<tr>
<td><strong>Include Scripts</strong></td>
<td>Select this check box to expand your search to include the scripts associated with the current picture or schedule.</td>
</tr>
</tbody>
</table>
### Understanding iFIX

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Button</td>
<td>Use this button to display any value that matches the search string. On the Replace tab, only values you can modify appear. These values can be picture and scheduler properties, or property values of objects in your pictures.</td>
</tr>
<tr>
<td>Replace Selected</td>
<td>Use this button to replace only the property value you select from the Match List box.</td>
</tr>
<tr>
<td>Replace All</td>
<td>Use this button to replace all property values found.</td>
</tr>
<tr>
<td>Replace Preview</td>
<td>Use this button to display the results of replacing all property values in the Match List list box.</td>
</tr>
<tr>
<td>Match List</td>
<td>Displays the properties and property values that match the search string. On the Replace tab, a preview of the replaced text also appears when you click Replace Preview. You can jump to the current picture, schedule, or one of the objects in the list by double-clicking it.</td>
</tr>
<tr>
<td>Stop Button</td>
<td>Use this button to stop the search or replace in progress.</td>
</tr>
</tbody>
</table>

### Get Project Dialog Box

The Get Project dialog box displays the following items:

**Select Project**

Select a project name from the drop-down list. The names in this list represent iFIX project names that you can retrieve from the Change Management Server.

**Project Destination**

The path that the project was last checked in with. Change this path if it is the same as your local iFIX path.

**IMPORTANT:** Do not get a project directly into your local iFIX path. Doing so copies over your existing iFIX files, which may create problems the next time you start iFIX. If you try to get a project to your local iFIX path, an error message appears.

**TIP:** If you later want to start iFIX with the SCU associated with this project, open the SCU, and modify the path configuration (the base and NLS paths should point to the local install, while the project path should point to folder you copied the files to). You also should modify the startup tasks, network configuration, SQL tasks, and local startup definition so that the appropriate paths point to the local iFIX install. Save the SCU and restart iFIX to start iFIX with this new SCU.
Get Options

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete all existing files under Project Destination</td>
<td>Select this check box to delete all existing files in the path you specify, and replace them with the ones in this project. If you select this check box, it is strongly recommended that you select the Initialize Project Destination with iFIX Default Files check box.</td>
</tr>
<tr>
<td>Initialize Project Destination with iFIX default files</td>
<td>Select this check box to restore your iFIX files to the factory default settings before retrieving the iFIX files from this project. If you do not select this check box, you can get the files, but you will not be able to run them in iFIX. Selecting this check box helps your project to run properly if the path is different from the default one listed when you select the project. It is highly recommended that you leave this check box selected.</td>
</tr>
</tbody>
</table>

SCU File

Shows the SCU name of the currently selected project. If you change the project destination, be sure to take note of this name; you will need to locate it in the SCU to update it.

Base Path

Shows the base path of the currently selected project. This is the main iFIX folder. Other iFIX folders are usually subdirectories of the base path.

If you change the project destination, be sure to take note of this path; you will need to change base path in the SCU to the local base path.

Project Path

Shows the project path of the currently selected project. This path includes project specific application files, such as pictures, databases, and tag groups. The default value for the Project Path is the base path.

If you change the project destination, be sure to take note of this path; you will need to change the project path in the SCU to the destination path.

Import Toolbars Dialog Box

The Import Toolbars dialog box displays the following items:

Toolbars Box

 Lets you select the toolbar you want to import.
Understanding iFIX

**Owner**

Lets you select an owner for the toolbar you are importing.

**Import**

Lets you import the selected toolbar.

**Modify Server Dialog Box**

The Modify Server dialog box displays the following items:

**Data Server**

Specifies a name for the OPC driver. This name identifies the driver to iFIX and is used in data sources to access the selected OPC driver. Make sure the name you enter contains no spaces and is not already used by another data server.

**OPC Server**

Specifies the OPC driver you want use.

**Machine Name**

Specifies the local computer name, or the remote computer name that the OPC Server resides on.

**Set As Default Server**

Select this check box to set the current OPC server as the default server. iFIX will use this server when you do not explicitly enter a server name in a data source.

**Multiple Command Script Wizard Dialog Box**

The Multiple Command Script Wizard lets you use one or more command Experts to build a sequence of actions that can be triggered by a mouse click on an object, a Scheduler entry, or a key macro.

The Multiple Command Script Wizard dialog box displays the following items:

**Select Action to Append**

The Select Action to Append drop-down list contains pre-defined Experts that you can add to your command sequence. When you select an action from the list, its associated Expert launches. After you configure the Expert for use in the sequence, it will appear in the Configured Actions list box.

*NOTE:* If the Expert you want to append is already displayed in the drop-down list, you can click the Append action button to launch the Expert.
Configured Actions

Append action button
Click this button to open the Expert currently displayed in the Select Action to Append list.

Delete a selected action button
Click this button to delete a selected action.

Delete all actions button
Click this button to delete all actions in the Configured Actions list box.

Up/Down buttons
Click the Up or Down button to move a selected action up or down in the Configured Actions list box.

Show/Hide action details button
Click the Show or Hide button to display or hide the details of all actions in the Configured Actions list box.

Modify selected action button
Click this button to modify the selected action.

Launch VB Editor
Click this button to launch the Visual Basic Editor.

Configured Actions List Box
The Configured Actions list box displays the command or sequence of commands that have been configured for the selected object. You can click the plus symbol next to a command to expand it and display its configured properties.

Proficy iFIX Project Backup Dialog Box
The Proficy iFIX Project Backup dialog box displays the following items:

Project Backup Wizard Button
Use this button to copy iFIX data and configuration files from the local node to a compressed archive file.
Understanding iFIX

Backup Type

Custom Backup

Allows you to select specific files within the project path to backup.

Full Backup

Select to backup all files, including security files, within the project path.

Project Restore Wizard Button

Use this button to copy iFIX data and configuration files from a compressed archive file to the local node.

Proficy iFIX Project Backup Wizard

The Proficy iFIX Project Backup Wizard displays the following items:

Custom Backup

Page 1

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Type</td>
<td>Specifies the type of backup you selected.</td>
</tr>
<tr>
<td>Node</td>
<td>Specifies the name of the local node from which you are backing up files.</td>
</tr>
<tr>
<td>Project Path</td>
<td>Specifies the path on the local node from which you are backing up files.</td>
</tr>
<tr>
<td>Backup File Option</td>
<td>Select the types of files you want to back up.</td>
</tr>
<tr>
<td>Include Security Files In Archive</td>
<td>Select to backup security settings. This option is only enabled when security files are found on the system.</td>
</tr>
<tr>
<td>Backup Notes</td>
<td>Displays notes about the backup. You cannot edit this field.</td>
</tr>
</tbody>
</table>
## Using the Proficy iFIX WorkSpace

### Page 2

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup File Path and Filename</td>
<td>Allows you to specify the path and name of the archive file to save. You can enter any valid file name and path, including a network path. The Wizard automatically appends the .FBK extension to the name you enter.</td>
</tr>
<tr>
<td>Browse Button</td>
<td>Lets you select the path and file name of the archive file by browsing to it.</td>
</tr>
</tbody>
</table>

### Full Backup

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup File Path and Filename</td>
<td>Allows you to specify the path and name of the archive file to save. You can enter any valid file name and path, including a network path. The Wizard automatically appends the .FBK extension to the name you enter.</td>
</tr>
<tr>
<td>Browse Button</td>
<td>Lets you select the path and file name of the archive file by browsing to it.</td>
</tr>
</tbody>
</table>

### Proficy iFIX Restore Wizard

The Proficy iFIX Restore Wizard displays the following items:

#### Page 1

**Backup Filename To Restore**

Specifies the name of the archive file you want to copy files from and the path to it.

**Browse Button**

Lets you select the path and file name of the archive file by browsing to it.

#### Page 2

**Backup Type**

Displays the type of archive you are restoring (Custom, Full, or Factory Default), and displays the location of the archive file.
### Restore Destination Options

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the Current SCU</td>
<td>Select this option to restore files into the current project path.</td>
</tr>
<tr>
<td>Use SCU File From Archive</td>
<td>Select this option to restore files into the project path specified in the archived SCU.</td>
</tr>
<tr>
<td>Create a New Project</td>
<td>Select this option to restore files to a new project path with a default sub-project path. To modify the default sub-project paths, refer to the BackupRestore.ini or user-specified ini file. Optionally, once you have restored the file, you can create a new SCU file and point to these new paths.</td>
</tr>
<tr>
<td>SCU File</td>
<td>Specifies the path and name of the local node's current SCU file.</td>
</tr>
<tr>
<td>Node</td>
<td>Specifies the name of the local node.</td>
</tr>
<tr>
<td>Project Path</td>
<td>Specifies the project path of the local node. You can change the project path by overwriting the existing SCU file on the local node and entering a new path. The wizard uses the path in this field to restore its files, creating any non-existent relative paths defined in the archive file.</td>
</tr>
<tr>
<td>View Project Path Configuration</td>
<td>Click to display the configured paths for the restored files within the project.</td>
</tr>
</tbody>
</table>

### Restore File Options

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete All Existing Files Under Target Path Before The Restore</td>
<td>Select this check box to delete all existing files under the selected project path before restoring a Custom or Full backup file. This option will not delete existing security files or the current SCU file loaded in local startup.</td>
</tr>
<tr>
<td>Restore Default iFIX Files Before Restoring Your Backup Files</td>
<td>Select this check box to restore default iFIX files before restoring your backup files. For Custom and Full restores, the default iFIX files are restored from the FactoryDefault file. To modify the default settings, modify the FactoryDefault definitions in the BackupRestore.ini file.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Leave Current Security Settings Alone</td>
<td>Select this option to maintain the current security settings and ignore</td>
</tr>
<tr>
<td></td>
<td>security overwrites in the backup files during the restore.</td>
</tr>
<tr>
<td>Replace Existing Security Files With</td>
<td>Select this option to replace the current security settings with the</td>
</tr>
<tr>
<td>Archived Files</td>
<td>security settings in the archived files.</td>
</tr>
<tr>
<td>Delete Existing Security Files And</td>
<td>Select this option to delete all existing security files from the current</td>
</tr>
<tr>
<td>Disable Security</td>
<td>iFIX system and disable security upon restore. This field also displays</td>
</tr>
<tr>
<td></td>
<td>the current status of security (Enabled or Disabled).</td>
</tr>
</tbody>
</table>

**Restore File Selection Box**

Select the types of files you want to restore.

**Task Wizard Dialog Box**

The Task Wizard dialog box displays the following items:

**Task Categories**

Specifies a task category. Each category contains Experts related to the category name. For example, the Database category contains Experts that let you create and modify database blocks.

**Tasks**

Lets you select and run an Expert.

**Perform Task**

Use this button to run the selected Expert.

**Toolbars Dialog Box**

The Toolbars dialog box displays the following items:

**Owner**

Lets you select a toolbar owner. Only active owners appear in the list.

**Toolbars**

Lets you show and hide the selected toolbar.
Understanding iFIX

Customize

Lets you:

- Create, import, and delete toolbars.
- Create, arrange, and delete toolbar buttons.
- Create, rename, and delete toolbar categories.

Show ScreenTips On Toolbars

Lets you enable or disable text descriptions for every button on every toolbar. When enabled, you can display a description by placing the cursor over a button.

User Preferences Dialog Box

General Tab - User Preferences Dialog Box

The General tab of the User Preferences dialog box displays the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start WorkSpace In Run Mode</td>
<td>Select this check box to indicate that the iFIX WorkSpace starts in the run-time environment. Clear this check box to indicate that the iFIX WorkSpace starts in the configuration environment.</td>
</tr>
</tbody>
</table>
## Using the Proficy iFIX WorkSpace

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Save Documents When Switching From Configure To Run</td>
<td>Select this check box to automatically save open documents when the iFIX WorkSpace switches to the run-time environment.</td>
</tr>
<tr>
<td>Full Screen In Run Mode</td>
<td>Select this check box to display pictures in the run-time environment with the maximum screen space possible. When the iFIX WorkSpace displays full-screen in the run-time environment, the menu bar is hidden. The system tree and all toolbars are always hidden in this environment.</td>
</tr>
<tr>
<td>Always Create Backup Copy</td>
<td>Select this check box to automatically copy the previous version of a file to a back-up folder each time you save a new version. If a back-up file already exists, the new back-up file replaces it.</td>
</tr>
<tr>
<td>Fire DataChange Event On Startup</td>
<td>Select this check box to configure the Data Change event of an event object to fire only when there is new data after the initialization. Actions such as switching from the Configuration environment to the Run-time environment while an iFIX schedule is open will cause the DataChange event to trigger accordingly. If you select this option, iFIX fires the event when initializing the event object at the time you open a picture and switch to run mode. Clear this check box if you want events to fire only if the data source truly changes.</td>
</tr>
<tr>
<td>Extend WorkSpace to Support Multiple Monitors</td>
<td>Select this check box if you plan to use multiple monitors with your iFIX displays.</td>
</tr>
<tr>
<td>Enable Ribbon User Interface</td>
<td>Select this check box to use the Ribbon user interface in the iFIX WorkSpace. Clear this check box to use the Classic user interface in the iFIX WorkSpace.</td>
</tr>
</tbody>
</table>

### Electronic Signature Options

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform Comments Table Name</td>
<td>Specifies the name of the table that contains predefined perform comments for the Electronic Signature dialog box.</td>
</tr>
</tbody>
</table>
### Understanding iFIX

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Default Perform Comments Table</strong></td>
<td>Use this button to create a new table containing predefined perform comments for the Electronic Signature dialog box.</td>
</tr>
<tr>
<td><strong>Verify Comments Table Name</strong></td>
<td>Specifies the name of the table that contains predefined verify comments in the Electronic Signature dialog box.</td>
</tr>
<tr>
<td><strong>Create Default Verify Comments Table</strong></td>
<td>Use this button to create a new table containing predefined verify comments for the Electronic Signature dialog box.</td>
</tr>
<tr>
<td><strong>Custom ActiveX Control ProgID</strong></td>
<td>Specifies the ProgID for the custom ActiveX control you want to use to replace the standard electronic signature ActiveX control used to capture user names and passwords for signatures. When the Electronic Signature dialog box opens, it checks this field for a ProgID. If no ProgID is found, the standard Esignature ActiveX control is displayed. If a ProgID is found, the Electronic Signature dialog box attempts to create the custom ActiveX control. However, if creation of the control fails, a message is displayed stating that the custom control could not be created and the standard Esignature ActiveX control is displayed instead.</td>
</tr>
</tbody>
</table>

### Security Options

**User Accounts Disabled Message**

Specifies the message that appears from the Electronic Signature dialog box when a user account is no longer valid.

**Expression Editor Options**

**Remember Last Filter**

Select this check box so that the last filter used in the Expression Builder dialog box is remembered. This is useful if you frequently use the same or similar information when building your expressions.

**Animations Data Error Defaults Tab - User Preferences Dialog Box**

The Animations Data Error Defaults tab of the User Preferences dialog box displays the following items:
### Linear Animation Object Defaults

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because the specified data source could not be found. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Out of Service</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because the specified I/O point is off scan. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Unknown</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives an undefined error. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Uncertain</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives questionable data. This data may be out of range or may be the result of combining good data with uncertain data. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Comm</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives a network error. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Device</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because an OPC device did not respond. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>

### Format Animation Object Defaults

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because the specified data source could not be found. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Out of Service</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because the specified I/O point is off scan. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>
### Understanding IFIX

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives an undefined error. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Uncertain</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives questionable data. This data may be out of range or may be the result of combining good data with uncertain data. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Comm</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives a network error. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Device</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because an OPC device did not respond. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>

### Lookup Animation Object Defaults

#### Numeric Table Entries

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because the specified data source could not be found. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Unknown</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives an undefined error. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Comm</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives a network error. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
<tr>
<td>Out Of Service</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because the specified I/O point is off scan. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>
### Using the Proficy iFIX WorkSpace

#### Device
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because an OPC device did not respond. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>

#### Uncertain
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uncertain</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives questionable data. This data may be out of range or may be the result of combining good data with uncertain data. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>

### String Table Entries

#### Item
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because the specified data source could not be found. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>

#### Unknown
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives an undefined error. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>

#### Comm
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comm</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives a network error. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>

#### Out Of Service
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Out Of Service</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because the specified I/O point is off scan. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>

#### Device
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation fails to receive data because an OPC device did not respond. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>

#### Uncertain
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uncertain</td>
<td>Specifies the default OPC error values that iFIX returns when a linear, format, or lookup animation receives questionable data. This data may be out of range or may be the result of combining good data with uncertain data. You can define your own defaults for each type of animation by entering a new value into each field.</td>
</tr>
</tbody>
</table>
### Color Table Entries

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Use this button to open the Select Color dialog box where you can choose the default color that iFIX displays when a lookup animation fails to receive data because the specified data source could not be found.</td>
</tr>
<tr>
<td>Unknown</td>
<td>Use this button to open the Select Color dialog box where you can choose the default color that iFIX displays when a lookup animation receives an undefined error.</td>
</tr>
<tr>
<td>Comm</td>
<td>Use this button to open the Select Color dialog box where you can choose the default color that iFIX displays when lookup animation receives a network error.</td>
</tr>
<tr>
<td>Out Of Service</td>
<td>Use this button to open the Select Color dialog box where you can choose the default color that iFIX displays when a lookup animation fails to receive data because the specified I/O point is off scan.</td>
</tr>
<tr>
<td>Device</td>
<td>Use this button to open the Select Color dialog box where you can choose the default color that iFIX displays when a lookup animation fails to receive data because an OPC device did not respond.</td>
</tr>
<tr>
<td>Uncertain</td>
<td>Use this button to open the Select Color dialog box where you can choose the default color that iFIX displays when a lookup animation receives questionable data. This data may be out of range or may be the result of combining good data with uncertain data.</td>
</tr>
</tbody>
</table>

### Shape Preferences Tab - User Preferences Dialog Box

The Shape Preferences tab of the User Preferences dialog box displays the following items:

#### Color

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fade Color</td>
<td>Use this button to open the Select Color dialog box where you can choose the default shape fade color.</td>
</tr>
<tr>
<td>Foreground Color</td>
<td>Use this button to open the Select Color dialog box where you can choose the default shape foreground color.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Use this button to open the Select Color dialog box where you can choose the default shape background color.</td>
</tr>
</tbody>
</table>
### Using the Proficy iFIX WorkSpace

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Color</td>
<td>Use this button to open the Select Color dialog box where you can choose the default shape edge color.</td>
</tr>
</tbody>
</table>

### Font

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Name</td>
<td>Specifies the default font for text objects.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Specifies the default size of text objects.</td>
</tr>
<tr>
<td>Font Styles</td>
<td>Specifies the default text object style. The text can be regular, bold, italics, or bold italics.</td>
</tr>
</tbody>
</table>

### General

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edge Style</td>
<td>Specifies the default shape edge style. Edges can be solid, transparent, dotted, or dashed.</td>
</tr>
<tr>
<td>Edge Width</td>
<td>Specifies the default shape edge width. You can enter any width from 0 to 255 logical units.</td>
</tr>
<tr>
<td>Hit Test Size</td>
<td>Specifies the minimum distance the cursor can be from an object before highlighting the object. You can enter any distance from 0 to 255 logical units.</td>
</tr>
<tr>
<td>Blend Percent</td>
<td>Specifies how much of the fade color, in a percentage, will be mixed with the foreground color. The higher the percentage, the more the fade color is visible.</td>
</tr>
<tr>
<td>Fill Style</td>
<td>Specifies the default shape foreground fill style. Fills can be solid, transparent, gradient, or a pattern.</td>
</tr>
<tr>
<td>Background Style</td>
<td>Specifies whether the default shape background is opaque or transparent.</td>
</tr>
<tr>
<td>Fade Type</td>
<td>Specifies the default fade type for shape objects. Fade types can be linear, concentric, radial, or reflected.</td>
</tr>
</tbody>
</table>
Understanding iFIX

Pipe

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness</td>
<td>Specifies the default thickness for pipe objects. You can enter any value from 10 to 300.</td>
</tr>
<tr>
<td>Elbow Style</td>
<td>Specifies the default elbow style for pipe objects. Elbow styles can be round or square.</td>
</tr>
<tr>
<td>Start Cap</td>
<td>Specifies the default start cap for pipe objects. Start caps can be round, square, horizontal-diagonal, or vertical-diagonal.</td>
</tr>
<tr>
<td>End Cap</td>
<td>Specifies the default end cap for pipe objects. End caps can be round, square, horizontal-diagonal, or vertical-diagonal.</td>
</tr>
</tbody>
</table>

Datalink – Remove Leading and Trailing Spaces

Select this check box to indicate whether iFIX should remove extra spaces when Data links are displayed in the run-time environment. This check box is selected by default, which means that all blank spaces before and after data within Data links will be stripped out. Also, note that this option only applies to Data links that display ASCII (A_) or Raw Format data. If you change this option, you must restart the WorkSpace for the change to take effect.

Text – Remove Leading and Trailing Spaces

Select this check box so that leading and trailing spaces are removed from text objects that you add to the WorkSpace. This setting only applies to text entered after you change the setting; it does not change existing text entries.

By default, this check box is selected.

Historical Datalink – Show Time Stamp with Data

Select this check box to specify that the Historical Datalink include the time stamp with the data. The time stamp appears only at run-time.

By default, this check box is selected.

Picture Preferences Tab - User Preferences Dialog Box

The Picture Preferences tab of the User Preferences dialog box displays the following items:
Using the Proficy iFIX WorkSpace

Properties

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Size</td>
<td>Specifies the default window size for pictures. You can create windows full size, half the height or width of the screen, or a quarter of the screen.</td>
</tr>
<tr>
<td>Automatically Determine</td>
<td>Select this check box to enable the Document Width and Document Height fields to allow you to define your own logical system that differs from the default 4:3 horizontal to vertical resolution. You should not change this setting unless you are familiar with the logical units system of measuring picture height and width. Otherwise, objects may not animate as expected.</td>
</tr>
<tr>
<td>Document Size</td>
<td></td>
</tr>
<tr>
<td>Document Width</td>
<td>Specifies the default width, in logical units, for pictures.</td>
</tr>
<tr>
<td>Document Height</td>
<td>Specifies the default picture height in logical units.</td>
</tr>
<tr>
<td>Highlight Timeout Interval</td>
<td>Specifies the length of time an object remains highlighted at run-time. When the specified interval expires, the highlight disappears. You can enter the time in hundredths of a second.</td>
</tr>
<tr>
<td>Grid Interval</td>
<td>Specifies the number of logical units between grid points.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Use this button to open the Select Color dialog box where you can choose the default picture background color.</td>
</tr>
<tr>
<td>Fade Color</td>
<td>Use this button to open the Select Color dialog box where you can choose the default picture fade color.</td>
</tr>
</tbody>
</table>

Basic Animation Dialog

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt On Delete</td>
<td>Select this check box to be prompted to confirm the deletion of an animation in the Basic Animation dialog box and the Command Expert dialog box.</td>
</tr>
<tr>
<td>Always Show Basic Animation Dialog</td>
<td>Select this check box to display the Basic Animation dialog box when you double-click an object or select Animations from an object's right-click menu.</td>
</tr>
<tr>
<td></td>
<td>If this check box is cleared, the Advanced Animations dialog box appears.</td>
</tr>
</tbody>
</table>

115
Create Picture Wizard

Show Picture Wizard From New Picture Menu

Select this check box to display the Create Picture Wizard. If this check box is cleared, the Create Picture Wizard is unavailable.

Picture Translation

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translate Picture On Open</td>
<td>Select this check box if you want to replace the text strings in all of your pictures with a selected language file (if it exists) when you open them in the run-time environment. If this check box is selected, the TranslateOnOpen and LanguageDesired properties on each picture's Properties window cannot be changed. If this check box is cleared, you can configure the TranslateOnOpen and LanguageDesired properties at the individual picture level.</td>
</tr>
<tr>
<td>Language</td>
<td>Specifies the language that all of your pictures' text strings will appear in when the pictures are opened in run mode. This field is available only when the Translate Picture on Open check box is selected.</td>
</tr>
</tbody>
</table>

Window Properties

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Bar</td>
<td>Select this check box to indicate whether your pictures appear with or without title bars.</td>
</tr>
<tr>
<td>System Menu</td>
<td>Select this check box to indicate whether you are creating pictures with or without a System menu, or Maximize, Minimize, and Close buttons.</td>
</tr>
<tr>
<td>Resizable</td>
<td>Select this check box to indicate whether you can or cannot resize pictures.</td>
</tr>
<tr>
<td>Always On Top</td>
<td>Select this check box to indicate that your pictures will automatically float on top of all other open documents. Typically, this feature is used to create detail pictures that you always want to display on top of other pictures.</td>
</tr>
<tr>
<td>Grid Enabled</td>
<td>Select this check box to indicate whether or not the grid in pictures is automatically displayed.</td>
</tr>
<tr>
<td>Snap To Grid</td>
<td>Select this check box to indicate whether or not your pictures will automatically align objects to the grid.</td>
</tr>
</tbody>
</table>
Using the Proficy iFIX WorkSpace

Click And Stick Enabled
Select this check box to indicate whether or not your pictures show or hide visual cues as to which objects can be selected and which object is currently selected.

Gradient

Enable Gradient
Select this check box to enable the Gradient fill style. The default fade type for the picture is linear. You can change the picture's fade type in the Edit Picture dialog box.

Thumbnail

Save Thumbnail
Select this check box to save a thumbnail of each picture you create.

Cache

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Picture Cache</td>
<td>Select this check box to enable picture caching, which reads and opens previously opened pictures from memory. Clear this check box to indicate that picture files will be opened from the disk drive.</td>
</tr>
<tr>
<td>Cache Size</td>
<td>Specifies the number of pictures (from 1-99) you want in the cache.</td>
</tr>
</tbody>
</table>

Auto Scale

Disable Auto Scale Feature
Select this check box to override the logical units to pixel ratio when changing the resolution of your screen. This may be helpful for multiple monitor configurations.

Chart Preferences Tab - User Preferences Dialog Box

*NOTE: The following options apply only to Standard Charts.*

The Chart Preferences tab of the User Preferences dialog box displays the following items:
### Scroll Direction

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll Right To Left</td>
<td>Select this option to set the default scroll direction for all charts to a right-to-left scroll.</td>
</tr>
<tr>
<td>Scroll Left To Right</td>
<td>Select this option to set the default scroll direction for all charts to a left-to-right scroll.</td>
</tr>
<tr>
<td>Reset</td>
<td>Specifies the percentage of the chart that moves when the plotted data reaches the left edge of the chart. For example, when you enter 25 into this field, the chart shifts right 25% along its time (X) axis and continues plotting data.</td>
</tr>
</tbody>
</table>

### Time Axis

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Of Ticks</td>
<td>Specifies the default number of ticks to display on your chart's time (X) axis. You can enter any value from 0 to 20 into this field.</td>
</tr>
<tr>
<td>Number Of Labels</td>
<td>Specifies the default number of labels to display on your chart's time (X) axis. You can enter any value from 0 to 20 into this field.</td>
</tr>
</tbody>
</table>

### Value Axis

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Of Ticks</td>
<td>Specifies the default number of ticks to display on your chart's value (Y) axis. You can enter any value from 0 to 20 into this field.</td>
</tr>
<tr>
<td>Number Of Labels</td>
<td>Specifies the default number of labels to display on your chart's value (Y) axis. You can enter any value from 0 to 20 into this field.</td>
</tr>
</tbody>
</table>

### Time Axis Span

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration Days</td>
<td>Specifies the amount of data your charts display along their time (X) axes. You can enter any value from 0 to 999 days in the Days field. In the Time field, enter the time in hours, minutes, and seconds. You can enter any time up to 23 hours, 59 minutes, and 59 seconds.</td>
</tr>
</tbody>
</table>
Using the Proficy iFIX WorkSpace

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration Time</td>
<td>Specifies the amount of data your charts display along their time (X) axes. You can enter any value from 0 to 999 days in the Days field. In the Time field, enter the time in hours, minutes, and seconds. You can enter any time up to 23 hours, 59 minutes, and 59 seconds.</td>
</tr>
<tr>
<td>Interval Time</td>
<td>Specifies the default interval between the data points on your charts. In the Time field, enter the time between data points in hours, minutes, and seconds. You can enter any time up to 23 hours, 59 minutes, and 59 seconds. The interval cannot be greater than half the duration. If you enter zero, iFIX automatically calculates the interval as the duration divided by the number of display points.</td>
</tr>
</tbody>
</table>

**General**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Time Axis Reset</td>
<td>Select this check box to control changes to the limits on the X (time) axis in a chart. Initially, the limits are set to match the time specified on the Time tab of the Chart Configuration dialog box. However, when you select this check box, you enable the time axis limits of your chart to be reset after you right-click the object to zoom out. The chart resets the time axis limits to the values of the Start Time and End properties.</td>
</tr>
<tr>
<td>Allow Value Axis Reset</td>
<td>Select this check box to control changes to the limit on the Y (value) axis in a chart. Initially, the limits are set to match the High and Low limits specified on the Pen tab of the Chart Configuration dialog box. However, when you select this check box, you enable the value axis limits of your chart to be reset after you right-click the object to zoom out. The chart resets the value axis limits to the values of the HiLimit and LoLimit properties.</td>
</tr>
<tr>
<td>Transparent</td>
<td>Select this check box to create a chart with a transparent background.</td>
</tr>
</tbody>
</table>

**Drawing Options Tab - User Preferences Dialog Box**

The Drawing Options tab of the User Preferences dialog box displays the following items:
Understanding iFIX

**Geometry Helper Options**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Extend Lines</td>
<td>Specifies that the selected lines will always extend to the intersection point when the Extend Lines button on the CAD Toolbar is used.</td>
</tr>
<tr>
<td>Extend Only When The Extension Is Shorter Than Half The Line</td>
<td>Specifies that the selected line will be extended to the intersection point only when the extension is shorter than half the line being extended.</td>
</tr>
<tr>
<td>Extend Only When The Extension Is Shorter Than X Pixels</td>
<td>Specifies that the selected line will be extended to the intersection point only when the extension is shorter than the defined value.</td>
</tr>
<tr>
<td>Always Trim Lines</td>
<td>Specifies that the selected lines will always be trimmed at the intersection point when the Trim Lines button on the CAD Toolbar is used.</td>
</tr>
<tr>
<td>Trim Only When The Trimmed Area Is Shorter Than X Pixels</td>
<td>Specifies that the selected line will be trimmed at the intersection point only when the trimmed area is shorter than the defined value.</td>
</tr>
</tbody>
</table>

**Graphics Connections**

**Always Show Connection Nodes**

Select this check box to indicate that the connection nodes are always displayed on the shapes in a picture. If this check box is cleared, the connection points are not visible, but can be displayed using one of the following methods:

- Select a connector and move it towards the shape to anchor it to a certain connection point on the shape.
- Or -
  - Select the shape and click either the Add Connection Point button or Delete Connection Point button on the CAD Toolbar.

**Environment Protection Tab - User Preferences Dialog Box**

The Environment Protection tab of the User Preferences dialog box displays the following items:

**Enable Run Time Environment Protection**

Select this check box to enable environment protection for the local node. When enabled, you can select the specific options that you want to restrict access to. These options take effect when you
switch to the run-time environment.

**WorkSpace Title and Menu Options**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Title Bar And Menu Bar</td>
<td>Select this check box to hide the WorkSpace menu bar and title bar at run-time.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> In Ribbon view, if this option is selected, the Title Bar takes on the appearance of Classic view, rather than Ribbon view.</td>
</tr>
<tr>
<td>Disable Menu Bar</td>
<td>Select this check box to hide the WorkSpace menu bar and title bar at run-time.</td>
</tr>
<tr>
<td>Disable &quot;WorkSpace&quot; Menu Pulldown</td>
<td>Select this check box to disable the WorkSpace menu at run-time.</td>
</tr>
</tbody>
</table>

**WorkSpace File Menu Accelerators**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable &quot;WorkSpace&quot; File Menu Accelerators</td>
<td>Select this check box to disable both the Open (Ctrl+O) and Print (Ctrl+P) WorkSpace file menu accelerators while in the Run-time environment.</td>
</tr>
<tr>
<td>Disable Open Accelerator</td>
<td>Select this check box to disable the Open (Ctrl+O) WorkSpace file menu accelerator while in the Run-time environment.</td>
</tr>
<tr>
<td>Disable Print Accelerator</td>
<td>Select this check box to disable the Print (Ctrl+P) WorkSpace file menu accelerator while in the Run-time environment.</td>
</tr>
</tbody>
</table>

**Other Options**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable &lt;Ctrl&gt; &lt;Alt&gt; &lt;Del&gt;</td>
<td>Select this check box to disable the &lt;Ctrl&gt;&lt;Alt&gt;&lt;Delete&gt; key sequence at run-time, thereby restricting operators from accessing the Task Manager, changing their password, logging off, or shutting down the computer.</td>
</tr>
</tbody>
</table>
### Understanding iFIX

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Task Switching</td>
<td>Select this check box to disable run-time task switching through &lt;Alt&gt;&lt;Tab&gt; and the Start button. <strong>NOTE:</strong> The Shift + F10 key macro does not work if you select this option.</td>
</tr>
<tr>
<td>Disable VBE Access</td>
<td>Select this check box to allow you to restrict access to the Visual Basic Editor at run-time. If access is not restricted, the editor appears when a compilation or run-time error occurs, allowing you to correct the error. When you restrict access, the iFIX WorkSpace suppresses the Visual Basic Editor even if an error occurs.</td>
</tr>
</tbody>
</table>

#### Background StartUp Tab - User Preferences Dialog Box

The Background StartUp tab of the User Preferences dialog box displays the following items:

**Background Task StartUp Schedules List Box**

Displays the schedules configured to automatically load in the background task when the background task is started. By double-clicking in the list, you can enter or edit any scheduled entry. You can also select the schedule you want to add by browsing to it with the Browse button.

**New Button**

Use this button to add a schedule (Background Startup tab) or a picture (Startup Pictures tab) to the start-up list by entering its name and path. You can also select the file by browsing to it with the Browse button.

**Delete Button**

Use this button to delete the selected file from the start-up list.

**Move Up Button**

Use this button to move the selected file up in the start-up list.

**Move Down Button**

Use this button to move the selected file down in the start-up list.

#### StartUp Pictures Tab - User Preferences Dialog Box

The StartUp Pictures tab of the User Preferences dialog box displays the following items:
StartUp Pictures List Box

Displays the pictures you want to open automatically when the iFIX WorkSpace starts in the run-time environment. By double-clicking in the list, you can enter or edit any entry. You can also select the picture you want to add by browsing to it with the Browse button.

New Button

Use this button to add a schedule (Background Startup tab) or a picture (Startup Pictures tab) to the start-up list by entering its name and path. You can also select the file by browsing to it with the Browse button.

Delete Button

Use this button to delete the selected file from the start-up list.

Move Up Button

Use this button to move the selected file up in the start-up list.

Move Down Button

Use this button to move the selected file down in the start-up list.

Change Management Tab - User Preferences Dialog Box

The Change Management tab of the User Preferences dialog box displays the following items:

Enable Change Management Server Connection

Select this check box to if you want to enable iFIX to connect to the Proficy Change Management Server. With this option selected, right mouse menu items for Change Management become available in the iFIX WorkSpace.

NOTE: You cannot edit the fields in this dialog box if security is disabled, or after you connect to the Change Management Server.

Logon Info

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management Server</td>
<td>Enter the name of your Proficy Change Management Server. For instance, if your server is named MYSERVER, enter MYSERVER in this field.</td>
</tr>
</tbody>
</table>
### Understanding iFIX

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Test Connection**         | Click to test a connection to the Proficy Change Management Server. After you supply login credentials for the Change Management Server, a message box appears indicating whether a connection can be made.  

*NOTE: If you do not have iFIX security Change Management application privileges, you will receive an error message when you click Test Connection. For more information refer to the Overview of iFIX Configuration Steps in the Change Management and iFIX ebook.* |
| **Logon at WorkSpace Startup** | Select this check box to log in to the Change Management Server when you start the iFIX WorkSpace. Clear this check box if you only want to login to the Change Management Server from the right-click menu. (In the system tree, right-click the node name, select Manage, and then click Logon.)  

*TIP: If you have a very large iFIX project, it is recommended that you clear this check box. Otherwise, for large projects, it may take several extra minutes for the iFIX WorkSpace to start up.* |
| **Prompt For User Name And Password At Logon** | Select this check box if you always want a dialog box requesting login credentials to appear when you logon to the Change Management Server. Clear this check box if you want to allow for automatic logon.  

*NOTE: For an automatic logon to work, the user name and password must be identical on both the Change Management Server and in iFIX. If the user name and password does not match in both applications, or the iFIX user you are logged in as is not defined as a user on the Change Management Server (or vice versa), after an error message, the Logon dialog box appears, even with this check box cleared.* |

### Change Management Project Name

Enter the name of the Change Management project folder you want to open after you logon. Files you check out or check in will reside in this project folder.

### Require comments to check in and check out files

Select this check box if you want to require that the user enter a comment when checking out or checking in a file. If you require comments, the OK button (found in the Check Out and the Check In dialog boxes) does not become available until you enter a comment.
### Electronic Signature Options

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform Comments Table Name</td>
<td>Specifies the name of the table that contains predefined perform comments for the Electronic Signature dialog box used with Change Management actions in the iFIX WorkSpace. This table name can be the same as the one you use for iFIX Performed By electronic signatures, as defined on the General tab. Or, you can enter another table with perform comments applicable only to the Change Management Server.</td>
</tr>
<tr>
<td>Create Default Perform Comments Table</td>
<td>Use this button to create a new table containing predefined perform comments for the Electronic Signature dialog box that appears with Change Management actions in the iFIX WorkSpace.</td>
</tr>
<tr>
<td>Verify Comments Table Name</td>
<td>Specifies the name of the table that contains predefined verify comments for the Electronic Signature dialog box used with Change Management actions in the iFIX WorkSpace. This table name can be the same as the one you use for iFIX Verified By electronic signatures, as defined on the General tab. Or, you can enter another table with verify comments applicable only to the Change Management Server.</td>
</tr>
<tr>
<td>Create Default Verify Comments Table</td>
<td>Use this button to create a new table containing predefined verify comments for the Electronic Signature dialog box that appears with Change Management verify actions in the iFIX WorkSpace.</td>
</tr>
<tr>
<td>None</td>
<td>Select this option if no iFIX electronic signature is required to perform a Change Management function from the WorkSpace.</td>
</tr>
<tr>
<td>Perform Only</td>
<td>Select this option if an iFIX Performed By electronic signature is required to perform a Change Management function from the WorkSpace (in addition to the Change Management Server login).</td>
</tr>
<tr>
<td>Perform And Verify</td>
<td>Select this option if a Performed By and Verified By electronic signature is required by iFIX in order to perform a Change Management function from the iFIX WorkSpace (in addition to the Change Management Server login).</td>
</tr>
<tr>
<td>Allow Continuous Use</td>
<td>Select this check box to allow the operator to repeatedly sign for successive actions by supplying only a password, when electronic signatures are enabled. Continuous use applies only to the person performing an action and does not affect the person verifying an action.</td>
</tr>
</tbody>
</table>
Proficy Historian Tab - User Preferences Dialog Box

The Proficy Historian tab of the User Preferences dialog box displays the following items:

Configuration of Tags for Collection in Proficy Historian

Use this option to configure all tags in your currently loaded database for collection by Historian. Collection begins when the Collector starts.

How Do I...

The following sections explain how to use the Proficy iFIX WorkSpace:

- Using the System Tree
- Working with Files
- Starting Applications and Experts
- Working with the WorkSpace Environments
- Setting Preferences
- Selecting Data Sources and Building Expressions
- Managing Files and Nodes
- Working with Toolbars
- Installing a Third-Party OPC Server

Click a section above for steps on how to use or configure this part of the Proficy iFIX WorkSpace.

Using the System Tree

The following sections provide steps on how to use the system tree in the iFIX WorkSpace:

- Displaying a System Tree Path
- Showing and Hiding the System Tree
- Opening or Closing a Folder
- Copying and Moving Objects
- Viewing Thumbnails

Displaying a System Tree Path

To display a system tree path:

1. In the iFIX WorkSpace system tree, right-click any folder or document. A pop-up menu appears.
2. From the pop-up menu, select Properties or File Properties.
Showing and Hiding the System Tree

To show and hide the system tree:

From the WorkSpace menu in the iFIX WorkSpace, select System Tree. If the system tree was hidden, the iFIX WorkSpace displays it. If the system tree was visible, the program hides it.

Opening or Closing a Folder in the System Tree

To open or close a folder in the system tree:

1. In the iFIX WorkSpace system tree, click the plus sign to open (expand) a folder.
2. Click the minus sign to close (collapse) a folder.

Copying and Moving Objects

To copy or move an object:

1. In the iFIX WorkSpace, open the source and target picture or Dynamo set.
2. Click, drag, and drop the object into the target to move it. Using the system tree, click, drag, and drop the object's name over the target's name to move it.
3. Hold the Control key down and drag and drop the object to copy it.

You can also copy and paste, or cut and paste objects when the source and destination do not appear on the screen simultaneously.

Viewing Thumbnails

To view picture and Dynamo set thumbnails:

1. In the iFIX WorkSpace system tree, click the plus sign to open (expand) both the Dynamo Sets and the Pictures folders.
2. Place the mouse pointer over a Dynamo set or picture file name. The thumbnail, if it exists, appears.

NOTES:

- You will not be able to view thumbnails if you are using Windows Vista and the Vista Basic Theme for your display.
- Windowless OLE objects will not display in thumbnails.
- Not all thumbnails appear in a uniform location; some may be centered while others appear in the upper left hand corner.

Working with Files

The following sections provide steps on how to work with files in the iFIX WorkSpace:
Understanding iFIX

- Creating Files
- Opening Files
- Saving Files

Creating Files

The following sections provide steps on how to create files in the iFIX WorkSpace:

- Creating a New Picture, Schedule, or Dynamo Set
- Creating a New File

Creating a New Picture, Schedule, or Dynamo Set

▶ To create a new picture:

In Classic view, in the iFIX WorkSpace, click the New Picture button on the Standard toolbar to create a picture.

- Or-

In Ribbon view, click the WorkSpace button, select New and then click Picture.

The Create Picture Wizard appears. Use this wizard to set sizes, locations, and properties of your new pictures.

**NOTE:** If a single untitled picture appears when you click the New Picture button, the Create Picture Wizard has been disabled. Enable it by selecting the following check box on the Picture Preferences tab of the User Preferences dialog box: Show Picture Wizard from New Picture Menu.

▶ To create a new schedule:

In Classic view, in the iFIX WorkSpace, click the New Schedule button on the Standard toolbar to create a schedule.

- Or-

In Ribbon view, click the WorkSpace button, select New, and click Schedule.

▶ To create a new Dynamo Set:

In Classic view, in the iFIX WorkSpace, click the New Dynamo Set button on the Standard toolbar to create a Dynamo Set.

- Or-

In Ribbon view, click the WorkSpace button, select New, and click Dynamo Set.

Creating a New File

▶ To create a new file:

1. In Classic view, in the iFIX WorkSpace, from the File menu, select New, and then Others.
Opening Files

The following sections provide steps on how to create files in the iFIX WorkSpace:

- Opening a File
- Opening a Back-up File
- Opening Pictures Automatically at Run Time

Opening a File

▷ To open a file:

1. In Classic view, in the iFIX WorkSpace, from the Standard toolbar, click the Open button.
   - Or-
   In Ribbon view, click the WorkSpace button and then Open.

2. Select the file you want to open.
   
   **TIP:** You can also open a file from the system tree by expanding a folder and double-clicking the file you want to open.

Opening a Backup File

▷ To open a backup file:

1. In Classic view, in the iFIX WorkSpace, from the Standard toolbar, click the Open button.
   - Or-
   In Ribbon view, click the WorkSpace button and then Open.

2. Select the path containing your backup file.
3. Double-click the backup file you want to open.
4. From the File menu, select Save As.
5. Rename the backup file and save it in the iFIX Picture path.

Opening Pictures Automatically at Run Time

▷ To open pictures automatically at run time:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.
   - Or-
In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the Startup Pictures tab.
3. Click the Add button and enter a file name (GRF files) for the picture you want to load when the iFIX WorkSpace enters the run-time environment. Optionally, click the Browse button to locate the file.
4. Repeat step 3 until you have added all the files you want to load at run time.
5. Select a file and click the Delete button to remove any pictures you no longer want to load at run time.
6. Double-click any existing entry to modify it, as needed.

Saving and Deleting Files

The following sections provide steps on how to save and delete files in the iFIX WorkSpace:

- Saving a File
- Saving Files Automatically
- Renaming a File
- Deleting a File

Saving a File

» To save a file:

1. In Classic view, in the iFIX WorkSpace, on the Standard toolbar, click the Save button.
   - Or-
   In Ribbon view, click on the Application button, and then Save.
2. If you are saving a new file, the iFIX WorkSpace prompts you for a file name. To save the new file, enter a name and a file type for the file.

Saving Files Automatically

» To automatically save open documents when switching to the run-time environment:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.
2. Click the General tab.
3. Select the Auto Save Documents when Switching from Configure to Run check box.
Renaming Files

To rename a file:

1. In the iFIX WorkSpace system tree, right-click a closed file.
2. From the pop-up menu, select Rename.
3. Enter the new name when prompted.

Deleting Files

To delete a file:

1. In the iFIX WorkSpace system tree, right-click a closed file.
2. From the pop-up menu, select Delete.

Starting Applications and Experts

The following sections provide steps on how to start applications and Experts in the iFIX WorkSpace:

- Starting an iFIX Application
- Starting the Visual Basic Editor
- Running Experts with the Task Wizard
- Configuring a Button

Starting iFIX Applications

To start an iFIX application:

- In Classic view, in the iFIX WorkSpace, on the Application toolbar, click the button for the application you want to start.
  - Or-
- In Ribbon view, on the Applications tab, select the application you want to start.
  - Or-
- Double-click the application from the iFIX WorkSpace system tree.

Starting the Visual Basic Editor

To start the Visual Basic Editor from the iFIX WorkSpace:

- In Classic view, in the iFIX WorkSpace, on the Standard toolbar, click Visual Basic Editor.
  - Or-
- In Ribbon view, on the Home tab, in the WorkSpace group, click Visual Basic Editor.
Running Experts With the Task Wizard

To run Experts with the Task Wizard:

1. In Classic view, in the iFIX WorkSpace, select an object from the current picture and click the Task Wizard button on the Standard toolbar.
   -Or-
   In Ribbon view, on the Tools tab in the Tasks/Experts group, click the Tasks/Experts dialog box launcher.

2. Select a category from the Task Category list.

3. In the Tasks list box, double-click the specific task or Expert you want to complete.

   **NOTE:** If you want to specify multiple commands for the object, select Multiple Commands Expert from the Command category to open the Multiple Command Script Wizard.

Configuring a Button

**To configure a button:**

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab in the WorkSpace group, click Setting, and then click Toolbars.

2. Click Customize.

3. Click the Buttons tab.

4. Select the category for the button you want to modify.

5. Click Modify Button.

   **NOTE:** You can only modify buttons in user-created categories.

6. From the Bitmaps area, select the bitmap for the button. If you want to use your own bitmap, browse for it and select it. Make sure the image size is no more than 20 x 20 and uses no more than 16 colors.

7. In the Name field, enter the button's name.

8. In the Description field, enter text describing the button.

9. In the ScreenTip field, enter the button's ToolTip.

10. Click Edit Script to launch the Visual Basic Editor.

11. Write a script for the button.

Working with the WorkSpace Environments

The following sections provide steps on how to work with environments in the iFIX WorkSpace:

- Switching Between Environments
Using the Proficy iFIX WorkSpace

- Setting the WorkSpace's Start-up Environment
- Configuring Environment Protection

Switching Between Environments

» To switch between the configuration environment and the run-time environments:

1. In Classic view, in the iFIX WorkSpace configuration environment, click Switch to Run on the Standard toolbar.
   - Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Switch to Run.

2. In the run-time environment, select Switch to Configure from the WorkSpace menu.

   TIP: You can also use the shortcut, Ctrl+W to switch between environments.

Accessing Menu Commands While in Full Screen Run Mode

» To access menu commands while in full screen run mode:

- Press the Alt key.

Setting up the WorkSpace's Start-up Environment

The following sections provide steps on how to use the start-up environment for the Proficy iFIX WorkSpace:

- Starting the iFIX WorkSpace in the Run-time Environment
- Starting the iFIX WorkSpace in the Configuration Environment

Starting the iFIX WorkSpace in the Run-time Environment

» To configure the iFIX WorkSpace to start in the run-time environment:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the General tab.

3. Select the Start WorkSpace in Run Mode check box.
Starting the iFIX WorkSpace in the Configuration Environment

To configure the iFIX WorkSpace to start in the configuration environment:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or -
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the General tab.

3. Clear the Start WorkSpace in Run Mode check box.

Setting the Display Options for the Ribbon in Run Mode

The following sections explain how to set the display options for the Ribbon in run mode:

- Viewing the Ribbon in Run Mode
- Minimizing the Ribbon in Run Mode
- Disabling the Ribbon Auto Hide Feature in Full Screen Run Mode
- Enabling the Ribbon Auto Hide Feature in Full Screen Run Mode

Viewing the Ribbon in Run Mode

To view the Ribbon in run mode:

- On the Quick Access toolbar, while in run mode, from the Customize Quick Access Tool list, deselect Minimize the Ribbon.

Minimizing the Ribbon in Run Mode

To minimize the Ribbon in run mode:

- On the Quick Access toolbar, while in run mode, from the Customize Quick Access Tool list, select Minimize the Ribbon.

Disabling the Ribbon Auto Hide Feature in Full Screen Run Mode

To disable the Ribbon auto hide feature in full screen run mode:

1. Press the Alt key to view the Quick Access toolbar.

2. On the Quick Access toolbar, from the Customize Quick Access Tool list, clear Auto Hide the Ribbon.
Enabling the Ribbon Auto Hide Feature in Full Screen Run Mode

To enable the Ribbon auto hide feature in full screen run mode:

1. Press the Alt key to view the Quick Access toolbar.
2. On the Quick Access toolbar, from the Customize Quick Access Tool list, select Auto Hide the Ribbon.

Configuring Environment Protection

The following sections provide steps on how to configure environment protection in the iFIX WorkSpace:

- Enabling Environment Protection
- Disabling Environment Protection

Enabling Environment Protection

To enable environment protection:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.
2. Click the Environment Protection tab.
3. Select the Enable Environment Protection check box.
4. Select the options you want to enable.

Disabling Environment Protection

To disable environment protection:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.
   -Or-
   In Ribbon view on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.
2. Click the Environment Protection tab.

Customizing the Ribbon User Interface

The following sections provides steps on how to customize the Ribbon user interface.
Understanding iFIX

- Showing Keytips
- Disabling Keytips
- Changing the WorkSpace Color Scheme
- Changing the Screentip Style
- Adding Commands to the Quick Access Toolbar
- Moving the Quick Access Toolbar
- Removing Commands from the Quick Access Toolbar
- Resetting the Quick Access Toolbar
- Customizing Keyboard Shortcuts

Showing KeyTips

➤ To show KeyTips:

NOTE: The following procedure applies only to Ribbon view.

1. Click the Application button and then on the Application menu, click Options.
2. If not already selected, in the Navigation pane, click Popular.
3. Select Show KeyTips.
4. Click OK.

Disabling KeyTips

➤ To disable KeyTips:

NOTE: The following procedure applies only to Ribbon view.

1. Click the Application button and then on the Application menu, click Options.
2. If not already selected, in the Navigation pane, click Popular.
3. Deselect Show KeyTips.
4. Click OK.

Changing the WorkSpace Color Scheme

➤ To change the WorkSpace Color Scheme:

NOTE: The following procedure applies only to Ribbon view.

1. Click the Application button and then on the Application menu, click Options.
2. If not already selected, in the Navigation pane, click Popular.
3. From the Color Scheme list, select the desired color scheme.
4. Click OK.
Changing the ScreenTip Style

To change the ScreenTip style:

\[NOTE: \text{The following procedure applies only to Ribbon view.}\]

1. Click the WorkSpace button in the upper left corner of the application, and then on the application menu, click the Options button.
2. If not already selected, in the Navigation pane, click Popular.
3. From the ScreenTip style list, select the desired ScreenTip style.
4. Click OK.

Adding Commands to the Quick Access Toolbar

There are three methods you can use to add commands to the Quick Access toolbar.

\[NOTE: \text{The following procedures apply only to Ribbon view.}\]

To add commands to the Quick Access toolbar (method 1):

1. In the iFIX WorkSpace, in the Ribbon, right-click the command you want to add to the Quick Access toolbar.
2. Click Add to Quick Access Toolbar.

To add commands to the Quick Access toolbar (method 2):

1. In the iFIX WorkSpace, on the Ribbon, click the Application tab.
2. Right-click an empty portion of the Ribbon, and select Customize Quick Access Toolbar. The Customize dialog box appears.
3. In the Choose Commands From list, select the category that contains the command you want to add to the Quick Access toolbar.
4. In the Commands list, for each the command you want to add to the Quick Access toolbar, select it and then click Add.
5. Repeat Step 4 until all desired commands are added.
6. To change the order of which the commands appear on the Quick Access toolbar:
   a. Click the command to move.
   b. Use the up or down arrow to move the command in the desired direction.
   c. Repeat steps a and b until commands are in the desired order.
7. Click OK.

To add commands to the Quick Access toolbar (method 3):

1. Right-click the Quick Access toolbar, and select Customize Quick Access Toolbar. The Customize dialog box appears.
2. In the Choose Commands From list, select the category that contains the command you want to add to the Quick Access toolbar.
3. In the Commands list, for each the command you want to add to the Quick Access toolbar, select it and then click Add.
4. Repeat Step 3 until all desired commands are added.
5. To change the order of which the commands appear on the Quick Access toolbar:
   a. Click the command to move.
   b. Use the up or down arrow to move the command in the desired direction.
   c. Repeat steps a and b until commands are in the desired order.
6. Click OK.

Moving the Quick Access Toolbar

There are three methods you can use to move the Quick Access toolbar either above or below the Ribbon.

NOTE: The following procedures apply only to Ribbon view.

To move the Quick Access toolbar (method 1):
1. In the iFIX WorkSpace, click the Quick Access toolbar.
2. Click the available command: either Show Quick Access Toolbar Below the Ribbon or Show Quick Access Toolbar Above the Ribbon.

To move the Quick Access toolbar (method 2):
1. Click the Application button and then on the Application menu, click Options.
2. In the Navigation Plane, click Customize.
3. To show the Quick Access toolbar below the Ribbon, select Show Quick Access Toolbar Below the Ribbon.
4. To show the Quick Access toolbar above the Ribbon, deselect Show Quick Access Toolbar Below the Ribbon.
5. Click OK.

To move the Quick Access toolbar (method 3):
1. Click Expand on the Quick Access toolbar.
2. Click the available command, either Show Below the Ribbon or Show Above the Ribbon.

Removing Commands from the Quick Access Toolbar

There are three methods you can use to remove commands from the Quick Access toolbar.

NOTE: The following procedures apply only to Ribbon view.

To remove commands from the Quick Access toolbar (method 1):
1. In the iFIX WorkSpace, on the Quick Access toolbar, right-click the command you want to remove.
2. Click Remove from Quick Access Toolbar.

**To remove commands from the Quick Access toolbar (method 2):**

1. Click the Application button and then on the Applications menu, click Options.
2. In the Navigation pane, click Customize.
3. In the list of commands in the box on the right, click the name of the command to remove and click Remove.
4. Click OK.

**To remove commands from the Quick Access toolbar (method 3):**

1. Click Expand on the Quick Access toolbar.
2. Click More Commands.
3. In the list of commands in the box on the right, click the name of the command to remove and click Remove.
4. Click OK.

### Resetting the Quick Access Toolbar

**To reset the default commands on the Quick Access toolbar:**

*NOTE: The following procedure applies only to Ribbon view.*

1. Click the Application button and then click Options.
2. In the Navigation pane, click Customize.
3. Click Reset.
4. Click OK.
5. Click OK.

### Customizing Keyboard Shortcuts

**To customize keyboard shortcuts:**

*NOTE: The following procedure applies only to Ribbon view.*

1. Click the Application button and then on the Application menu, click Options.
2. In the Navigation pane, click Customize.
3. Click Customize.
4. In the Categories list, click the category that contains the command for which you want to create a shortcut.
5. In the Commands list, click the name of the command for which you want to create a shortcut. Any shortcut keys that are currently assigned appear in the Current Keys box.
Understanding iFIX

6. Click in the Press New Shortcut Key box and press the desired keyboard shortcut. The combination appears in the Press New Shortcut Key box.

7. In the Set Accelerator for list, choose the desired option.

8. Click Assign.

9. Click OK.

Setting Preferences

The following sections provide steps on how to set preferences in the iFIX WorkSpace:

- Setting Monitor Preferences
- Setting Picture, Shape, Drawing, and Chart Preferences
- Setting Run-time Preferences
- Setting the WorkSpace's Start-up Environment
- Configuring Environment Protection

Setting Monitor Preferences

To enable the use of multiple monitors:

**IMPORTANT:** You configure the overall monitor settings for your computer, before you can configure iFIX to display multiple monitors.

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the General tab.

3. Select the Extend WorkSpace to support multiple monitors check box.

4. Click OK.

Setting the iFIX WorkSpace User Interface

**To set the iFIX WorkSpace User Interface:**

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the General tab.

3. To enable Ribbon view, select the Enable Ribbon User Interface check box.
4. To enable Classic view, clear the Enable Ribbon User Interface check box.
5. Click Ok.
6. Restart the WorkSpace for changes to take effect.

**Enabling Database Tag Collection by Historian**

To enable database tag collection by Historian:

**NOTES:**

- *Enabling this feature causes all of your database tags to be collected by Historian.*
- *During database reload, if an iFIX tag already exists in Historian, the information is read from Historian, not iFIX; the update in the iFIX database contains the Historian fields.*
- *You can enable collection, one tag at a time, on the Historian tab of the database block itself. For more information, see Enabling or Disabling Block Collection by Historian.*
- *This feature does not work if you have a run-time only license for iFIX.*

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or-
     In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.
2. Click the Proficy Historian tab.
3. Select Automatically Configure Tags for Collection in Historian.
4. Click OK.
5. Restart the WorkSpace and reload the database for changes to take effect.

**Setting Picture, Shape, Drawing, and Chart Preferences**

The following sections provide steps on setting picture, shape, drawing, and chart preferences in the iFIX WorkSpace:

- Setting Picture Preferences
- Globally Translating Picture Text
- Enabling Picture Caching
- Setting Shape Preferences
- Setting Drawing Options
- Setting Save Preferences
- Setting Chart Preferences
Setting Picture Preferences

To set picture preferences:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or -
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the Picture Preferences tab.

3. From the Window Size list, select the default window size.

4. In the Window Properties area, select the window properties you want to enable.

5. If you are familiar with the logical units system of measuring picture height and width, clear the Automatically determine document size check box. Then, in the Document Height and Document Width fields, enter, in logical units, the default height and width for your pictures.

6. In the Highlight Timeout Interval field, enter the length of time, in seconds, that an object in your picture should stay selected.

7. In the Grid Interval field, enter the space, in logical units, between grid points for your pictures.

8. Click the Background Color button and choose the default picture background color.

9. Click the Fade Color button and choose the default picture fade color.

10. In the Gradient area, select the Enable Gradient check box.

11. In the Thumbnail area, select the Save Thumbnail check box.

12. In the Basic Animation Dialog area, select from the following options:
   - **Prompt on Delete** – Prompts you to confirm the deletion of an animation in the Basic Animation dialog box and the Command Expert dialog box.
   - **Always Show Basic Animation Dialog** – Displays the Basic Animation dialog box when you double-click an object or select Animations from an object's right-click menu. If this check box is cleared, the Advanced Animations dialog box appears.

13. Enable picture caching.

14. In the Create Picture Wizard area, select the Show Picture Wizard From New Picture Menu check box. If this check box is cleared, the Create Picture Wizard is not available.

15. Select the Disable Auto Scale Feature check box to override the logical units to pixel ratio when changing the resolution of your screen.

16. If applicable, set global language settings.

Globally Translating Picture Text

To configure global picture language settings:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.
   - Or -
Using the Proficy iFIX WorkSpace

In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the Picture Preferences tab.
3. Select the Translate Picture on Open check box.
4. From the Language list, choose the language you want all picture text strings to appear in, provided that you add translations to an exported CSV file.
5. Open your pictures in run mode. The displayed text strings are automatically translated into the selected language.

Enabling Picture Caching

To enable picture caching:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.
2. Click the Picture Preferences Tab.
3. Select the Enable Picture Cache check box.
4. Enter a number from 1 to 99 to indicate the number of pictures to be cached. This number represents preload and run-time pictures.

Setting Shape Preferences

To set shape preferences:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.
2. Click the Shape Preferences tab.
3. In the Color area, click each button and select the shape's fade, foreground, background, and edge colors.
4. In the Font area, select the default font, size, and style for text objects.
5. From the Edge Style and Fill Style lists select the default shape edge and fill styles, respectively.
6. In the Edge Width field, enter the default edge thickness, in logical units.
7. From the Background Style list, select the default background style.
8. In the Hit Test Size field, enter the minimum distance, in logical units, required to select an object. When the cursor is within the specified distance, iFIX selects the object.
9. From the Fade Type list, choose the default fade type.
Understanding iFIX

10. In the Blend field, enter how much of the fade color, in a percentage, will be mixed with the foreground color.

11. In the Thickness field, enter the default thickness for pipe objects. You can enter any value from 10 to 300.

12. From the Elbow Style list, choose the default elbow style for pipe objects.

13. From the Start Cap and End Cap lists, choose the default start and end caps for pipe objects.

14. Select the Remove Leading and Trailing Spaces check box to indicate that iFIX should remove extra spaces when Data Links are displayed in the run-time environment.

Setting Drawing Preferences

To set drawing preferences:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.

Or

2. In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

3. Click the Drawing Options tab.

4. In the Extend Options area, select the default option for extending line objects to an intersection point.

5. In the Trim Options area, select the default option for trimming line objects to an intersection point.

6. Select the Always Show Connection Nodes check box to display the connection nodes when using the LineConnector Tool, the Rightangleline Connector, or the Pipe Connector.

Setting Save Preferences

To set the save preferences:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.

Or

2. In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

3. Click the General tab.

4. Select the Always Create Backup Copy check box to automatically create a backup copy each time you save a file. Clear the check box to disable the option.

Setting Chart Preferences

*NOTE:* You can only set preferences for Standard Charts.
To set chart preferences:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.

   - Or -

   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the Chart Preferences tab.

3. From the Scroll Direction area, select the scroll direction.

4. If you choose a Left to Right scroll, in the Reset field, enter the percentage of the chart to repaint when the plotted data reaches the left edge of the chart.

5. In the Time Axis and Value Axis areas, enter the number of ticks and labels for the X and Y axes, respectively.

6. In the Duration area, enter the length of time the X axis spans.

7. In the Interval area, enter the length of time between plotted data points.

8. Select the Allow Time Axis Reset check box to enable the time axis limits of your chart to be reset after you right-click the object to zoom out. The time axis limits are reset to the values of the Start Time and End properties.

9. Select the Allow Value Axis Reset check box to enable the value axis limits of your chart to be reset after you right-click the object to zoom out. The value axis limits are reset to the values of the HiLimit and LoLimit properties.

10. Select the Transparent check box to make the chart's background transparent. Clear the check box to make the background opaque.

Setting Run-time Preferences

The following sections provide steps on how to set run-time preferences in the iFIX WorkSpace:

- Displaying the WorkSpace Full Screen
- Hiding the Historical Datalink Timestamp
- Running Schedules in the Background
- Defining OPC Connection Error Preferences

Displaying the WorkSpace Full-Screen

To display the WorkSpace at full-screen:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.

   - Or -

   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the General tab.

3. Select the Full Screen in Run Mode check box.
Running Schedules in the Background

To select the schedules you want to run in the background:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the Background Startup tab.

3. Click the Add button and enter a file name (EVS files) for the schedule you want to run when iFIX starts. Optionally, click the Browse button to locate the file.

4. Repeat step 3 until you have added all the files you want to run in the background.

5. Select a file and click the Delete button to remove any schedules you no longer want to run in the background.

6. Double-click any existing entry to modify it, as needed.

Setting OPC Connection Error Preferences

To set the OPC connection error preferences:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Click the Animations Data Error Defaults tab.

3. In the Linear Animation Object Defaults area, enter the default numeric values to use when an error occurs scaling a value.

4. In the Format Animations Object Defaults area, enter the default strings to display in a Data link when an error occurs.

5. In the Numeric Table Entries and the String Table Entries areas, enter the default numeric and string values to use when an error occurs in a lookup table.

6. In the Color Table Entries area, click each button and select the color to use when an error occurs in a lookup table.

Selecting Data Sources and Building Expressions

The following sections provide steps on how to select data sources and build expressions in the iFIX WorkSpace:

- Browsing the Process Database
- Building an Expression
- Filtering Data Sources
Using the Proficy iFIX WorkSpace

- Specifying the Tolerance, Deadband, and Refresh Rate
- Using the Proficy Historian Tab in the Expression Builder Dialog Box

Browsing the Process Database

To browse the process database:

1. In the iFIX WorkSpace, open a dialog box that displays a Data Source field. For instance, double-click a datalink to display the Datalink dialog box, or open an Expert dialog box to add a basic animation.
2. Click the Browse button to the right of the Data Source field. The Expression Builder dialog box appears.
3. Click the FIX Database tab.
4. From the Node Names, Tag Names, and Field Names list boxes, respectively, select the SCADA server, block, and field you want. If a list box has many entries you do not want to display, filter the data source.
5. Enter the tolerance, deadband, and refresh rate for this connection.

Building an Expression

To build an expression:

1. In the iFIX WorkSpace, open a dialog box that displays a Data Source field. For instance, double-click a datalink to display the Datalink dialog box, or open an Expert dialog box to add a basic animation.
2. Click the Browse button to the right of the Data Source field. The Expression Builder dialog box appears.
3. Click the tab that contains the items you want to use in your expression, as follows:
   - To include a data source in an expression, click the node, block, and field from the FIX Database tab.
   - To include properties of picture objects, click the Pictures tab.
   - To include historical data, click the Historical tab.
   - To include global objects, click the Globals tab.
   - To include I/O points from third-party OPC servers, click the Data Servers tab.

   *NOTE: Not all tabs are available for all objects.*

4. Expand the list to display the items you want and select them. If a tab has many entries you do not want to display, filter the data source.
5. If you want to combine two expressions, click the Mathematical Functions button and an operator button followed by a numeric value or another expression.
6. Repeat steps 2 through 4, moving from tab to tab until you have included all the items you want in the expression.
7. Enter the tolerance, deadband, and refresh rate for this connection.
8. Click the Check Syntax button to verify that your expression is valid. A valid expression displays the message "Syntax check successful!". An error message is displayed for an invalid
NOTE: If you have created an object-to-object connection, such as the fill percentage of one tank to another, or created a connection to a data source, the animated properties display in boldface in the Properties list of the Pictures tab for the selected object.

Filtering Data Sources

To filter data sources:

1. In the iFIX WorkSpace, open a dialog box that displays a Data Source field. For instance, double-click a datalink to display the Datalink dialog box, or open an Expert dialog box to add a basic animation.
2. Click the Browse button to the right of the Data Source field. The Expression Builder dialog box appears.
3. Click the tab you want to display.
4. Enter the text you want to display, including any wildcards, in the Filter field.
5. Click the Filter button.

Remembering the Last Filter

To remember the last filter:

1. In Classic view, from the iFIX WorkSpace menu, select User Preferences.
   - Or -
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.
2. Select the Remember last filter check box on the General tab. The most recently used filter(s) used on the Expression Builder dialog box will be remembered.

Specifying the Tolerance, Deadband, and Refresh Rate

To specify the tolerance, deadband, and refresh rate:

1. In the iFIX WorkSpace, open a dialog box that displays a Data Source field. For instance, double-click a datalink to display the Datalink dialog box, or open an Expert dialog box to add a basic animation.
2. Click the Browse button to the right of the Data Source field. The Expression Builder dialog box appears.
3. Click the FIX Database tab.
4. In the Tolerance field, enter the maximum allowable rounding factor for the data source or expression you are building. If the value of the data source or expression is within the tolerance of a target value, iFIX assumes the two values are equal.
5. In the Deadband field, enter the maximum fluctuation you want for the data source or expression. If the value of the data source or expression exceeds the maximum or minimum deadband, iFIX updates the object with the new value.
6. In the Refresh Rate field, select how often to update the data source or expression, in seconds.

**Using the Proficy Historian Tab in the Expression Builder Dialog Box**

**Using the Proficy Historian Tab**

The following sections provide steps on how to use the Proficy Historian tab when working with the iFIX WorkSpace:

- Sorting Fields in the Tag List
- Applying Filters to the Tag List
- Resetting Tag Filters

**Sorting Fields in the Tag List**

▶ To sort a field in the tag list:

1. Click the appropriate field header name (Node, Tag, Description, or Collector Name). An arrow appears. The up arrow indicates that the field is sorted in ascending order. The down arrow indicates that the field is sorted in descending order.
2. Click the field header name again to reverse the sort order.

**NOTE:** By default, the fields are sorted in ascending order by the node name.

**Applying a Filter to the Tag List**

▶ To apply a specified filter to the tag list:

1. Enter your filter criteria in the appropriate filter drop-down box (Node, Description, Tag, or Collector Type).
2. Select the Apply Filter button.

**Resetting Tag Filters**

▶ To reset filter specifications:

- Select the Reset button.

**Managing Files and Nodes**

The following sections provide steps on how to manage files and nodes in the iFIX WorkSpace:

- Sharing Files
- Starting iFIX with an SCU file from a different path
- Getting a Different iFIX Project from the Change Management Server
- Creating a Factory Default
Understanding iFIX

- Finding and Replacing Data Overview
- Using the Backup and Restore Wizard Overview

Sharing iFIX Files

To share iFIX files:

1. In Classic view, in the iFIX WorkSpace, click the System Configuration Utility button on the toolbar.
   - Or -
   In Ribbon view, on the Applications tab, in the System & Security group, click SCU.

2. Click the Paths button on the SCU toolbox.

3. In the appropriate field(s), enter the network path(s) you want to use. For example, enter a network path in the Picture field, such as C:\Program Files\Proficy\Proficy iFIX \PIC, to change the Picture path.

4. Copy all the files in the shared paths from your local node to your file server.

Starting iFIX with an SCU File from a Different Path

To start iFIX with an SCU file from a different path:

**NOTE:** The following steps describe how to modify an SCU file with a path outside the install path, so that you run it in iFIX.

1. Shut down iFIX.

2. On the Start menu, point to Programs, Proficy HMI SCADA - iFIX, and then System Configuration to open the SCU. The SCU window appears.

3. From the SCU Configure menu, click Paths. The Path Configuration dialog box appears.

4. In the Path Configuration dialog box, change the base path and NLS path to point to the local install path. Change the project path to point to the project destination folder, if it does not already do so.

5. From the SCU Configure menu, click Tasks. The Task Configuration dialog box appears.

6. In the Task Configuration dialog box, change the path of the configured tasks to the local install path, make sure that you include the same command line options.

7. From the SCU Configure menu, click Network. The Network Configuration dialog box appears.

8. In the Network Configuration dialog box, confirm the information is correct and make changes if necessary.

9. From the SCU Configure menu, click SQL, and then click Configure SQL Tasks. The SQL Task Configuration dialog box appears.

10. In the SQL Task Configuration dialog box, make sure that the Primary and Secondary paths are correct, if used.

11. From the SCU Configure menu, click Local Startup. The Local Startup Definition dialog box appears.
12. In the Local Startup Definition dialog box, change the path to the folder you copied the project to with the get command.

13. From the SCU File menu, click Save.

14. Restart iFIX.

**Getting a Different iFIX Project from the Change Management Server**

To get a different iFIX project from the Change Management Server:

1. From the iFIX WorkSpace system tree, right-click the node name, point to Manage, and then click Get Other Project. The Get Project dialog box appears.

   _NOTE: The Manage right-click menu is unavailable if you are not logged into the Change Management Server from iFIX._

2. In the Select Project drop-down list, select a project name.

3. In the Project Destination field, if the path is the same as your local iFIX install, enter a different path. By doing this, you prevent the get command from overwriting your current iFIX project files.

   By default, the path in the Project Destination field is set to the path that the project was last checked in with.

4. If you want to delete any existing files before you get the project files, select the Delete all existing files under Project Destination check box.

5. If you want to copy iFIX default files into the folder before retrieving the project, select the Initialize Project Destination with iFIX default Files check box. It is recommended that you leave this check box selected. Otherwise, you will not be able to run the project you get in iFIX.

6. Click Get. A status box appears as the iFIX project files are copied to your local computer.

7. If you want to start iFIX using the SCU from the project you just got, follow the steps below.

   To start iFIX with that project's SCU:

   _NOTE: These steps start iFIX with an SCU from a different path (a path outside the install path)._

1. Shut down iFIX.

2. On the Start menu, point to Programs, Proficy HMI SCADA - iFIX, and then System Configuration to open the SCU. The SCU window appears.

3. From the SCU Configure menu, click Paths. The Paths Configuration dialog box appears.

4. In the Path Configuration dialog box, change the base path and NLS path to point to the local install path. Change the project path to point to the project destination folder, if it does not already do so.

5. From the SCU Configure menu, click Tasks. The Tasks Configuration dialog box appears.

6. In the Task Configuration dialog box, change the path of the configured tasks to the local install path, make sure that you include the same command line options.

7. From the SCU Configure menu, click Network. The Network Configuration dialog box appears.

8. In the Network Configuration dialog box, confirm the information is correct and make
changes if necessary.

9. From the SCU Configure menu, click SQL, and then click Configure SQL Tasks. The SQL Task Configuration dialog box appears.

10. In the SQL Task Configuration dialog box, make sure that the Primary and Secondary paths are correct, if used.

11. From the SCU Configure menu, click Local Startup Paths. The Local Startup Definition dialog box appears.

12. In the Local Startup Definition dialog box, change the path to the folder you copied the project to with the get command.

13. From the SCU File menu, click Save.

14. Restart iFIX.

Creating a Factory Default Backup File

To create a factory default backup file:

From the command line, enter

```
BackupRestore.exe /FactoryDefault [/l=<user ini file>]
```

**NOTE:** You can modify the BackupRestore.ini file to create user specific defaults. For more information, refer to the BackupRestore.ini file.

Finding and Replacing Data

The following sections provide steps on how to find and replace data in the Proficy iFIX WorkSpace:

- Finding Data
- Replacing Data

Finding Data in Pictures, Schedules, and Scripts

To find data in pictures, schedules, and scripts:

1. In Classic view, in the iFIX WorkSpace, from the Edit menu, select Find and Replace.
   - Or-
   In Ribbon view, on the Home tab, in the Editing group, click Find and Replace.

2. In the Find What field, enter the text you want to locate.

3. Select one or more of the following check boxes to set the appropriate options:
   - Select the Match Case check box to do a case-sensitive search.
   - Select the Whole Word Only check box to locate whole words that match the search string.
   - Select the Data Source Only check box to locate only data sources.
   - Select the Include Scripts check box to locate the search string in the scripts.
Replacing Data in Pictures, Schedules, and Scripts

To replace data in pictures, schedules, and scripts:

1. Using the Find and Replace dialog box, find the data you want to replace.
2. Click the Replace tab in the Find and Replace dialog box.
3. In the Replace With field, enter the text you want to substitute for the search string.
4. Click one or more of the following buttons to replace the values as needed:
   • Click Replace Preview to view the results of replacing all the property values found without changing them.
   • Click Replace Selected to replace the value selected from the Match List list box.
   • Click Replace All to replace all the property values found.

Using the Backup and Restore Wizard

The following sections provide steps on how to use the Backup and Restore wizard in the Proficy iFIX WorkSpace:

- Archiving Selected Files
- Restoring Files From an Archive
- Defining the Archive iBatch Project

Archiving Selected Files

To archive selected files, or create a new factory default file:

1. From the iFIX submenu, open the Backup & Restore Wizard:
   a. From the Windows Start menu, point to Programs, Proficy HMI SCADA - iFIX, Tools, and then Backup and Restore Wizard.
   b. From the iFIX submenu, choose Backup & Restore Wizard. The Proficy iFIX Project Backup dialog box appears.

   **NOTE:** To run the Backup and Restore wizard with the Factory Default option, run the application with the /FactoryDefault command line option. For instance, in the Run dialog box, type: backuprestore.exe /FactoryDefault. In Factory Default mode, the Custom and Full Backup options are unavailable.

2. Select the Custom Backup or Factory Default Backup option and click the Project Backup Wizard button. The Proficy iFIX Project Backup Wizard appears.
3. From the Backup File Option list, select the check box(es) for the types of files you want to archive. To archive all your files, select the Backup the Entire System check box.
4. If you have Security files and want to add those to your archive file, select the Include security files in archive check box.
Understanding iFIX

5. Click Next and specify the path and archive file to use. You can also click the Browse button to locate the path and file.
6. Click Finish to archive the selected files.

To create an archive of all your files:

1. From the iFIX submenu, select the Backup & Restore Wizard as follows:
   a. From the Windows Start menu, point to Programs then point to Proficy HMI SCADA – iFIX.
   b. From the iFIX submenu, choose Backup & Restore Wizard. The Proficy iFIX Project Backup dialog box appears.
2. In the Backup Type area, select the Full Backup option and click the Project Backup Wizard button. The Proficy iFIX Project Backup Wizard appears.
3. Enter the path and archive file to use. You can also click the Browse button to locate the path and file.
4. Click Finish to archive the selected files.

Restoring Files From an Archive

To restore files from an archive:

1. Shut down iFIX if it is running.
2. From the iFIX submenu, select Backup & Restore Wizard as follows:
   a. From the Windows Start menu, point to Programs, Proficy HMI SCADA - iFIX, Tools, and then Backup and Restore Wizard.
   b. From the iFIX submenu, choose Backup & Restore Wizard. The Proficy iFIX Project Backup dialog box appears.
3. Click the Project Restore Wizard button. The Proficy iFIX Restore Wizard appears.
4. Click the Browse … button and select the archive file from which to restore files.
5. Click Next and select the appropriate Restore Destination Option.
   The corresponding destination information displays in the Destination Info fields.
6. To perform a clean restore and delete all files before restoring the archive, select the Delete all existing files under target project path before the restore option.
7. To restore the iFIX files to their default state before restoring your archive, select the Restore default iFIX files before restoring your backup files option.
8. If security files are located in the archive, select to leave the security settings alone, replace existing security files with archived files, or delete all existing security files and disable security.
9. Select the check box(es) of the specific files you want to restore or select the Restore the entire system check box to restore all files in the archive.
Defining the Active Batch Execution Project

To define the active Batch Execution project:

1. From the system tree, double-click the Batch configuration icon. The Batch Configuration dialog box appears.
2. Click the Project tab.
3. In the Active Project field, enter the name of the project or click the Create New Project button and enter the name of the project in the dialog box that appears.
4. Click OK.
5. Restart the iFIX WorkSpace.

Installing the Proficy Historian Server

The following sections provide steps on how to install and use the Proficy Historian server in the iFIX WorkSpace:

- Configuring Proficy Historian and iFIX
- Adding a Server to the Proficy Historian Server List
- Deleting a Server from the Proficy Historian Server List
- Modifying a Server on the Proficy Historian List
- Setting the Default Collector
- Setting the Default Proficy Historian Server
- Troubleshooting Proficy Historian and iFIX

Configuring Proficy Historian and iFIX

You must shut down Historian services and licensing prior to installing iFIX and Historian. To use the integrated Proficy Historian features in iFIX, you must choose to install Historian.

To configure Proficy Historian and iFIX:

After the iFIX and Historian install, do the following:

1. Restart your computer.
2. Confirm that the Collectors installed. To do so:
   a. On the Start menu, click Programs, Proficy Historian, and then Historian Administrator. The Historian Administrator program starts.
   b. Log into Proficy Historian Administrator.
   c. Click Collectors.
   d. Verify that all of your collectors appear in the Collectors area, especially the iFIX collector.
3. Start iFIX, the WorkSpace and the iFIX collector.
4. Classic view only: Insert the Proficy Historian toolbar. To do so:
Understanding IFIX

5. Change Historians. To do so:
   a. In Classic view, on the Proficy Historian toolbar, click Change Historian.
   -Or-
   In Ribbon view, on the Administration tab, in the Proficy Historian Group, click Configure Historian, and then click Change Historian.
   b. Select Proficy Historian, and then click OK.
   c. Close and restart the WorkSpace.

6. Configure the Historian Server. To do so:
   -Or-
   In Ribbon view, on the Administration tab, in the Proficy Historian Group, click Configure Historian, and then click Configure Historian Server.
   b. Click Get Collectors. The Collector Name list is populated.
   c. Select the iFIX collector, and then click Set Default.
   d. Click Close.
   e. Restart the WorkSpace.

7. In the iFIX Database Manager, add the blocks that you want to start collecting on. To do so:
   a. In the Database Manager, in Classic view, on the Database Manager's toolbar, click Open.
   -Or-
   In Ribbon view, click the Main Button, and then click Open.
   b. Double-click the SCADA server you want to connect to. The database displays.
   c. Double-click in a blank cell in the spreadsheet. The Select a Block Type dialog box appears.
   d. Select the type of block you want to add and click OK. The block's dialog box appears.
   e. Complete each tab. Use the Proficy Historian tab to enter the information from Historian, and then click Save.
   f. Repeat Steps C-E for each block you want to add.
   g. Save your database. In Classic view, on the Database Manager's toolbar, click Save.
   -Or-
   In Ribbon view, click the Main Button, and then click Save.
Using the Proficy iFIX WorkSpace

**NOTE:** For instructions on modifying blocks, see Modifying Blocks.

8. After approximately two minutes, in the Historian Administrator, check that your tag was added. To do so:
   a. On the Start menu, click Programs, Proficy Historian, and then Historian Administrator. The Historian Administrator program starts.
   b. Log into Proficy Historian Administrator.
   c. Click Tags.
   d. Verify that all of your tags appear in the tags area.

**NOTE:** The confighist.txt file is the log file in the iFIX LOCAL folder. Use this log file to troubleshoot if your tags do not get added to Historian.

9. Verify your configuration. To do so:
   a. Add a historical data link to your picture. In Classic view, from the Toolbox, click Historical Datalink.
      - Or -
      In Ribbon view, on the Insert tab, in the Objects/Links group, click Objects/Links, and then click Historical Datalink.
   b. Switch to run mode. In Classic view, from the WorkSpace menu, select Switch to Run.
      - Or -
      In Ribbon view, on the Home tab, in the WorkSpace group, click Switch to Run.
   c. View the last value collected in the data link.

**NOTE:** There will be a delay of approximately two minutes between data updates.

Adding a Server to the Proficy Historian Server List

**To add a server to the Proficy Historian server list:**

1. In Classic view, locate the Proficy Historian toolbar and then click the Configure iHistorian Server button, which is the third of the four buttons.
   - Or -
   In Ribbon view, on the Administration tab, in the Proficy Historian group, click Configure Historian, and then click Configure Historian Server.

2. Click Add Server.

3. In the Alias Name field, enter an alias.

4. In the Server Name field, enter a server name.

5. If required, in the User Name and Password fields, enter a user name and password, respectively.

6. Click Add Server.

7. Click OK.
Deleting a Server from the Proficy Historian Server List

To delete a server from the Proficy Historian server list:

1. In Classic view, locate the Proficy Historian toolbar and then click the Configure iHistorian Server button, which is the third of the four buttons.
   - Or -
   In Ribbon view, on the Administration tab, in the Proficy Historian group, click Configure Historian, and then click Configure Historian Server.

2. From the Alias Name/Server Name list, select the server to delete.

3. Click Delete.

4. Click Close.

Modifying a Server on the Proficy Historian List

To modify a server on the Proficy Historian server list:

1. In Classic view, locate the Proficy Historian toolbar and then click the Configure iHistorian Server button, which is the third of the four buttons.
   - Or -
   In Ribbon view, on the Administration tab, in the Proficy Historian group, click Configure Historian, and then click Configure Historian Server.

2. From the Alias Name/Server Name list, select a server to modify.

3. Click Modify.

4. Click Close.

Setting the Default Proficy Historian Server

To set the default Proficy Historian server:

NOTE: You must select a default Historian server. Otherwise, Historian will not work correctly in the WorkSpace.

1. In Classic view, locate the Proficy Historian toolbar and click the Configure iHistorian Server button, which is the third of the four buttons.
   - Or -
   In Ribbon view, on the Administration tab, in the Proficy Historian group, click Configure Historian, and then click Configure Historian Server.

2. From the Alias Name/Server Name list, select a server.

3. Click Set Default. The selected server is set as the default Historian server.
Setting the Default Collector

- **To set the default collector:**

  1. In Classic view, locate the Proficy Historian toolbar and then click the Configure iHistorian Server button, which is the third of the four buttons.
     - Or-

     In Ribbon view, on the Administration tab, in the Proficy Historian group, click Configure Historian, and then click Configure Historian Server.

  2. Click Get Collectors.

  3. From the Collector Name list select a collector.

  4. Click Set Default. The selected collector is set as the default Historian collector.

**NOTES:**

- For iFIX 5.1 automatic collection, you must select the iFIX collector.

- If you are upgrading your system, set your existing collector as the default collector.

- If you have redundant servers, for each server, set the primary server's collector as the default collector. For more information about redundancy and Historian, refer to the Proficy Historian and Enhanced Failover section.

- Because this feature only supports collectors that read data from iFIX, the collectors available for selection are limited to the following:

  - iFIX Native Collector
  - OPC Collector reading from Intellution.OPCEDA or Intellution.OPCiFIX OPC servers

Troubleshooting Proficy Historian and iFIX

The following table lists some specific troubleshooting information for configuring Proficy Historian and iFIX.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Solution/Explanation</th>
</tr>
</thead>
</table>
| I reloaded my database. I have a tag named A11; I have set Enable Collection on this tag and updated the necessary Historian fields. However, the tag does not seem to be collected. | Verify that:  
  - The default Collector is configured.  
  - A connection exists between iFIX and Historian.  
  - You have configuration privileges.  
  There are a number of reasons why tags are not collected. If none of the preceding reasons seem to be the cause, check the confighist.txt file and review the error log. Also, check the alarm history information. |
### Understanding iFIX

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Solution/Explanation</th>
</tr>
</thead>
</table>
| I have a tag named Fix.A11.F.CV in Historian already collecting. What will happen if I reload or import a database and the database already contains a tag named A11? | Proficy Historian always configures tags using the following format for the tag name:  
NodeName.TagName.F.CV.  
Hence, if you are already collecting a tag with the same name, when you:  
**Reload** – at the time of reload, iFIX will detect that there is already another tag with the same name being collected and all the information from Historian for that tag will be updated in the iFIX block named A11.  
**Import** or **Add** – When importing or adding a tag to the database, the tag from Historian will be overwritten with the tag of the same name from the iFIX database. |
| I do not want to install integrated Historian, and want to continue using Historian as I did before. | Never do the following:  
- Select the Automatically Configure Tags for Collection in Historian on the Proficy Historian tab of the User Preferences dialog box.  
- Use Proficy Historian fields in the iFIX Database Manager to configure anything in Historian. |
| I want to use both products simultaneously to configure tags.           | We recommend avoiding this practice. Use the feature that best accommodates the collection requirements of the particular tag.  
If you decide to use both products at once, changes made in iFIX take precedence and will overwrite settings made using Historian Administrator.  
If you are using Historian Administrator, do not use iFIX block fields for those tags. |
| I upgraded from iFIX 4.5 to iFIX 5.1. What will happen to my database blocks? | All of the database blocks will be upgraded to include all of the new fields and they will be initialized to default values for Historian fields. Additional considerations:  
- By default collection is not enabled  
- If some of the blocks are already being collected, they will receive the information from Historian for the collection fields at the time of reload. |
<p>| I have configured redundant SCADA nodes. How does this feature affect my configuration? | iFIX always adds tags to the primary collector, so if you have collector redundancy configured correctly, there should be no problem. |</p>
<table>
<thead>
<tr>
<th>Scenario</th>
<th>Solution/Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>I selected the Automatically Add Tags for Collection check box. I have some tags already configured for collection in Historian. What will happen to my tags?</td>
<td>Since at reload time information from Historian is updated in iFIX, this option will not take effect for your existing tags; you will have to update them manually. The log in configHist.txt will show that the tag already exists and in the Database Manager you can see that the tag has pulled up information from Historian.</td>
</tr>
<tr>
<td>My Collector list is empty.</td>
<td>In the Task Configuration dialog box of the SCU tool, add the collector. Let the collector run at least one time on your system.</td>
</tr>
<tr>
<td>My database does not contain all of the tags I added.</td>
<td>Check the configHist.txt file, located in the Local folder, to determine if you exceeded the licensed tag collection amount. If so, you may need to purchase more tags.</td>
</tr>
<tr>
<td>There is a long time between when changes are made in the database and when they appear.</td>
<td>When using iFIX and Historian together, and the Collector is running, there is approximately a two minute delay between when changes are made and when they appear.</td>
</tr>
<tr>
<td>I reloaded my database and some tags seem to have disappeared from Historian. What happened?</td>
<td>When you reload the database, all of the new database tags are added to Historian. In addition, all of the tags from the previous database are hidden from Historian. It may seem as though those tags are deleted, but they are not.</td>
</tr>
<tr>
<td>I decided to uninstall Historian. Now I get the error message &quot;Could not load an object...&quot; when I open WorkSpace.</td>
<td>To correct this, register COMDLG32.ocx.</td>
</tr>
<tr>
<td>On the Configure the Proficy Historian Server dialog box, the Get Collectors and Set Default buttons are unavailable.</td>
<td>The Get Collectors and Set Default buttons are unavailable in iFIX if you are attempting to configure the default collector on a View node.</td>
</tr>
<tr>
<td>I have configured my Historian Servers. However, when I log in to iFIX, there are no servers listed.</td>
<td>Historian servers need to be configured for each operating system user. For example, let's assume you configured the Historian server while you were logged in as Administrator. If you did not configure the Historian server for all other Windows users, the servers you configured for the Administrator will not display, because they are not configured for any other user. Make sure to configure Historian servers for all operating system users.</td>
</tr>
</tbody>
</table>
Working with Toolbars

The following sections provide steps on how to work with toolbars in the iFIX WorkSpace:

- Showing and Hiding Toolbars
- Customizing Toolbars Overview
- Creating Toolbars Overview
- Creating Buttons Overview

Showing and Hiding Toolbars

To show or hide toolbars:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
2. Select the owner for the toolbars you want to show or hide.
3. Select the check box of each toolbar you want to display and clear the check box for each toolbar you want to hide.

Customizing Toolbars

The following sections provide steps on how to customize toolbars in the Proficy iFIX WorkSpace:

- Adding a Button to a Toolbar
- Removing a Button from a Toolbar
- Arranging Buttons on a Toolbar
- Enabling and Disabling Toolbar Docking
- Resetting Standard Toolbars

Adding a Button to a Toolbar

To add a button to a toolbar:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
2. Click Customize.
3. Click the Buttons tab and select the category for the button you want to add.
4. Click, drag, and drop the button you want to add onto the toolbar.

   *NOTE:* The buttons in the Scheduler category are for internal use only.

Removing a Button From a Toolbar

» To remove a button from a toolbar:

1. In Classic view, from the iFIX WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

2. Click Customize.

3. Click, drag, and drop the button you want to delete off of the toolbar.

Arranging Buttons on a Toolbar

» To arrange buttons on a toolbar:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

2. Click Customize.

3. Click, drag, and drop the button to its new location on the toolbar.

   *NOTE:* The buttons in the Scheduler category are for internal use only.

Enabling and Disabling Toolbar Docking

» To enable and disable toolbar docking:

   *NOTE:* In Ribbon view, toolbars cannot be docked.

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.

2. Click Customize.

3. Select the owner of the toolbar you want to modify.

4. Select the floating toolbar you want to modify. If the toolbar is hidden, select the toolbar's check box to display it.

5. Select the Enable Docking for Selected Toolbar check box to enable docking. To disable docking, clear the check box.
Resetting Standard Toolbars

To reset a standard toolbar:

1. In Classic view, from the iFIX WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, in the Settings list, click Toolbars.
2. Click Customize.
3. Select the toolbar you want to reset and click Reset. If the button is grayed out, the toolbar is supplied with iFIX.

Creating Toolbars

The following sections provide steps on how to create and work with toolbars in the Proficy iFIX WorkSpace:

- Creating a Toolbar
- Deleting a Toolbar
- Modifying Toolbar Properties
- Editing the Script of a Toolbar Button

Creating a Toolbar

To create a toolbar:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
2. Click Customize.
3. Click the Toolbars tab.
4. Click Add Toolbar.
5. Enter a name for the toolbar.
6. Select the toolbar's owner from the Owner list. If the owner you want does not appear:
   a. Close the Customize Toolbars dialog box.
   b. Open a document of the associated type. For example, open a picture to select Picture as an owner.
7. Repeat steps 1 through 6.
8. Add buttons to the toolbar.
9. Edit each button's script as needed.
Deleting a Toolbar

To delete a toolbar:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

2. Click Customize.

3. Click the Toolbars tab.

4. Select the owner of the toolbar you want to delete from the Owner list. If the owner you want does not appear:
   a. Close the Customize Toolbars dialog box.
   b. Open a document of the associated type. For example, open a picture to select Picture as an owner.
   c. Repeat steps 1 through 4.

5. Select the toolbar you want to delete.

6. Click Delete Toolbar.

Modifying Toolbar Properties

To modify a toolbar's properties:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

2. Click Customize.

3. Click the Toolbars tab.

4. Select the toolbar's owner from the Owner list. If the owner you want does not appear:
   a. Close the Customize Toolbars dialog box.
   b. Open a document of the associated type. For example, open a picture to select Picture as an owner.
   c. Repeat steps 1 through 4.

5. Select the toolbar you want to modify.

6. Click Modify Properties.

7. Change the toolbar's name and owner as needed.
Understanding iFIX

Editing the Script of a Toolbar Button

To edit the script of a toolbar button:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
2. Click Customize.
3. Double-click the button you want to modify from a toolbar or click the Buttons tab and double-click the button.
4. Click Edit Script to open the Visual Basic Editor. Edit the button's script with the VBE.

Creating Buttons

The following sections provide steps on how to create button in the Proficy iFIX WorkSpace:

• Creating or Renaming a Category
• Deleting a Category
• Creating a Button
• Deleting a Button
• Modifying a Button's Properties
• Displaying a Toolbar
• Importing a Toolbar

Creating or Renaming a Category

To create or rename a category:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
2. Click Customize.
3. Click the Buttons tab.
4. Click Add Category or Rename Category and enter a category name.
   Category names can be up to 31 letters long. You cannot include numbers, a space, period (.), exclamation mark (!), or the characters @, &, $, # in the name. In addition, category names cannot match the name of any other toolbar, category, picture, schedule, or Dynamo set.

NOTE: You can rename user-created categories only.
Deleting a Category

To delete a category:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   - Or -
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
2. Click Customize.
3. Click the Buttons tab.
4. Select the category you want to delete.
5. Click Delete Category.
   
   NOTE: You can delete user-created categories only.

Creating a Button

To create a button:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   - Or -
   In Ribbon view, on the Home tab in the WorkSpace group, click Settings, and then click Toolbars.
2. Click Customize.
3. Click the Buttons tab.
4. Select the category you want to assign the button to.
5. Click Add Button.
6. Configure the button.
   
   NOTE: You can create buttons for user-created categories only.

Deleting a Button

To delete a button:

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   - Or -
   In Ribbon view, on the Home tab in the WorkSpace group, click Settings, and then click Toolbars.
2. Click Customize.
3. Click the Buttons tab.
4. Select the category for the button you want to delete.
5. Select the button and click Delete Button.
6. Click OK when you are prompted to confirm the deletion.

**NOTE:** You can delete buttons only from user-created categories.

**Modifying Button Properties**

**To modify a button's properties:**

1. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   - Or-
     In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
2. Click Customize.
3. Click the Buttons tab.
4. Select the category for the button you want to modify.
5. Click Modify Button.
6. Configure the button.

**NOTE:** You can modify buttons only in user-created categories.

**Displaying a Toolbar**

**To display a toolbar:**

1. Open the iFIX Workspace.
2. In the WorkSpace system tree, double-click the Project Toolbar Files folder, and then the Toolbars folder.
3. Double-click the name of the toolbar you want to display. The toolbar should now display in the WorkSpace.

**Importing a Toolbar**

**To import a toolbar:**

1. Copy the toolbar file (.TBX) you want to import to the Local path of your computer.
2. In Classic view, in the iFIX WorkSpace, from the WorkSpace menu, select Toolbars.
   - Or-
     In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.
3. Click Customize.
4. Click Import.
5. From the Toolbars list box, select the file.
6. From the Owner list, select the owner. If the owner you want does not appear:
   a. Close the Customize Toolbars dialog box.
   b. Open a document of the associated type. For example, open a picture to select Picture as an owner.
   c. Repeat steps 1 through 6.
7. Click Import.

Installing a Third-Party OPC Server

The following sections provide steps on how to install and use a third-party OPC server in the iFIX WorkSpace:

- Adding or Modifying an OPC Server
- Deleting an OPC Server
- Troubleshooting OPC Server Installations
- Setting up DCOM Support in the WorkSpace

Adding or Modifying an OPC Server

▸ To add or modify an OPC server:

1. On the Start menu, point to Programs, Proficy HMI SCADA - iFIX, Tools, and then Data Server Installer.
2. Click Add or double-click the data server you want to modify.
3. In the Data Server field, enter an OPC data source name. Make sure the name is not already in use.
4. From the OPC server list, select an OPC driver.
5. In the Machine Name field, enter the local or remote computer name where the OPC Server resides.
6. Select the Set as Default Server check box to make the server the default.
   
   **NOTE:** You must have rights to write to the registry in order to perform this task.

Deleting an OPC Server

▸ To delete an OPC server:

1. On the Start menu, point to Programs, Proficy HMI SCADA - iFIX, Tools, and then Data Server Installer. The Data Server Installer dialog box appears.
2. Select the OPC server you want to delete.
3. Click Remove.
   
   **NOTE:** You must have rights to write to the registry in order to perform this task.
Troubleshooting OPC Server Installations

You can add third-party OPC servers into iFIX by installing them with the Data Server Installer. The Data Server Installer can be accessed from the Start menu by pointing to Programs, Proficy HMI SCADA - iFIX, Tools, and then Data Server Installer. If you have difficulty accessing data from the OPC server, use the following steps to troubleshoot.

▶ To troubleshoot your OPC Server installation:

1. From the Start menu, select Run and enter Regedit.
2. Open the key HKEY_CLASSES_ROOT\FIX32\DataSources.
3. Ensure that each subkey in the DataSources folder represents an OPC server installed into iFIX, and that it contains the following:
   - (Default) = "DataSourceName"
   - DefaultServer = 0 (1, if server is the default)
   - OpcAccessPath = ""
   - OpcDataSource = "AnyString"
   - OpcProgID = "ProgID"
   - OpcServerMachineName = ""

   For example, the subkey for the FIX OPC server appears as follows:
   - (Default) = "FIX32"
   - DefaultServer = 1
   - OpcAccessPath = ""
   - OpcDataSource = "Intellution OPC EDA Server"
   - OpcProgID = "Intellution.OPCEDA"
   - OpcServerMachineName = ""

Setting up DCOM Support in the WorkSpace

▶ To setup DCOM support in the WorkSpace:

1. If necessary, install the driver:
   a. Insert the I/O Drivers and OPC Servers CD into your CD-ROM drive. The CD spins up and the Driver CD splash screen appears.
   b. Click the Install Driver button.
   c. Select the driver name from the menu. For example for the MBE driver, select MBE - Modbus Ethernet v7.x.
   d. Click the Install Now button.
2. Run the Data Server Installer. You can launch this application from the Start menu by pointing to Programs, Proficy HMI SCADA - iFIX, Tools, and then Data Server Installer. The Data Server Installer dialog box appears.
3. Click Add to add an OPC server. The Add Server dialog box appears.
4. Enter an OPC data source name in the Data Server field. For example, for the MBE driver, you might enter MBESOURCE in this field.
5. Select the OPC server from the drop-down list in the OPC Server field. For example, for the MBE driver you would select Intellution.MBEOPC.
6. In the Machine Name field, enter the local or remote computer name where the OPC Server resides.
7. Click OK to save your changes.
8. Configure the server from the iFIX program group. For example, for the MBE driver, select the MBE PowerTool option.
Managing iFIX Nodes

This chapter explains how to manage your iFIX nodes with the Proficy iFIX WorkSpace by backing up and restoring your files. The chapter also describes other management tasks you can complete with the WorkSpace, such as configuring the local computer, finding and replacing data in iFIX, and specifying the active Proficy Batch Execution project.

Refer to the following sections for more information:

- Configuring the Local Computer
- Sharing Files
- Finding and Replacing Data
- Backing up and Restoring Files
- Specifying a Proficy Batch Execution Project

Configuring the Local Computer

Your main tool for configuring your computer for use with iFIX is the System Configuration Utility (SCU). This program lets you configure the computer's:

- Network connections.
- Alarm routing and destinations.
- SCADA and I/O driver options (for SCADA servers only).
- Security options (when iFIX is running).
- iFIX paths.
- Start-up tasks.
- Alarm area configuration.

To learn more about the SCU, refer to the Setting up the Environment manual.

Sharing Files

Using iFIX, you can share files among your nodes by placing these files on a file server and changing the local node's paths. The files you share depend on your configuration; you may want to share operator displays or schedules. Frequently, the alarm area database is shared to ensure that all SCADA servers have access to an identical set of alarm areas. Likewise, sharing your security files ensures that operators can log in from any node.

The path you specify for sharing files also depends on your configuration. You can specify any mapped network drive, such as Z:\Program Files\Proficy\Proficy iFIX\ALM.

*NOTE:* iFIX stores different types of files in the paths it uses. For example, the Picture path holds
pictures, user globals, color tables, and named colors. Sharing this path gives access to all these files.

The iFIX pictures are not backwards compatible for earlier versions of iFIX. If you use multiple versions of iFIX, store your pictures locally or use a separate shared pictures path for each version of iFIX.

**Configuring the Picture Path**

If you are using a shared PIC directory on a drive other than the one on which iFIX is installed, you must enter the full path in the SCU.

For example, if you want to use a shared PIC directory on the G:\drive, you must enter G:\PIC in the SCU. If you enter G:\, your WorkSpace will not open correctly.

---

**Finding and Replacing Data**

Many process environments are expansive, and may include pictures or schedules that reference many sources of data for operations in different locations throughout your plant. If you need to reroute certain data to another node, or globally change a data source throughout a plant, you can do so quickly, without disrupting operation or using valuable resources by finding and replacing data.

Finding data locates values of picture and schedule properties that match the search string. It also locates property values of objects in your pictures. The search string you enter indicates the data you want to locate and optionally replace. Any property value that matches this text appears on the Find tab. On the Replace tab, only values you can modify appear.

**Find Options**

You can select any of the following options when finding data:

- **Match Case** – Finds text that matches the exact case of the search string.

- **Whole Word Only** – Finds only whole words that match the search string. A whole word is any text delimited by a carriage return, a line feed, a space, a hyphen (-), a semi-colon (;), a colon (:), a comma (,), a period (.), an underscore (_), an exclamation point (!), quotation marks ("), apostrophe (‘), parenthesis ( ), braces { }, or brackets [ ]. This means that a typical data source, such as Fix32.MIXER1.AI1.F.CV contains five words.

- **Data Source Only** – Finds only data sources that match the search string.

  **NOTE:** If a data source used to animate an object has its Data Conversion type set to Object, the data source is ignored during all Find operations.

- **Include Scripts** – Finds text in the scripts associated with the current picture or schedule.

**Replace Options**

When replacing data, you can select from the following options:

- **Replace Selected** – Replaces only the property values you select.
Replace All – Replaces all property values found.

Replace Preview – Displays the results of replacing all property values in the Replace Value With column.

**NOTE:** You cannot undo a Find and Replace operation and the text you enter as the replacement string appears exactly as you enter it.

**Notes on Special Characters in Search Strings**

When you use wildcard characters such as the * or ? character in your search string, text containing the following special characters will not be found even if it satisfies the search criteria:

```
" ' ( ) * + ; ? @ ^ ' { } ~
```

For instance, if you want to locate joe@company.com and enter j*com as your search string in the Find What field, the joe@company.com term is not found, since the text includes a special character (@).

**Example: Finding and Replacing Data**

Assume you want to replace all of the tags in a picture from MIXER.AI_VALVE_OPEN to MIXER.AI_VALVE_CLOSED. One way you can change these value is to perform a whole word find and replace.

To perform a whole word find and replace:

1. On the Edit menu, click Find and Replace.
2. In the Find What field, enter MIXER1.AI_VALVE_OPEN.
3. Click the Replace tab, and enter MIXER1.AI_VALVE_CLOSED in the Replace With field.
4. Click Replace Preview to view the resulting values in the Replace Value With column.
5. Click Replace All.

If you find and replace a tag which returns numeric data only, such as F_CV, with a tag that returns non-numeric data, such as A_CUALM, Data links that are connected to this tag will no longer appear to update. For example:

<table>
<thead>
<tr>
<th>If you replace...</th>
<th>With...</th>
<th>Then the Replace will...</th>
</tr>
</thead>
<tbody>
<tr>
<td>F_CV</td>
<td>A_CV</td>
<td>Works for analog tags where the A_CV is simply a string containing a number.</td>
</tr>
<tr>
<td>A_CV</td>
<td>F_CV</td>
<td>Work without errors.</td>
</tr>
<tr>
<td>F_CV</td>
<td>A_MODE</td>
<td>Not work.</td>
</tr>
</tbody>
</table>
Understanding IFIX

If you replace... | With... | Then the Replace will...
---|---|---
F_CV | A_CV and then A_MODE | Not work because the tag was originally a number.

Using Wildcards

One of the most powerful options you have when finding and replacing data is the ability to include wildcards in search strings and the replacement text you enter. You can enter any of the following wildcards:

* – Finds zero or more characters.

? – Finds any single character. For example, the search string TAN? locates the string TANK. It also locates the string TANKS.

\ – Finds wildcard characters in the search string. For example, \* locates an asterisk (*) in the property values being searched.

When replacing data, the wildcard only lets you substitute one character for the wildcard. For example, if you replace TAN? with TANZ, the resulting strings are TANZ and TANZS.

To make your searches more effective, use these guidelines:

- If the search string has wildcard characters, the replacement string must have the same wildcard characters or none at all.
- If the search string has no wildcard characters, the replacement string cannot have any wildcard characters.
- Do not use * and ? in the same search string.

The table below details some examples of using wildcards with Find and Replace.

<table>
<thead>
<tr>
<th>Property Value</th>
<th>Search String</th>
<th>Replacement Text</th>
<th>Modified Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE1.AI1</td>
<td>N*.A*</td>
<td>M*.B*</td>
<td>MODE1.BI1</td>
</tr>
<tr>
<td>NODE1.AI1</td>
<td>*.AI1</td>
<td>NEWNODE.A</td>
<td>NEWNODE.A</td>
</tr>
<tr>
<td>NODE1.AI1</td>
<td>**</td>
<td>N2.A2</td>
<td>N2:A2</td>
</tr>
<tr>
<td>NODE1.AI2</td>
<td>NOD*.AI*</td>
<td>BE*.CO*</td>
<td>BEE1.CO2</td>
</tr>
</tbody>
</table>
### Finding and Replacing Data in Scripts

By default, finding and replacing data in the Proficy iFIX WorkSpace does not search in the scripts associated with the current picture or schedule. However, you can search in event scripts by selecting the Include Scripts check box. Declarations, forms, class modules, and other scripts are not searched by iFIX. To search in these scripts, use the Visual Basic Editor (VBE). For more information on using the VBE, refer to its online Help.

iFIX lets you add find and replace capabilities to your scripts using the FindReplace interface in the FixScriptGlobal object. Refer to the Writing Scripts manual and the iFIX Automation Interfaces Help file for more information.

### Using Find and Replace with User Globals

In order to use the Find and Replace command on User Globals, you must right-click the User icon in the Globals folder in the system tree, and select Find and Replace from the menu. You cannot perform a Find and Replace on User Globals by selecting Find and Replace from the Edit menu (Classic view) or on the Home tab, in the Editing group, click Find and Replace (Ribbon view). That menu belongs to the active document only.

Note that the Find and Replace dialog box displays the name of the document being searched in its title bar. For example, if you perform a Find and Replace on User Globals, Find and Replace User appears in the title bar.

### Backing up and Restoring Files

#### Backing up and Restoring Files

To help you manage your iFIX files, use the iFIX Backup and Restore feature. Access this feature through the Backup and Restore Wizard or from the command line. Command line parameters are available to automate backup or restore operations in scripting or external programs.

With this feature, you can backup your entire iFIX system or portions of it. You can later use these backed up files to restore your iFIX system, or specific parts of it. Additionally, you can restore your iFIX system to the factory default settings and files – a clean restore. This feature is helpful in configuring new computers with the same configuration, or in disaster recovery.
Overview of Files

A Custom Backup of iFIX includes a subset of the following files:

- SCU files
- Configuration files
- Pictures and Dynamo sets
- Process and alarm area databases
- I/O driver configuration files and exported databases
- Alarm files
- Historical configuration and data files
- Tag groups
- Application files
- Toolbars
- Schedules
- Global definition files and named colors
- Chart group wizard files
- Startup profiles
- FIX32 picture and key macro files
- Security files
- Master and control recipes

A Full Backup includes all of your iFIX files in the following folders:

- ALM path (*.*)
- APP path (*.*)
- HTR path (*.*)
- HTRDATA path (*.*)
- LOCAL path (*.*)
- PDB path (*.*)
- PIC path (*.*)
- RCC path (*.*)
- RCM path (*.*)

**IMPORTANT:** A Full Backup includes version dependent files. Do not restore a Full Backup from one version of iFIX to another version. Instead, use the Custom Backup option if you want to restore specific files from one version of iFIX to another.

Be aware that you can even backup and restore application files across multiple iFIX projects using the Project Path concept. For more information about modifying the project path, refer to the Best Practices for Managing Multiple iFIX Users section.
**IMPORTANT:**

- To backup and restore driver configuration files, you must add the driver in the SCU’s SCADA Configuration dialog box. To add the I/O driver, from the SCU Configure menu, click SCADA. In the I/O Driver Definition area, click the browse (...) button to select the I/O driver name, and then click Add.

- Be aware that configuration files for 7.x series drivers saved outside of the iFIX database directory will not be backed up with the Backup and Restore Wizard. If you installed iFIX to the default location, the path to the iFIX database directory is: C:\Program Files\Proficy\Proficy iFIX\PDB.

**Accessing the Backup and Restore Wizard**

To access the Backup and Restore wizard, click the Start button and point to Programs, Proficy HMI SCADA - iFIX, Tools, and then Backup and Restore Wizard. You can also access the application by locating and running the BackupRestore.exe file in the Proficy iFIX folder, which is the folder where you installed iFIX. If you want to restore files, you must shut down iFIX before running the Backup and Restore wizard. Otherwise, iFIX should be running.

The following figure shows the main screen that appears when you open the Backup and Restore Wizard.

![Backup and Restore Wizard](image)

**Overview of the Backup Process**

The Backup and Restore Wizard allows you to perform the following types of backup:

- **Custom Backup** – Allows you to select the specific files within the project path to backup.
- **Full Backup** – Archives all files, including security and INI files within the project path. This includes all files in the APP, HTR, HTRDATA, LOCAL, PDB, PIC, RCC, and RCM folders.
Understanding iFIX

- **Factory Default Backup** – Allows you to create a new factory default backup file. The Factory Default is a set of default iFIX files used to perform a clean restore. A standard FactoryDefault.IFD file is provided with the iFIX product. You can create a new, customized one, and save it under another name or the same name, using this option.

The steps below explain how to perform a backup with the Backup and Restore Wizard. For steps on how to use the command line, refer to the Using the Command Line Options section.

▶ **To perform a custom backup:**

1. In the Backup and Restore Wizard main screen, select the Custom Backup option.
2. Click the Backup button. The following figure appears.

![Proficy iFIX Backup Wizard](image)

3. Verify that the Backup Source Info is correct. For more information about modifying the project path, refer to the Best Practices for Managing Multiple iFIX Users section.
4. In the Backup File Option section, select the specific files or folders that you would like to back up.

5. Optionally, select the Include security files in archive option to backup all of your security files.

   NOTE: If the Backup and Restore wizard does not detect any security files in the project path, the Include security files in archive option does not appear.

6. Click the Next button.

7. Enter a backup file name and path into the field or browse to select one.

   NOTE: By default, this archive and path is C:\Program Files\Proficy\Proficy iFIX\ProjectBackup\nodename.FBK; however, you can specify any local path and file name. If you want to use a network path, you must use a mapped network drive. For instance, \MyServer\folder will not work, but a network drive mapped to Y:\folder (where Y:\ is the map to \MyServer) would work.

8. Click the Finish button to begin archiving your selected files.

To perform a full backup:

1. In the Backup and Restore Wizard main screen, select the Full Backup option.
2. Click the Backup button.
3. Enter a backup file path and filename into the field or browse to select one.

   NOTE: By default, this archive and path is C:\Program Files\Proficy\Proficy iFIX\ProjectBackup\nodename.FBK; however, you can specify any local path and file name. If you want to use a network path, you must use a mapped network drive. For instance, \MyServer\folder will not work, but a network drive mapped to Y:\folder (where Y:\ is the map to \MyServer) would work.

4. Click the Finish button to begin archiving all of your files.

To create a new factory default file:

1. Start the Backup and Restore Wizard with the /FactoryDefault option. For example:

   BackupRestore.exe /FactoryDefault

   Refer to the Using the Command Line Options section for more information on /FactoryDefault startup options.

2. In the Backup and Restore Wizard main screen, select the Factory Default option.

   NOTE: The Full Backup and Custom Backup options are unavailable when you start the Backup and Restore Wizard in Factory Default mode.

3. Click the Backup button. The following dialog box appears.
4. In the Backup File Option section, select the specific files or folders that you would like to back up.

   **NOTE:** The Include security files in archive option is not available for a Factory Default backup.

5. Click the Next button.

6. Enter a backup path and file name into the field, or browse to select one.

   **NOTE:** By default, this archive and path is `C:\Program Files\Proficy\Proficy iFIX\ProjectBackup\nodename.ifd`; however, you can specify any local path and any file name. Most likely, you will want to leave the original Factory Default file, and save the file under another name. If you want to use a network path, you must use a mapped network drive. For instance, `\MyServer\folder` will not work, but a network drive mapped to `Y:\folder` (where `Y:\` is the map to `\MyServer`) would work.

7. Click the Finish button to begin archiving your selected files.
Managing iFIX Nodes

TIP: If you enter a new name in step 7, you may want modify the [WizardSettings] section of BackupRestore.ini file to point this custom Factory Default file. For more information, refer to the Using and Creating FactoryDefault Files and the Sample BackupRestore.ini sections.

Overview of the Restore Process

You can restore your archived files to any computer that has iFIX installed. Prior to restoring the files, you can select the individual types of files you want to restore or you can restore the entire archive.

The Backup and Restore Wizard includes the following restore features:

- Ability to select a specified destination for the restored files, as well as the individual files you want to restore.
- Ability to delete all existing files under a target project path before performing a restore. This action removes any existing application files in the destination paths, with the exception of the security files.
- Ability to restore the iFIX factory defaults of your original install before restoring the backup files.
- Option to retain the current SCU security settings for the restore, replace the SCU settings with the ones in the archive, or create a new project requiring the input of a new project folder to complete the restore.

The steps below explain how to perform a restore with the Backup and Restore Wizard. For steps on how to use the command line, refer to the Using the Command Line Options section.

To restore an archive:

1. In the Backup and Restore Wizard main screen, select the Restore button.
2. On the first page of the wizard, enter the backup file name to restore or click browse to select one.
   By default, backup files are stored in the C:\Program Files\Proficy\Proficy iFIX\ProjectBackup folder.
3. Click Next to continue. The following dialog box appears, allowing you to select the appropriate restore options.
iFIX Restore Wizard

4. Select the required options and click Finish.

To restore a factory default file:

1. Start the Backup and Restore Wizard with the /FactoryDefault command line option. For example:

   `BackupRestore.exe /FactoryDefault`

   Refer to the Using the Command Line Options section for more information on /FactoryDefault startup options.

2. In the Backup and Restore Wizard main screen, select the Restore button.

3. On the first page of the wizard, enter the file name of the factory default backup or click browse to select one.

   To restore iFIX with the standard factory defaults, select the FactoryDefault.IFD file. If you installed iFIX to the default location, you can find this file in the C:\Program Files\Proficy\Proficy iFIX folder.

4. Click Next to continue.

5. Select the required options and click Finish.

Restore Destination Options

The Restore Destination Options allow you to select whether you restore the files to the current project path, the project path specified in the archived SCU, or into a separate new project path. The Create New Project option does not modify the existing SCU settings.
Managing iFIX Nodes

If you select to use the SCU file from the archive, this overwrites the SCU file on the target computer. Typically, you would only want to overwrite an SCU file if the target computer does not have an SCU file, or if you want to restore the target computer to its previous state.

If you choose to overwrite an existing SCU file, be sure to verify that the computer's hardware key supports all of the enabled SCU options and the software for these options is installed. For example, if SCADA support is enabled, verify that the hardware key has SCADA support and that the SCADA software is installed on the target node. You should also verify that the path for each start-up task, listed in the Task Configuration dialog box, is correct.

You can modify the node name and project path stored in the archived SCU file when you select to overwrite the existing SCU file. The Node field defines the node name stored in the archived SCU file; the Project Path field defines the project path.

When the restoration process begins, the wizard reads the text in the Node and Project Path fields to determine where to restore the files you selected. Next, the wizard restores the files using the relative paths stored in the selected SCU file. The wizard creates any non-existent paths.

**NOTE:** If multiple SCU files exist in the archive when you are restoring files, iFIX copies all existing SCU files to the Local path. The SCU file that was in use continues to be used by the system.

If you choose to Create a New Project, files are restored to a new project path with a default sub-project path. To modify the default sub-project paths, refer to the BackupRestore.ini or user-specified .INI file.

Optionally, once you have restored the file, you can create a new SCU file and point to these new paths.

**Destination Info**

The Destination Info section of the Restore screen displays the SCU file, node, and project path that the archive will be restored to. To display the configured paths for the restored files within the project, click the View Project Path Configuration button. The configured paths are determined by the destination option you selected. If you selected:

- **Use the current SCU** – the paths are determined by the SCU file currently loaded.

- **Use SCU from archive** – the paths are determined by the SCU file in the archive. You can modify the node name and project path. Sub-project paths are determined by the SCU file in the archive and cannot be modified.

- **Create a new project** – the project path is determined by user input. Sub-project paths are determined by the .INI file settings. Refer to the BackupRestore.ini file for more information.

**Restore File Options**

To perform a clean restore, the Backup and Restore wizard allows you to delete all existing files or to restore default iFIX files before restoring the archive.

Select the Delete all existing files under target project path before the restore option to delete all existing files before restoring a Custom or Full backup file. This option will not delete existing security files or the current SCU file loaded in local startup.
Understanding iFIX

Select the Restore default iFIX files before restoring your backup files option to return the files to their default state before performing a restore. For Custom and Full restores, the default iFIX files are restored from the FactoryDefault file.

To modify the default settings, modify the FactoryDefault definitions in the BackupRestore.ini file. For more information, refer to the BackupRestore.ini file.

Security File Option

If the Restore Wizard locates any security files in the archive that you are restoring, you can select from the following options:

- **Leave the current security settings alone** – Select this option to maintain the current security settings and ignore security overwrites in the backup files during the restore.

- **Replace existing security files with archived files** – Select this option to replace the current security settings with the security settings in the archived files.

- **Delete all existing security files and disable security** – Select this option to delete all existing security files from the current iFIX system and disable security upon restore. This option also displays the current status of security (Enabled or Disabled). If you select this option, ensure that the Restore default iFIX files before restoring your backup files option is also selected to use the active iFIX project.

The restore destination for security files is determined by the presence of security files in the current iFIX system and the archive. The following table shows the sample configurations and the determined destination:

<table>
<thead>
<tr>
<th></th>
<th>Are security files present in current iFIX configuration?</th>
<th>Are security files present in archive?</th>
<th>Destination of restored security files:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>No</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>No</td>
<td>node.dov</td>
<td>Target local path</td>
</tr>
<tr>
<td>3</td>
<td>No</td>
<td>Display.dov</td>
<td>Target local path</td>
</tr>
<tr>
<td>4</td>
<td>node.dov</td>
<td>node.dov</td>
<td>Target local path</td>
</tr>
<tr>
<td>5</td>
<td>node.dov</td>
<td>Display.dov</td>
<td>Target local path</td>
</tr>
<tr>
<td>6</td>
<td>Display.dov</td>
<td>node.dov</td>
<td>Target local path</td>
</tr>
<tr>
<td>7</td>
<td>Display.dov</td>
<td>Display.dov</td>
<td>Current global security path</td>
</tr>
</tbody>
</table>
NOTE: In the previous table, node.dov denotes that local security settings related to a single project are found. Display.dov denotes that global security settings are found.

In the 2nd and 3rd configurations shown in the table, the security files are restored to the target local path. The user receives no warning message.

In the 4th and 5th configurations, the security files are also restored to the target local path. A warning message displays the current security path and the new security path. As node.dov relates to a specific single project, if the current path is not equal to the target path, the existing security settings remain and the archived security settings are restored to a new project path. If the current path is equal to the target path, the existing security files are deleted and then the archive is restored.

In the 6th configuration, the global security settings are removed and the security files are restored to the target local path. A warning message appears displaying the current security path and the new security path.

In the 7th configuration, security files are restored to the current global security path. A warning message displays, alerting the user that the current security path is the same as the new security path and will be overwritten.

Restore File Selection

Once you select the appropriate restore options, select which specific files you would like to restore to the project path. If you would like to restore all files, select the Restore the entire system check box.

Using the Command Line Options

You can also run the Backup and Restore utility from the command line. This is especially useful if you want to automate the backup and restore operations through scripting or external programs.

The syntax for the BackupRestore.exe command line is as follows:

Syntax for Backup

    BackupRestore.exe
    [/FactoryDefault]
    /B=<file name with full path>
    [/F]
    [/P=<project path> or /P=UseINI]
    [/BackupSec]
    [/S or /Y]
    [/I=<ini file name>]

Syntax for Restore

    BackupRestore.exe
    [/FactoryDefault]
Understanding iFIX

/R=<file name with full path>

[/A]

[/A=<project path> [/N=<node name>] [/X]]

[/P=<project path> or /P=UseINI]]

[/C]

[/RestoreSec] or [/DelSec]]

[/S or /Y]

[/I=<ini file name>]

Notes on the Syntax

- The brackets ( [ ] ) indicate that a parameter is optional. The brackets are not part of a command; if a bracketed option is desired, type only the text that is inside the brackets, and not the brackets themselves.

- Italics are used to represent the information that the user must supply to run the command. The information in italics is not typed exactly as it appears. Instead, the user enters the information specific to the italicized expression.

The following table lists the command line options available for BackupRestore.exe.

<table>
<thead>
<tr>
<th>Command Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/F</td>
<td>Specifies a Full Backup of all files within a project path, including security files.</td>
</tr>
<tr>
<td>/FactroyDefault</td>
<td>Performs a factory default backup or restore.</td>
</tr>
<tr>
<td>/P</td>
<td>Specifies the source project path for the Backup or the destination project path for the restore.</td>
</tr>
<tr>
<td>/P=UseINI</td>
<td>Specifies the source project path for the Backup or the destination project path for the Restore. Allows you to specify the full path for all sub-project paths within the INI file settings.</td>
</tr>
<tr>
<td>/A</td>
<td>Uses the archived SCU file to determine the destination project path of the Restore.</td>
</tr>
<tr>
<td>/A=&lt;project path&gt;</td>
<td>Specifies the destination project path for the Restore, and sets it to the extracted SCU file.</td>
</tr>
</tbody>
</table>
### Available Command Options

<table>
<thead>
<tr>
<th>Command Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/N=&lt;nodeName&gt;</td>
<td>Specifies the node name of the node you want to restore. Used with the /A option.</td>
</tr>
<tr>
<td>/X</td>
<td>Specifies that you do not want to rename the current node name with the name of the restored node. Used with the /A option.</td>
</tr>
<tr>
<td>/C</td>
<td>Deletes all existing files under the selected project path before restoring a Custom or Full Backup file.</td>
</tr>
<tr>
<td>/BackupSec</td>
<td>Includes security files in the backup.</td>
</tr>
<tr>
<td>/RestoreSec</td>
<td>Replaces the current security settings with the security settings in the archived files during the restore.</td>
</tr>
<tr>
<td>/DelSec</td>
<td>Deletes all existing security files and disables security upon restore.</td>
</tr>
<tr>
<td>/S</td>
<td>Runs the Backup or Restore project in silent mode, with no progress bar or user prompt.</td>
</tr>
<tr>
<td>/Y</td>
<td>Automates the user prompt and displays the progress bar while the backup or restore runs in silent mode.</td>
</tr>
<tr>
<td>/I</td>
<td>Specifies an .INI file and path, if you want to use an .INI file other than the BackupRestore.ini file. By default, Backup and Restore reads the BackupRestore.ini file in the Local folder. By using the /I command, you can specify another .INI file name. The format must be the same as the BackupRestore.ini file however. Refer to the Sample BackupRestore.ini section for more information.</td>
</tr>
<tr>
<td>/?</td>
<td>Opens the Help for the command line options.</td>
</tr>
</tbody>
</table>

**NOTE:** If you do not define the /P option while running a Backup, the source path is taken from the current SCU setting. If you do not define the /P or /A option while running a Restore, the destination is the current SCU setting.

### Examples

This command performs a custom backup silently including security files, without displaying the Backup and Restore Wizard:
Understanding iFIX

BackupRestore.exe /B="C:\Program Files\Proficy\Proficy iFIX\ProjectBackup\FIX.fbk" /S /BackupSec

This command performs a project restore to the current project path silently, without displaying the Backup and Restore Wizard:

BackupRestore.exe /R="C:\Program Files\Proficy\Proficy iFIX\ProjectBackup\FIX.fbk" /S /RestoreSec

This command performs a project restore to the project path archived in the SCU, and shows a progress bar for restore process:

BackupRestore.exe /R="C:\Program Files\Proficy\Proficy iFIX\ProjectBackup\FIX.fbk" /A /Y

**NOTE:** When including the /A command, you may need to review the SCU to see if the base path has changed.

This command performs a factory default backup, without displaying the Backup and Restore Wizard:

BackupRestore.exe /FactoryDefault /B="C:\Program Files\Proficy\Proficy iFIX\ProjectBackup\FIX.ifd" /S

This command performs a factory default restore, without displaying the Backup and Restore Wizard:

BackupRestore.exe /FactoryDefault /R="C:\Program Files\Proficy\Proficy iFIX\ProjectBackup\FIX.ifd" /S

**Return Code**

The Backup and Restore application returns the following exit codes after it runs.

<table>
<thead>
<tr>
<th>Exit Code</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0         | Backup or Restore action completed without errors.  
When you run the user interface for the Backup and Restore, instead of using the command line, the exit code also will be 0. |
| 1         | Backup or Restore action aborted with an error. This usually indicates that the error occurred during the action. For example: a backup file was unable to be opened, a backup file is corrupted, or security settings could not be adjusted. |
| 2         | Backup or Restore action unable to start, for any reason. For example: an invalid command was detected, or a specified file was not found.  
Also, when you run the BackupRestore.exe /? help command, the exit code is 2. |

When the BackupRestore.exe program returns a 1 or 2, the action failed. If an error is detected before an action log file opens, these errors are recorded in the BackupRestoreDefaultLog.txt file. By default, this file is located in the iFIX base path. If you installed iFIX to the default location, then the base path is the C:\Program Files\Proficy\Proficy iFIX folder.
If a 1 or 2 is returned, look to the BackupRestoreDefaultLog.txt first for details on the error. If there is no information there, then look at actual action log (BackupLog.txt or RestoreLog.txt).

Be aware that the BackupRestoreDefaultLog.txt log also contains full command line parameter information and the time when the BackupRestore.exe program started.

**Using and Creating Factory Default Files**

The Factory Default is a set of default iFIX files used to perform a clean restore. A standard FactoryDefault.IFD file is provided with the iFIX product. The FactoryDefault.IFD file also includes your FIX Desktop files. Refer to the Files Included in the FactoryDefault Backup File section below for a list of files included in the standard .IFD file.

**NOTE:** Be aware that if you later install an iFIX SIM as a product update, and that SIM contains updated iFIX factory default files, the SIM installer prompts you to update the original FactoryDefault.IFD file as a part of the SIM installation.

You can also create your own Factory Default file, with the .IFD file extension, to include custom toolbars, custom Dynamo objects, application specific picture templates, or user specific .INI settings. To do this, you use the Factory Default command line option for the Backup and Restore application. You can overwrite the original FactoryDefault.IFD file, or create a new one. Most likely, you will want to leave the original Factory Default file, and save the file under another name.

**IMPORTANT:**

- **Be aware that whatever files are included in the FactoryDefault.IFD file are also used in the restore process, by default, when you select the Restore default iFIX files before restoring your backup files check box in the iFIX Restore Wizard. If you overwrite the original FactoryDefault.IFD file, you change the files that get restored when that check box is selected. Use caution when overwriting the original FactoryDefault.IFD file.**

- **If you want this check box to reference another Factory Default file, modify the [WizardSettings] section of BackupRestore.ini file. On the FACTORYDEFAULT=FactoryDefault.IFD, replace FactoryDefault.IFD with the name of your new factory default file. For more information on the BackupRestore.ini file, refer to the Sample BackupRestore.ini file section.**

To create a Factory Default backup file, type the following at the command line and press ENTER:

```
BackupRestore.exe /FactoryDefault
```

This command starts the Backup and Restore application with the Create New Factory Default file option enabled.

To restore the files in a Factory Default file, use the same command line option:

```
BackupRestore.exe /FactoryDefault
```

When the /FactoryDefault option is specified, the Backup and Restore Wizard appears with the Custom and Full Backup buttons unavailable, as shown in the following figure. To create a new Factory Default file, click the Project Backup button to open the Project Backup Wizard. To restore a Factory Default file, click the Project Restore button to open the Project Restore Wizard.
For more information on using Command Line options, refer to Using the Command Line Options section.

**Files Included in the Factory Default Backup File**

The following is a list of files included in the FactoryDefault.IFD file provided with the iFIX product. If you select the Restore default iFIX files before restoring your backup files option during a restore, these files will be restored to your system before the archive is restored.

**IMPORTANT:** Be aware that if you later install an iFIX SIM as a product update, and that SIM contains updated iFIX factory default files, the SIM installer prompts you to update the original FactoryDefault.IFD file as a part of SIM the installation.

The FactoryDefault.IFD file includes the following files:

**ALM Files**

None

**APP Files**

APP\BuildDynamoInstall.grf
APP\ChartGroupInstall.grf
APP\iDetective.tbx
APP\sqlerr.txt

**HTR Files**

HTR\ChartGroup1.csv
HTR\ChartGroup2.csv
HTR\ChartGroup3.csv
Managing iFIX Nodes

HTRDATA Files
None

Local Files
LOCAL\alarm.ini
LOCAL\AnimationTasks.tbc
LOCAL\Applications.tbc
LOCAL\ApplicationToolbar.tbx
LOCAL\ApplicationToolbar.xbt
LOCAL\Association.dat
LOCAL\BackupRestore.ini
LOCAL\BuildDynamo.bmp
LOCAL\CADToolbar.tbx
LOCAL\CADToolbar.xbt
LOCAL\CADTools.tbc
LOCAL\ChartGroups.tbc
LOCAL\ChartGroupToolbar.tbx
LOCAL\ChartGroupToolbar.xbt
LOCAL\CommandTasks.tbc
LOCAL\CreateObjects.tbc
LOCAL\CrossReference.ini
LOCAL\CustomButton1.bmp
LOCAL\CustomButton10.bmp
LOCAL\CustomButton2.bmp
LOCAL\CustomButton3.bmp
LOCAL\CustomButton4.bmp
LOCAL\CustomButton5.bmp
LOCAL\CustomButton6.bmp
LOCAL\CustomButton7.bmp
LOCAL\CustomButton8.bmp
LOCAL\CustomButton9.bmp
LOCAL\databasemanager.ini
LOCAL\DatabaseTasks.tbc
LOCAL\DataEntryTasks.tbc
LOCAL\ddeclnt.ini
LOCAL\default.fmt
LOCAL\default qry
LOCAL\default.rft
LOCAL\default.srt
LOCAL\draw.ini
LOCAL\dwnarrow.ico
LOCAL\dwndwarrow.ico
LOCAL\DynamoToolbar.tbx
LOCAL\DynamoToolbar.xbt
LOCAL\DynamoTools.tbc
LOCAL\Edit.tbx
LOCAL\Edit.xbt
LOCAL\Experts.tbx
LOCAL\Experts.xbt
LOCAL\filterederrors.ini
LOCAL\FindReplace.csv
LOCAL\fix.ini
LOCAL\FixGraphicConnectionObjects.tbx
LOCAL\FixGraphicConnectionObjects.xbt
LOCAL\fixodbc.ini
LOCAL\FixUserPreferences.ini
LOCAL\FormatObjects.tbc
LOCAL\GraphicConnections.tbc
LOCAL\Horn.ico
LOCAL\htd.ini
LOCAL\iFixScreenSaver.bmp
LOCAL\iFIXSysMgmt.ini
LOCAL\ImportToolbars.txt
LOCAL\logmsg.tov
LOCAL\NoHorn.ico
Managing iFIX Nodes

LOCAL\PictureExporter.tbc
LOCAL\PictureTasks.tbc
LOCAL\ProficyHistorian.tbx
LOCAL\ProficyHistorian.xbt
LOCAL\ProficyHistorianCat.tbc
LOCAL\ReportTasks.tbc
LOCAL\RestoreLog.txt
LOCAL\Ribbon.ini
LOCAL\SCADASync.ini
LOCAL\Scheduler.tbc
LOCAL\SECNET.ini
LOCAL\SetupComServerApp.ini
LOCAL\Shapes.tbx
LOCAL\Shapes.xbt
LOCAL\Standard.tbc
LOCAL\StandardCategories.txt
LOCAL\StandardToolbars.ini
LOCAL\StandardToolbar.tbx
LOCAL\StandardToolbar.xbt
LOCAL\SystemTree.csv
LOCAL\Toolbox.tbx
LOCAL\Toolbox.xbt
LOCAL\Tools.tbx
LOCAL\Tools.xbt
LOCAL\TranslationToolbar.tbx
LOCAL\TranslationToolbar.xbt
LOCAL\uparrow.ico
LOCAL\upuparrow.ico
LOCAL\Utilities.tbx
LOCAL\Utilities.xbt
LOCAL\view.ini
LOCAL\VisiconXControls.tbc
Understanding iFIX

LOCAL\VisiconXToolbar.tbx
LOCAL\VisiconXToolbar.xbt

**PDB Files**
PDB\aa61.tbl
PDB\ai61.tbl
PDB\ao61.tbl
PDB\ar61.tbl
PDB\bb61.tbl
PDB\bl61.tbl
PDB\ca61.tbl
PDB\CGW.csv
PDB\da61.tbl
PDB\dc61.tbl
PDB\Default.SM2
PDB\di61.tbl
PDB\do61.tbl
PDB\dr61.tbl
PDB\dt61.tbl
PDB\empty.pdb
PDB\etr61.tbl
PDB\etr73.tbl
PDB\ev61.tbl
PDB\fn61.tbl
PDB\hs61.tbl
PDB\ll61.tbl
PDB\mdi61.tbl
PDB\pa61.tbl
PDB\pg61.tbl
PDB\pid61.tbl
PDB\rb61.tbl
PDB\rm61.tbl
PDB\sc61.tbl
Managing iFIX Nodes

PDB\sd61.tbl
PDB\sqd61.tbl
PDB\sqt61.tbl
PDB\ss61.tbl
PDB\tm61.tbl
PDB\tr61.tbl
PDB\tt61.tbl
PDB\tx61.tbl

**PIC Files**

PIC\TagStatus
PIC\3D_TEXT.SBL
PIC\aa.bdf
PIC\ai.bdf
PIC\ao.bdf
PIC\ar.bdf
PIC\bb.bdf
PIC\bl.bdf
PIC\BORDERS.SBL
PIC\BUNGEE.odt
PIC\BUNGEE.SVA
PIC\BUNGEE.VGA
PIC\BUTTONS.SBL
PIC\ca.bdf
PIC\ChartGroupDemo.grf
PIC\CHARTS1!.SBL
PIC\CHARTS2!.SBL
PIC\CHARTS3!.SBL
PIC\CHARTS4!.SBL
PIC\CHKBOX!.SBL
PIC\CHKBOX2!.SBL
PIC\da.bdf
PIC\di.bdf
Understanding iFIX

PIC\do.bdf
PIC\dr.bdf
PIC\draw.kmx
PIC\dt.bdf
PIC\DTALK1!.SBL
PIC\DTALK2!.SBL
PIC\etr.bdf
PIC\ev.bdf
PIC\EmergencyStopButtons.fds
PIC\ExpertGlobal.fxg
PIC\ExpertGlobals2.fxg
PIC\FACEPLT!.SBL
PIC\FactoryGlobals.fxg
PIC\fn.bdf
PIC\FREEFALL.odt
PIC\FREEFALL.SVA
PIC\FREEFALL.VGA
PIC\GaugesHorizontalLarge.fds
PIC\GaugesHorizontalMedium.fds
PIC\GaugesHorizontalSmall.fds
PIC\GaugesRoundLarge.fds
PIC\GaugesRoundMedium.fds
PIC\GaugesRoundSmall.fds
PIC\GaugesVerticalLarge.fds
PIC\GaugesVerticalMedium.fds
PIC\GaugesVerticalSmall.fds
PIC\HANGTEN.odt
PIC\HANGTEN.SVA
PIC\HANGTEN.VGA
PIC\Historical.fds
PIC\HistoricalLineChart.fds
PIC\hs.bdf
Managing iFIX Nodes

PIC\INLINE.odt
PIC\INLINE.SVA
PIC\INLINE.VGA
PIC\ISA-S55A.SBL
PIC\ISA-S55B.SBL
PIC\ISA-S55C.SBL
PIC\ISA-S55D.SBL
PIC\ISA-Y32A.SBL
PIC\ISA-Y32B.SBL
PIC\ISA-Y32C.SBL
PIC\ISA-Y32D.SBL
PIC\ISA-Y32E.SBL
PIC\ISA-Y32F.SBL
PIC\ISA-Y32G.SBL
PIC\ISA-Y32H.SBL
PIC\ISA-Y32I.SBL
PIC\KEYPAD!.SBL
PIC\ll.bdf
PIC\LocalAsBackup.grf
PIC\LocalAsPrimary.grf
PIC\LUGE.odt
PIC\LUGE.SVA
PIC\LUGE.VGA
PIC\mdi.bdf
PIC\METERS!.SBL
PIC\METERS2!.SBL
PIC\Miscellaneous.fds
PIC\MOTORS!.SBL
PIC\Motors.fds
PIC\MOTORS.SBL
PIC\NetworkStatusDisplay.grf
PIC\NetworkStatusOverview.grf
Managing iFIX Nodes

PIC\RADIO2!.SBL
PIC\rb.bdf
PIC\rm.bdf
PIC\ROWSERS.SBL
PIC\RUNTASK!.SBL
PIC\sc.bdf
PIC\sd.bdf
PIC\Shades Of Blue.ftb
PIC\Shades Of Cyan.ftb
PIC\Shades Of Gray.ftb
PIC\Shades Of Green.ftb
PIC\Shades Of Magenta.ftb
PIC\Shades Of Red.ftb
PIC\Shades Of Yellow.ftb
PIC\SHAPES.SBL
PIC\SLIDERS!.SBL
PIC\SPIKE.odt
PIC\SPIKE.SVA
PIC\SPIKE.VGA
PIC\sqd.bdf
PIC\sqt.bdf
PIC\StorageTanksLarge.fds
PIC\StorageTanksAnim.fds
PIC\ss.bdf
PIC\SwitchesLarge.fds
PIC\SwitchesMedium.fds
PIC\SwitchesSmall.fds
PIC\System Default.ftb
PIC\SYSTEM!.SBL
PIC\TANKS!.SBL
PIC\Tanks.fds
PIC\TANKS.SBL
Understanding iFIX

PIC\TanksAnim1.fds
PIC\TanksAnim2.fds
PIC\TICMARKS.SBL
PIC\tm.bdf
PIC\tr.bdf
PIC\tt.bdf
PIC\tx.bdf
PIC\UpDownButtons.fds
PIC\VALVES!.SBL
PIC\Valves.fds
PIC\VALVES.SBL
PIC\ValvesAnim.fds
PIC\ValvesISAHorizLarge.fds
PIC\ValvesISAHorizSmall.fds
PIC\ValvesISAVertLarge.fds
PIC\ValvesISAVertSmall.fds
PIC\VBARS!.SBL
PIC\view.kmx
PIC\WizLayouts.tpl
PIC\TagStatus\Aa_TS.Grf
PIC\TagStatus\AI_TS.grf
PIC\TagStatus\AO_TS.Grf
PIC\TagStatus\Ar_TS.Grf
PIC\TagStatus\Bb_TS.Grf
PIC\TagStatus\Bl_TS.Grf
PIC\TagStatus\Ca_TS.Grf
PIC\TagStatus\Da_TS.Grf
PIC\TagStatus\DI_TS.Grf
PIC\TagStatus\Do_TS.Grf
PIC\TagStatus\Dr_TS.Grf
PIC\TagStatus\Dt_TS.Grf
PIC\TagStatus\Etr_TS.grf
Managing iFIX Nodes

```
PIC\TagStatus\Ev_TS.Grf
PIC\TagStatus\Fn_TS.Grf
PIC\TagStatus\Hs_TS.Grf
PIC\TagStatus\Ll_TS.Grf
PIC\TagStatus\Mdi_TS.grf
PIC\TagStatus\Pa_TS.Grf
PIC\TagStatus\Pg_TS.Grf
PIC\TagStatus\Pid_TS.grf
PIC\TagStatus\QuickTrend.grf
PIC\TagStatus\Rb_TS.Grf
PIC\TagStatus\Rm_TS.Grf
PIC\TagStatus\Sc_TS.Grf
PIC\TagStatus\Sd_TS.Grf
PIC\TagStatus\Sqd_TS.grf
PIC\TagStatus\Sqt_TS.grf
PIC\TagStatus\Ss_TS.Grf
PIC\TagStatus\TagControlPanel.grf
PIC\TagStatus\Tm_TS.Grf
PIC\TagStatus\Tr_TS.Grf
PIC\TagStatus\TS.ini
PIC\TagStatus\Tt_TS.Grf
PIC\TagStatus\Tx_TS.Grf
```

**RCC Files**
None

**RCM Files**
None

**Sample BackupRestore.ini**

Use the BackupRestore.ini to specify default and custom settings that appear in the Backup and Restore Wizard, and when you run BackupRestore.exe from a command line. The BackupRestore.ini file is located in the iFIX LOCAL folder. If you installed iFIX to the default location, you can find the BackupRestore.ini in the C:\Program Files\Proficy\Proficy iFIX\LOCAL folder.

The BackupRestore.ini file can contain information in the following sections:
Understanding iFIX

- **[Version]** – used to determine iFIX product version in archive header signature. This section is required. Do not change this value.

- **[DefaultSubProject]** – used to determine default sub-project paths for the Create New Project option in the Restore operation.

- **[FactoryDefaultExtension]** – used to determine which files are included in Factory Default settings.

- **[WizardSettings]** – used to determine file name and path (if it is different than your iFIX base path) of the Factory Default file when you select the "Restore default iFIX files before restoring your backup files" option during a Restore operation.

- **[AddCustomExtension]** – used if you want to include or exclude any additional files or file types in your custom backup. By default, the AddExtension feature is set to False. Set AddExtension to True to enable this feature. Each category has keys to include (xxxIncludeExtn=) and exclude (xxxxExcludeExtn=) files. The xxxxExcludeExtn key is used to exclude files from xxxxIncludeExtn key, not to exclude a default extension.

  The entire key can be up to 2048 characters long, in total. If you exceed this length, for instance if the path is too long, an error message appears and the custom file or file extension is ignored when you attempt the backup.

  **IMPORTANT:** Make sure that you do not include the same file or file extension (from the same location) in more than one category. If you back up the same file or file type in more than one category, you will experience issues restoring your files. Configure your custom settings carefully.

By default, the Backup and Restore application references the BackupRestore.ini file when it runs. If you want to change the name of the .INI file, you must run BackupRestore.exe with the /i command line option, and specify the file name of the custom .INI file. If you create a custom .INI file, it must follow the same format described above.

The following is an example of the BackupRestore.ini that includes all four of the sections defined above:

```ini
[Version]
Version=4.00

[DefaultSubProject]
LOCPATH=LOCAL
PDBPATH=PDB
NLSPATH=NLS
PICPATH=PIC
APPPATH=APP
HTCPATH=HTR
HTDPATH=HTRDATA
HTRDATA=HTRDATA
ALMPATH=ALM
RCMPATH=RCM
```
RCCPATH=RCC
AADDPATH=PDB
AADBPATH=PDB

[FactoryDefaultExtension]
ALM_EXTN=.*
APP_EXTN=*.grf,*.tbx,sqlerr.txt
HTR_EXTN=*.csv
HTRDATA_EXTN=.*
LOCAL_EXTN=Association.dat,default.fmt,FindReplace.csv,SystemTree.csv,default.qry,default.rft,default.srt,logmsg.tov,StandardCategories.txt,*.txb,*.xbl,*.ico,*.bmp,*.ini
PDB_EXTN=CGW.csv,Default.SM2,FIX.sm2,empty.pdb,*.tbl
PIC_EXTN=WizLayouts.tpl,*.fds,*.ftb,*.fxg,*.grf,*.SBL,*.BDF,*.odt,*.SVA,*.VGA,*.kdx,*.CSV,TS.ini
RCC_EXTN=.*
RCM_EXTN=.*

[WizardSettings]
FACTORYDEFAULT=FactoryDefault.IFD
FACTORYDEFAULT_PATH=

[AddCustomExtension]
AddExtension=FALSE

; Configuration files (*.SCU,*.INI,*.CFG), LOCPATH
SCUIncludeExtn=
SCUExcludeExtn=

; Picture files (*.GRF,*.FDS,*.FTB,*.LST), PICPATH
PicIncludeExtn=
PicExcludeExtn=

; Database files (*.PDB,*.AAD), PDBPATH
PDBIncludeExtn=
PDBExcludeExtn=
;Database ASCII files (*.GDB), PDBPATH
GDBIncludeExtn=
GDBExcludeExtn=
;
;Driver Configuration Binary files (*._*), PDBPATH
DrvIncludeExtn=
DrvExcludeExtn=
;
;Database/Driver CSV files (*.CSV), PDBPATH
DBCSVIncludeExtn=
DBCSVExcludeExtn=
;
;Historical Config files (.CFG,.HGP,.DAT), HTCPATH
HistConfigIncludeExtn=
HistConfigExcludeExtn=
;
;Tag Group files (*.TGD,.TGS,.TGE), PICPATH
TagGroupIncludeExtn=
TagGroupExcludeExtn=
;
;Recipe Control files (*.RCC,.RCY), RCCPATH
RCPIncludeExtn=
RCPEcludeExtn=
;
;Master Recipe files (*.RCM,.RCX), RCMPATH
RCMIncludeExtn=
RCMExcludeExtn=
;
;Application files (*._*), APPPATH
APPIncludeExtn=
APPExcludeExtn=
;
Specifying a Proficy Batch Execution Project

If you have Proficy Batch Execution installed on your computer, you can configure the local node by specifying a name for the current project with the Proficy iFIX WorkSpace. In Proficy Batch Execution, a project is the entire set of files needed to deliver a batch solution. Typically, a project includes:

- Pictures
- An equipment database
- Recipes
- Configuration files
Understanding iFIX

However, a project can also include Word files, Excel spreadsheets, or documents from other OLE-compliant applications.

Associated with each Batch Execution project is an actual project file. This file stores project-related information. When you specify a project in iFIX, you are selecting the project file you want to open the next time the Proficy Batch Execution Server starts. As a result, you must restart the iFIX WorkSpace and then the Batch Execution Server to load the project you specify.
Using the Electronic Books

This section describes how to:

- Access electronic books from iFIX.
- Use the table of contents and the index for the document set, and the text and figures in the books themselves.
- Search for information across all iFIX books using the index or full-text search feature. Use Boolean, wildcard, and nested expressions for advanced full-text searches. You can also limit the full-text search to previous results, match similar words, or search topic titles only.
- Print individual topics from electronic books.
- Hide or show the frame that contains the Contents, Index, and Search tabs.
- Copy text and paste it into another application, such as Microsoft Word.
- Create a personalized list of favorite Help topics using the Favorites tab.

Accessing Information in Electronic Books

You can access the electronic books:

- In the WorkSpace tree, by double-clicking the Help and Information folder.
- On the Help menu in any iFIX application, by clicking Electronic Books.
- For WorkSpace and Database Manager only: In Ribbon view, from the Help list, located on the right, near the minimize button.
- By clicking the Start button, pointing to Programs, Proficy HMI SCADA - iFIX, and then Electronic Books.

You can display the Contents, Index, or Search navigation tools in the left frame by clicking the appropriate tab. Text and graphics in the electronic book appear in the frame on the right side of the screen. Initially, the collapsed table of contents is displayed in the left frame and the cover page is displayed in the right frame.

Electronic Book Buttons

The following buttons are displayed at the top of the electronic book window.
**Understanding iFIX**

**Electronic Book Toolbar Buttons**

- **Hide/Show** – Lets you toggle the display of the frame that contains the Contents, Index, and Search tabs.

- **Locate** – Displays the contents heading that corresponds to the current topic.

- **Back** – Displays the last topic that you accessed.

- **Forward** – Displays the next topic in a previously viewed sequence.

- **Stop** – Stops downloading file information if you are connected to the Internet.

- **Refresh** – Reloads the current file if you are connected to the Internet.

- **Print** – If the Contents tab is displayed, provides options for printing pages, headings, sub-topics, or the entire table of contents. If the Index or Search tab is displayed, allows you to print the current topic.

- **Options** – Displays menu commands that correspond to the electronic book toolbar buttons. It also allows you to toggle highlighting of search hits using the Highlighting Off/On command. After you select Highlighting Off, selecting Highlighting On takes effect beginning with the next topic you search for. (This feature is supported in Internet Explorer 4.0 and later.)

- **Help** – Displays information on how to use iFIX electronic books.

- **GlobalCare** – Opens the main support web page (http://www.ge-ip.com/support) if an Internet connection is available.

---

**Using the Table of Contents**

You can navigate through the electronic books using the tables of contents. The Contents tab appears on the top of the left frame.

From the Contents tab, you can:
Using the Electronic Books

- Double-click the book title to expand the table of contents and display section titles in the book. The closed book icon changes to an open book icon.
- Click the plus (+) icon to the left of a section title to display subsection titles within that section. A chapter or section is completely expanded when the minus (-) icon appears to the left of the title.
- Click a topic title to display that topic in the right frame.

You can fully expand the table of contents by right-clicking anywhere within the left frame and selecting Open All from the menu. Likewise, you can fully collapse the table of contents by right-clicking the left frame and selecting Close All from the menu.

The following figure shows a fully-expanded table of contents.

Searching Electronic Books

You can search for topics in the iFIX electronic books by using either the Index tab or the Search tab:

**Index** – Lets you search all iFIX books for topics by keyword. The index displays entries that match or begin with the keyword.

**Search** – Lets you search all iFIX electronic books for a specific text string. A list of all topics that contain that search string is displayed.
Understanding iFIX

To find a topic using the index:

1. Open the iFIX Electronic Books.
2. Click the Index tab to display the master index for the electronic books.
3. Enter the keyword for which you want to display topics. As you enter the word, the topic list scrolls to display the first topic that begins with or matches the keyword you entered.
4. Click Display to display the topic in the right frame, or double-click the topic.

To find a topic using full-text search:

1. Open the iFIX Electronic Books.
2. Click the Search tab to perform a search for a text string throughout all electronic books.
3. Enter the text for which you want to search. For more information, refer to the Refining Your Search section.
4. Click List Topics.
5. Select the topic that you want to display and click Display, or double-click the topic.

Refining Your Search

When you search for a word in the iFIX electronic books, you obtain a list of all topics in which that word appears. If you enter more than one word, every topic that includes all of the search words appears in the topics list. There are several ways to refine your search:

Using Quotes to Define a Phrase

Enclosing multiple words in quotes generates a list of topics in which that phrase appears.

For example, if you enter the search string:

database blocks

in the Search tab, the topics list includes all topics in which both words appear. The words can appear in any order anywhere in the topic text.

If you enter:

"database blocks"

enclosed in quotes, the topics list only includes those topics in which the exact phrase (or slight variations, such as database block) appears in the topic text.

NOTE: Be aware that if the text you search for contains the words AND, OR, NOT, or NEAR, you must surround the search phrase with quotes, or quotes surrounded by parentheses. Otherwise, these words will be treated as search operators, and the expected topic(s) will not be found in the search. For example, both of the following search strings should find the appropriate topics:

"items not supported"

("items not supported")
Searching with Wildcard Expressions

You can use the * symbol to search for multiple unknown characters in a word or phrase. You can also use the ? symbol for a single unknown character in a search. For example, the entry iW* would display iWebServer and iWebCast. The entry ?DO would display topics for both ADO and RDO.

Defining Search Terms

The AND, OR, NOT, and NEAR operators enable you to precisely define your search by creating a relationship between search terms.

Using Nested Expressions

Nested expressions allow you to create complex searches for information. For example, "control AND ((active OR opc) NEAR window)" finds topics containing the word "control" along with the words "active" and "window" close together, or containing "control" along with the words "opc" and "window" close together.

The basic rules for searching Help topics using nested expressions are as follows:

- You can use parentheses to nest expressions within a query. The expressions in parentheses are evaluated before the rest of the query.
- If a query does not contain a nested expression, it is evaluated from left to right. For example: "Control NOT active OR opc" finds topics containing the word "control" without the word "active," or topics containing the word "opc." On the other hand, "control NOT (active OR opc)" finds topics containing the word "control" without either of the words "active" or "opc."
- You cannot nest expressions more than five levels deep.

Using Other Searching Methods

There are three other options available for searches at the bottom of the search window that you can click. These options are as follows:

- **Search titles only:** Allows you to search for words in the titles of HTML files.
- **Match similar words:** Enables you to include minor grammatical variations for the phrase you search. For example, a search on the word "add" will find "add," "adds," and "added." This feature only locates variations of the word with common suffixes. For example, a search on the word "add" will find "added," but it will not find "additive."
- **Search previous results:** Enables you to narrow a search that results in too many topics found. You can search through your results list from a previous search by using this option. If you want to search through all of the files in a Help system, this check box must be cleared.

Determining Your Location within the Electronic Books

When you select a topic from the Search tab or from the Index tab, the topic appears in the right frame while the left frame continues to display either the search results or the Index. You can see the relative position of the topic within the table of contents by clicking the Click to Show Browse Buttons... link, and then clicking the Locate button from the electronic books toolbar.
If you have the Contents tab displayed, the title of the current topic is highlighted in the table of contents as you browse through the book.

---

**Printing Electronic Books**

The steps that follow describe how to print from the electronic books.

- **To print a single section:**
  1. Select the topic that you want to print.
  2. Click Print.
  3. Click Print the Current Page to print the selected topic.
  4. Select the printer and printer options, if necessary.

- **To print a topic from the Search or Index tab:**
  1. Select the topic or sub-topic from the list.
  2. Click Print.
  3. Select the printer and printer options, if necessary.

*NOTE:* If you want to print an entire book or large sections of a book, use the associated .PDF file and print from Acrobat Reader. Contact your Support representative for more information on obtaining .PDF files.

---

**Displaying or Hiding the Left Frame**

You can choose whether or not to display the left frame, which contains the Contents, Index, and Search tabs. To hide the left frame, click Hide. To show the left frame, click Show.

---

**Copying and Pasting Text from an Electronic Book to Another Application**

You can copy all or part of any topic in an electronic book and paste it into any application that accepts text from the clipboard. For example, you may want to copy an example from the Writing Scripts manual and paste it directly into the Visual Basic Editor.

- **To copy selected text in a topic:**
  1. Display the topic from which you want to copy text.
  2. Highlight the text that you want to copy.
  3. Press CTRL+C, or right-click the highlighted text and select Copy.
  4. Paste the text into another application, such as Word.
To copy all of the text in a topic:

1. Display the topic from which you want to copy text.
2. Press CTRL+A, or right-click anywhere within the right frame and select Select All.
3. Press CTRL+C, or right-click the highlighted text and select Copy.
4. Paste the text into another application, such as Word.

*NOTE:* You cannot copy graphics from an electronic book.

Using the Favorites Tab

The steps below explain how to add links to the Favorites tab in HTML Help.

To create a list of favorite Help topics:

1. Locate the Help topic you want to make a favorite topic.
2. Click the Favorites tab, and then click Add.

*NOTES*

- To return to a favorite topic, click the Favorites tab, select the topic, and then click Display.
- If you want to rename a topic, select the topic, and then type a new name in the Current topic box.
- To remove a favorite topic, select the topic and then click Remove.
Using the iFIX Sample System

iFIX includes a Sample System which consists of four industry demos: Water & Wastewater, Chemical, Discrete, and Pharmaceutical manufacturing. The Sample System demonstrates the power and flexibility of iFIX, while providing a learning tool for new users. You can dissect and study these demos to assist you as you create your own applications.

All animations and controls in the Sample System are driven by the real-time process database using the simulation driver that comes with every installation of iFIX. This driver provides several test signals, including a ramp, sine wave, and I/O addresses that you can use to simulate pump and motor control, sequencing, and so forth. None of the animations are driven by scripts or code. Every object, picture, tool, and function in the system was developed using the tools included on your iFIX DVD, including the context-sensitive Help provided throughout the Sample System.

The demos in the Sample System collectively demonstrate the following features in iFIX:

- Tag groups
- Pop-up pictures
- Alarm counters
- Trending
- Reports
- Picture layers
- VisiconX
- Simulation database
- iFIX graphics
- ToolTips
- Electronic signatures
- Electronic records

While using the Sample System, you may use pictures you find that work well in your own application. Many of the pictures were designed to be flexible for this purpose. For example, the trending screen's Start Date/Time form list has a drop-down box that lists dates with historical data. Instead of hard-coding in the dates that came with the Sample System, the form looks at the historical data path for the machine and returns all the available dates that are on the machine. So, with minor modifications, you can use it on your system.

For more detailed information on any of the features demonstrated in the Sample System, refer to the iFIX electronic books.

Before You Begin

Before you begin using the Sample System, you should be aware of the restrictions and requirements discussed in this section.
Running the Sample System with iFIX

The Sample System runs on a special demo version of iFIX; therefore, you cannot run the Sample System and iFIX simultaneously. When you start iFIX, a dialog box appears, giving you the choice of starting iFIX normally, starting the Sample System, or always starting iFIX normally.

Using the Sample System with a Terminal Server

If you use multiple Sample System sessions with a Terminal Server, you should be aware of the following:

- Terminal Server requires that each node have a unique node name. For the Sample System, every session starts with the node name SAMPLE.
- Multiple Sample System sessions use the same LOCAL directory and the same .tbx (toolbar) files. The first session that runs accesses the toolbar. All subsequent sessions are unable to load the toolbars.
- Multiple Sample System sessions use the same PIC directory and the same .TGS (Tag Group Storage) files. The first session to run using a .TGS file gets exclusive access. A Subsequent Sessions Report error displays.

To avoid these Sample System node name-related problems, use LAUNCH.EXE to start the Sample System with a unique node name as described below for each terminal server user.

To use LAUNCH.exe to start the Sample System:

1. Copy the Sample System directory into a unique directory. For example, C:\Program Files\Proficy\Proficy iFIX\Sample2.
2. Open the .SCU file in the new \local directory of the directory you created.
3. In the SCU, select Configure Paths and change all paths to match your new directory.
4. Create a new LAUNCH shortcut to start your new system, for example:

```
Launch.exe /t /nNEWNODENAME /sNEWPATH
```

Where NEWNODENAME is the unique node name, NEWPATH is the new path to the SCU file. For example:

```
Launch.exe /t /nSAMPLE2 /s"C:\Program Files\Proficy\Proficy iFIX\SAMPLE2\LOCAL\SAMPLE2.SCU"
```

For more information on using the LAUNCH.EXE program, refer to the section Running iFIX from the Command Line in the Setting Up the Environment manual.

**NOTE:** When using the Sample System with Terminal Server, we recommend that you disable picture caching for better performance.

Using the Sample System with Picture Caching

Disable picture caching when using the Sample System.
Starting the Sample System

Start the Sample System using either method:

- Double-click the Sample System icon on your desktop.
- Click the Start button and point to Programs, Proficy HMI SCADA - iFIX, and then iFIX Sample System.

You cannot run the Sample System and iFIX simultaneously. If iFIX is already running when you attempt to start up the Sample System, a dialog box appears asking if you want to shut down iFIX and start another configuration.

If iFIX is not running when you start up the Sample System, the Sample System starts immediately and displays the following main menu.

From this screen you can:

- Enter any of the four industry demos.
- Visit the web site.
- Open the Sample System Help.
- View web-based Microsoft PowerPoint slides that describe the technology innovation of the Proficy software.
- Read the iFIX electronic books.
- Locate the address of other offices worldwide.
- Exit the Sample System.
Help is available for each category of information on the main menu. Click the ? button, then click on an item for additional information.

**Accessing Other Desktop Applications**

The Sample System opens in full screen view. Screen elements, such as scroll bars, toolbars and menus are not visible. Therefore, you must press Alt+Tab to access other applications that you are running on your desktop.

**Using the Sample System Help**

The Sample System uses Help to describe the functionality demonstrated in each picture. The Help describes special features and technologies being highlighted, and in many cases, describes how an animation or function was created. Many of the objects in a picture, for example, a pump, tank, or valve, have Help that describes how the object was created, and the purpose of that object within the picture. Therefore, it is important that you understand how to use the Help system.

**Getting Help for an Object or Picture**

The ? button is available on each screen of every picture. If you are not sure what an object does or how it was created, click the ? button, then click on the object (field, button, tank, pump, valve, and so forth) to display Help for that object. You can also click the ? button, then click anywhere on the picture for general information about the picture. Press Shift+F1 to display the ? button, then you can click an object to display help.

**Displaying ToolTips**

ToolTips are used throughout the Sample System. Place your cursor over an object for a few seconds to display the ToolTip for that object, if one exists.

**Clicking the Help File Button from a Picture**

Clicking the Help File button from a picture displays the Help on screen.

**Working with the Sample System Demos**

Before you begin using the Sample System demos, it is helpful to understand basic information about the demos such as how the Alarm Summary, Trending, and Reporting screens were setup, how to use the configure and run modes, and how to navigate through the demos.

Refer to the following sections for more information:

- Understanding the Alarm Summary, Trending Chart, and Reporting Screens
- Using Configure and Run Modes
- Navigating through the Demos

**Understanding the Alarm Summary, Trending Chart, and Reporting**
Using the iFIX Sample System

Screens

The Sample System uses one Alarm Summary, Trending Chart, and Reporting screen for all industry demos. For example, instead of placing and configuring an Alarm Summary object in each picture, the Sample System uses a single picture that stays on top of the other pictures. For alarms, each of the four industries is separated into four different alarm areas: Water_WasteWater, Batch_Production, Discrete_Mfg, and Pharm_Process. Therefore, when you are in the Water & Wastewater demo, you see alarms only for that industry.

Similarly, all of the alarm counters are also filtered based on the particular alarm area. Each time the alarm summary picture opens it loads the appropriate Tag Group file to filter the alarms and restrict the alarm counters to the specific area you are in.

For the Trending Chart screen, only the real-time and historical tags for the industry you are in are available. For the reporting screen, only the tags for the industry you are in are available. As a result, the Alarm Summary Object, Trending Chart, and Reporting screens show different information as you change industries.

Because all demos share one alarm summary and trending screen, the specific details of these features are discussed in the Exploring Alarms and Alarm Counters and Exploring Trending sections. You can explore these features from any demo.

Using Configure and Run Modes

Press Ctrl+W to toggle between run mode and configure mode in each of the demos. Configure mode opens the WorkSpace and allows you to drill down into the components of an object to see how it was created. You can add data or try a new feature, then press Ctrl+W again to see that object's behavior in run mode.

NOTE: When you switch to configure mode, some pictures have variables that are set based on which buttons you clicked. Therefore, after you make changes in configure mode, the picture may not always display correctly. To ensure that the picture displays correctly after you have made changes, either shutdown and re-start the WorkSpace, or close all pictures and open the main menu picture (iFix1_Splash.grf), then switch to run mode and navigate to the picture you changed.

Navigating through the Demos

Each picture in the Sample System contains Previous and Next buttons that let you move through the screens in each picture. The Next button takes you to the next screen in the demo, and the Previous button takes you to the last screen that you viewed within a demo. If you switch to another demo, the Previous button will not work.

You can change industry demos by clicking the appropriate button from the current demo.

Parts of the Demos

The following sections provide brief descriptions of the individual pictures included in each demo:

- Water & Wastewater Demo
- Discrete Manufacturing Demo
Understanding iFIX

- Specialty Chemical Demo
- Pharmaceutical Manufacturing Demo

Parts of the Water & Wastewater Demo

Chemical Feed Picture

This is a sample Chemical Feed system employing many useful techniques you can use in your everyday projects. The graphic can be mined for String Lookup tables and Color Lookup tables. The use of Multistate Digital input (MDI) process database blocks, linked object properties and much more.

Backwash Filter Picture

This picture represents a typical backwash filter sequencing process. You can select one of three different filters to display, start or stop the sequence, and control the various blowers and valves. The key technology that makes this picture possible is its extensive use of tag groups. Instead of having three different pictures for each backwash filter, we use only one picture and substitute the appropriate tags for filter 1, 2 or 3 as appropriate. The various, valves, pumps and blowers can be set to Auto or Manual, and started or stopped through the simulation database. Click on an object to open a pop-up control picture.

Trending Picture

This screen is designed to show some of the power and flexibility of the iFIX trending object. One of its main features is the ability to display real-time process data, historical and archived data, and lab data from a file or database. You can customize most properties, from colors to scroll directions, in either configure or run-time environment. Note also, that as with the Alarms picture, only those real-time and historical tags that pertain to the particular industry you are in are available.

NOTE: The historical chart used in the Water & Wastewater, Chemical, and Discrete demo and the Reports screen available to each demo are hard-coded in the English (United States) format. To ensure compatibility with your system, you must set your computer to also use the English format. You can check these settings in the Regional Options folder in the Control Panel.

To add a pen, select an historical or real-time pen from one of the combo boxes, then click the appropriate Add Pen button.

Alarms Picture

This is the alarm summary screen for all of the industry samples. This screen is designed to show several features of alarming including: Alarm Areas, Alarm Counters, and the Alarm Summary OCX. Alarm areas are a powerful way of filtering the alarms that an operator can see and acknowledge based on a physical or logical method of grouping equipment. Alarm counters enable you to get a quick summary of the number and type of alarms in your plant. The Alarm Summary OCX (ActiveX control) is the grid that you are currently viewing, which allows you to filter and sort the alarms based on your preferences.

In this sample system, we separate each of the four industries into four different alarm areas: Water & Wastewater, Batch Production, Discrete Manufacturing, and Pharmaceutical. Therefore, when you are in the Water & Wastewater demo, you only see alarms for that particular industry. Similarly, all of the alarm counters are also filtered based on the particular alarm area. As you change industries, notice how the same picture shows very different information.
Using the iFIX Sample System

Reports Picture

This is the main reporting screen for each industry demo. iFIX does not currently ship with a reporting package. You must have Crystal Report XI or Crystal Reports XI run-time files installed to view reports in iFIX. As such, the reports in this screen are simulated examples.

All the reports use the iFIX ODBC drivers for historical data. If Crystal were installed with the Sample System, when you click the Display Report button, iFIX would build a simple ODBC query string that contained the tags and other parameters that you selected, and send it to the report. Crystal Reports would execute the query and print the report as an HTML file on the local hard disk. We then use a Microsoft Web Browser control (part of Microsoft Internet Explorer) to display the HTML file.

In addition, you can print the report to your default printer and export it to any one of several formats. All of these functions come from the Crystal Reports engine. Note also, that as with other portions of the system, only those tags that are relevant to a particular industry are available for you to execute a report.

The historical chart used in the Water & Wastewater, Chemical, and Discrete demo and the Reports screen available to each demo are hard-coded in the English (United States) format. To ensure compatibility with your system, you must set your computer to also use the English format. You can check these settings in the Regional Options folder in the Control Panel.

Parts of the Discrete Manufacturing Demo

Discrete Picture

This picture shows a picture tube annealing line. As the picture tubes move down the assembly line, they are pre-heated, then rotated as the tube necks are annealed on. Finally, they move under the cooling flange that drops over the necks to cool them before they move on to the rest of the production line.

The entire annealing process is driven by Analog Input (AI) and Digital Input (DI) tags in the process database. When you start the production line (by switching to Auto), a set of Program Blocks (PG) in the process database take on the role of a PLC and write values to the AI and DI tags to simulate the process.

As the tubes move down the assembly line, the total number of tubes produced and number of rejects updates automatically. In addition, all of the graphics are created using iFIX objects. No bitmaps are used in this picture.

Trending Picture

This screen is designed to show some of the power and flexibility of the iFIX trending object. One of its main features is the ability to display real-time process data, historical and archived data, and lab data from a file or database. You can customize most properties, from colors to scroll directions, in either configure or run-time environment. Note also, that as with the Alarms picture, only those real-time and historical tags that pertain to the particular industry you are in are available.

NOTE: The historical chart used in the Water & Wastewater, Chemical, and Discrete demo and the Reports screen available to each demo are hard-coded in the English (United States) format. To ensure compatibility with your system, you must set your computer to also use the English format. You can check these settings in the Regional Options folder in the Control Panel.
To add a pen, select an historical or real-time pen from one of the combo boxes, then click the appropriate Add Pen button.

**Alarms Picture**

This is the alarm summary screen for all of the industry samples. This screen is designed to show several features of alarming including: Alarm Areas, Alarm Counters, and the Alarm Summary OCX. Alarm areas are a powerful way of filtering the alarms that an operator can see and acknowledge based on a physical or logical method of grouping equipment. Alarm counters enable you to get a quick summary of the number and type of alarms in your plant. The Alarm Summary OCX (ActiveX control) is the grid that you are currently viewing, which allows you to filter and sort the alarms based on your preferences.

In this sample system, we separate each of the four industries into four different alarm areas: Water & Wastewater, Batch Production, Discrete Manufacturing, and Pharmaceutical. Therefore, when you are in the Water & Wastewater demo, you only see alarms for that particular industry. Similarly, all of the alarm counters are also filtered based on the particular alarm area. As you change industries, notice how the same picture shows very different information.

**Reports Picture**

This is the main reporting screen for each industry demo. iFIX does not currently ship with a reporting package. You must have Crystal Report XI or Crystal Reports XI run-time files installed to view reports in iFIX. As such, the reports in this screen are simulated examples.

All the reports use the iFIX ODBC drivers for historical data. If Crystal were installed with the Sample System, when you click the Display Report button, iFIX would build a simple ODBC query string that contained the tags and other parameters that you selected, and send it to the report. Crystal Reports would execute the query and print the report as an HTML file on the local hard disk. We then use a Microsoft Web Browser control (part of Microsoft Internet Explorer) to display the HTML file.

In addition, you can print the report to your default printer and export it to any one of several formats. All of these functions come from the Crystal Reports engine. Note also, that as with other portions of the system, only those tags that are relevant to a particular industry are available for you to execute a report.

The historical chart used in the Water & Wastewater, Chemical, and Discrete demo and the Reports screen available to each demo are hard-coded in the English (United States) format. To ensure compatibility with your system, you must set your computer to also use the English format. You can check these settings in the Regional Options folder in the Control Panel.

**Parts of the Specialty Chemical Demo**

**Production Picture**

This screen shows some of the various tank, pipe and valve Dynamos in iFIX. The tank levels, mixers, temperatures and valve positions come from simulation I/O points in the real time database using Analog Input (AI) and Digital Input (DI) blocks. The pipe flows are calculated using calculation (CA) blocks. All of the pipe colors come from a color threshold table that contains a single set of color definitions for values of 0 – 100%.

To start the batch process, click the Batch Automatically button. This picture also demonstrates object layering and the ability to add ToolTips to a picture.
Trending Picture

This screen is designed to show some of the power and flexibility of the iFIX trending object. One of its main features is the ability to display real-time process data, historical and archived data, and lab data from a file or database. You can customize most properties, from colors to scroll directions, in either configure or run-time environment. Note also, that as with the Alarms picture, only those real-time and historical tags that pertain to the particular industry you are in are available.

**NOTE:** The historical chart used in the Water & Wastewater, Chemical, and Discrete demo and the Reports screen available to each demo are hard-coded in the English (United States) format. To ensure compatibility with your system, you must set your computer to also use the English format. You can check these settings in the Regional Options folder in the Control Panel.

To add a pen, select an historical or real-time pen from one of the combo boxes, then click the appropriate Add Pen button.

Alarms Picture

This is the alarm summary screen for all of the industry samples. This screen is designed to show several features of alarming including: Alarm Areas, Alarm Counters, and the Alarm Summary OCX. Alarm areas are a powerful way of filtering the alarms that an operator can see and acknowledge based on a physical or logical method of grouping equipment. Alarm counters enable you to get a quick summary of the number and type of alarms in your plant. The Alarm Summary OCX (ActiveX control) is the grid that you are currently viewing, which allows you to filter and sort the alarms based on your preferences.

In this sample system, we separate each of the four industries into four different alarm areas: Water & Wastewater, Batch Production, Discrete Manufacturing, and Pharmaceutical. Therefore, when you are in the Water & Wastewater demo, you only see alarms for that particular industry. Similarly, all of the alarm counters are also filtered based on the particular alarm area. As you change industries, notice how the same picture shows very different information.

Batch Data Picture

This screen shows our sample product line along with some profit and production values from a Microsoft Access® database. All the data is returned and evaluated using VisiconX data controls without using scripts. In addition, you can change the unit cost of a selected product, and when you click the Commit button, the data controls write the new value to the database and re-calculate the production totals using standard SQL (Structured Query Language) commands.

As you select different products, note that the grid updates automatically to show the information for that particular product. This is done automatically because the two grids are linked together by animating the ADO Records property of the Batch Summary grid to the selected entry of the Available Products grid.

CIP Picture

This screen shows a sample Clean In Place (CIP) summary for a specialty chemical/batch process. The data comes from a Microsoft Access® database that was populated using the SQL Trigger (SQT) and SQL Data (SQD) database blocks in the iFIX real-time process database. The SQT and SQD blocks (which were not included with the sample system) automatically inserted the records as the CIP took place.

By selecting a different CIP route, you can see the usage summary, batches produced, CIP supplier
Understanding iFIX

Information and statistics update. All the data is returned and evaluated using VisiconX data controls with no scripting. This works because all of the data controls are linked together so that as one updates, any dependent controls automatically re-query the database to get the latest information.

Alarm History Picture

This picture demonstrates two technologies: the Alarm ODBC driver and VisiconX. The Alarm ODBC driver is a service that sends all alarms and system events to a relational database such as SQL Server or Oracle. This picture uses two VisiconX data controls to let you select the alarms for either all the tags or a specific tag based on your selection in the drop down combo box. This is done automatically without the use of scripts or code in the background.

Reports Picture

This is the main reporting screen for each industry demo. iFIX does not currently ship with a reporting package. You must have Crystal Report XI or Crystal Reports XI run-time files installed to view reports in iFIX. As such, the reports in this screen are simulated examples.

All the reports use the iFIX ODBC drivers for historical data. If Crystal were installed with the Sample System, when you click the Display Report button, iFIX would build a simple ODBC query string that contained the tags and other parameters that you selected, and send it to the report. Crystal Reports would execute the query and print the report as an HTML file on the local hard disk. We then use a Microsoft Web Browser control (part of Microsoft Internet Explorer) to display the HTML file.

In addition, you can print the report to your default printer and export it to any one of several formats. All of these functions come from the Crystal Reports engine. Note also, that as with other portions of the system, only those tags that are relevant to a particular industry are available for you to execute a report.

The historical chart used in the Water & Wastewater, Chemical, and Discrete demo and the Reports screen available to each demo are hard-coded in the English (United States) format. To ensure compatibility with your system, you must set your computer to also use the English format. You can check these settings in the Regional Options folder in the Control Panel.

Parts of the Pharmaceutical Manufacturing Demo

High Shear Mixer Picture

This screen shows animations that use a state machine and electronic signatures. The mixing bowl has eight positions, or states:

<table>
<thead>
<tr>
<th>State</th>
<th>State Name</th>
<th>State Description</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ready to Change</td>
<td>Mixing bowl off screen.</td>
<td>Change Mixing Bowl</td>
</tr>
<tr>
<td>2</td>
<td>At Base</td>
<td>Mixing bowl at base of mixer.</td>
<td>Remove Mixing Bowl Load Mixing Bowl</td>
</tr>
</tbody>
</table>
Using the iFIX Sample System

<table>
<thead>
<tr>
<th>State</th>
<th>State Name</th>
<th>State Description</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Stopped</td>
<td>Mixing bowl stopped, but in position to mix.</td>
<td>Unload Mixing Bowl Start (requires two electronic signatures). Cut Away</td>
</tr>
<tr>
<td>4</td>
<td>Running</td>
<td>Mixing bowl running and in position to mix.</td>
<td>Stop (requires two electronic signatures). Cut Away</td>
</tr>
<tr>
<td>5</td>
<td>Changing</td>
<td>Mixing bowl moving right-to-left, to base of mixer.</td>
<td>None</td>
</tr>
<tr>
<td>6</td>
<td>Raising</td>
<td>Mixing bowl rising from base of mixer to mixing position.</td>
<td>None</td>
</tr>
<tr>
<td>7</td>
<td>Lowering</td>
<td>Mixing bowl lowering from mixing position to base of mixer.</td>
<td>None</td>
</tr>
<tr>
<td>8</td>
<td>Removing</td>
<td>Mixing bowl moving left-to-right, from base of mixer.</td>
<td>None</td>
</tr>
</tbody>
</table>

All graphic animations are executed in program blocks and are based on the state of the mixing bowl. The mixing bowl state controls which buttons are enabled and the text on the buttons.

Changing the temperature set point requires a “performed by” electronic signature for the current mixer. Starting and stopping the mixing operation requires both a “performed by” and a “verified by” electronic signature for the current mixer. Acknowledging alarms in the Pharm_process alarm group also requires an electronic signature. You can view valid user names and passwords by clicking the Users button in the upper right corner of the screen picture. This displays a picture with the “always on top” attribute set, which enables you to refer to the information in the picture, as needed, when performing tasks that use electronic signatures. The requirement for electronic signatures is enabled at the tag level using the database manager application. This ensures that all pictures writing to the tag, regardless of node, require the operator to enter an electronic signature.

User Security Matrix Picture

Be aware that to access this picture, you must click the Users button. The Users button is only available when the High Sheer Mixer picture is open in the demo (in run mode).

The User Security Matrix picture shows a list of users and their corresponding security areas and application feature privileges. This picture is configured as “always on top” so you can refer to it when using electronic signatures in the pharmaceutical portion of the demo. The username consists of the person's first initial and last name; the password is the first and last initial.
Understanding iFIX

Alarms Picture

This is the alarm summary screen for all of the industry samples. This screen is designed to show several features of alarming including: Alarm Areas, Alarm Counters, and the Alarm Summary OCX. Alarm areas are a powerful way of filtering the alarms that an operator can see and acknowledge based on a physical or logical method of grouping equipment. Alarm counters enable you to get a quick summary of the number and type of alarms in your plant. The Alarm Summary OCX (ActiveX control) is the grid that you are currently viewing, which allows you to filter and sort the alarms based on your preferences.

In this sample system, we separate each of the four industries into four different alarm areas: Water & Wastewater, Batch Production, Discrete Manufacturing, and Pharmaceutical. Therefore, when you are in the Water & Wastewater demo, you only see alarms for that particular industry. Similarly, all of the alarm counters are also filtered based on the particular alarm area. As you change industries, notice how the same picture shows very different information.

NOTE: In order to acknowledge alarms within the Pharmaceutical industry will require the user to enter an e-signature.

Audit Trail View Picture

This picture shows an audit trail containing electronic signature data. This information is based on two technologies: Alarm ODBC driver and VisiconX. The Alarm ODBC driver is an easy-to-configure service that sends all signed operator actions to a relational database, such as Microsoft's SQL Server® or Oracle®. These actions include set point changes, start/stop actions, and alarm acknowledgements in the pharmaceutical process area that each requires electronic signatures. The operator's full name and optional comment, and the supervisor's full name and optional comment are some of the fields that are stored in the record sent to the relational database.

Based on which option button you select (Users or Batch ID), a script changes the query for the criteria VisiconX object. This filtered data then displays in a VisiconX list box without the use of scripting. When you select an item from the list box, its associated audit trail messages display in the corresponding VisiconX grid at the bottom of the picture.

Reports Picture

This is the main reporting screen for each industry demo. iFIX does not currently ship with a reporting package. You must have Crystal Report XI or Crystal Reports XI run-time files installed to view reports in iFIX. As such, the reports in this screen are simulated examples.

All the reports use the iFIX ODBC drivers for historical data. If Crystal were installed with the Sample System, when you click the Display Report button, iFIX would build a simple ODBC query string that contained the tags and other parameters that you selected, and send it to the report. Crystal Reports would execute the query and print the report as an HTML file on the local hard disk. We then use a Microsoft Web Browser control (part of Microsoft Internet Explorer) to display the HTML file.

In addition, you can print the report to your default printer and export it to any one of several formats. All of these functions come from the Crystal Reports engine. Note also, that as with other portions of the system, only those tags that are relevant to a particular industry are available for you to execute a report.
Quick Tour of the Discrete Manufacturing Demo

The Discrete Manufacturing demo shows a picture tube annealing assembly line. This is the simplest of the four demos and demonstrates the use of the simulation database and iFIX graphics capability. All the graphics in this picture were created using iFIX objects. No bitmaps are used in this picture.

To start the production line and view the picture tube annealing process, click the Start button.

The Annealing Process

In the Discrete Manufacturing demo, picture tubes move from right to left down the assembly line. There are three stages in this process, as shown at the top of the picture: pre-heating stage, annealing stage, and the cool down stage. The tubes are pre-heated, then rotated as the tube necks are annealed on. Finally, they move under the cooling flange which drops over the necks to cool them before they move on to the rest of the production line.

The entire annealing process is driven by Analog Input (AI) and Digital Input (DI) tags in the process database. When you start the production line, a set of Program Blocks (PG) in the process database act as a PLC and write values to the AI and DI tags to simulate the process.

Manufacturing Step Indicator

The Manufacturing Step Indicator to the left in the picture shows which steps are currently being performed on the production line. Notice the red arrows and flashing red text that indicate which processes are currently being performed on the production line.

As the tubes move down the assembly line, the total number of tubes produced and the number of rejects updates automatically in the Total, Target Qty, and Rejects fields located at the bottom of the Manufacturing Step Indicator. Click the ? button, then click on any of these fields for a description of how the field was created and its purpose within the picture.

Alarm Summary Object

The alarm summary object is located at the bottom of the screen and shows only one alarm. As explained earlier, all four demos use one alarm summary screen which filters the alarms based on the demo that you are viewing. Although you can right-click on the alarm summary in this picture to perform other functions, we recommend that you explore the alarm summary feature using the Chemical or Wastewater demo. These demos contain a greater number of alarms which will allow you explore more of the functionality available in the alarm summary object. To see a larger more expanded view of the Alarm Summary screen, click on the Alarms button.

For more information on the simulation database, refer to the section Using the Simulation Driver (SIM) in the Building a SCADA System manual. For more information on creating graphics, refer to the Creating Pictures manual.

Quick Tour of the Water & Wastewater Demo

The Water & Wastewater demo shows a picture of a water filtration and chemical feed system. This demo shows the use of tag groups, pop-up pictures, alarm counters, trending, and reports. All graphics in this picture were created using iFIX objects. This section guides you through exploring tag groups
Understanding IFIX and pop-up pictures. To explore alarms, alarm counters, and trending, refer to the Exploring Alarms and Alarm Counters and Exploring Trending sections.

The chemical feed picture in the Water & Wastewater demo shows two storage tanks of Sodium Hydroxide connected to three pumps that control input to the tanks. This picture uses tag groups for pump and valve control, and Multistate Digital Input blocks. The use of tag groups and Multistate Digital blocks show how you can use a single database tag to indicate one of several conditions such as Stop, Fail, Auto, and Manual.

This picture also includes a Backwash Filter sequencing process. Instead of having three different pictures for each backwash filter, we use only one picture and use tag groups to substitute the appropriate tags for each filter. Click on the Next button to display the Backwash Filter screens. From the Backwash Filter screen you can select one of the three different filters to display, start, or stop the sequence, and control the various blowers and valves.

Exploring Tag Groups and Pop-up Pictures

Tag groups provide a way to let you use one picture multiple times with different tags. For example, the Water & Wastewater picture uses a single valve pop-up picture to control any number of different valves by opening the picture with a different tag group file.

Tag groups support in-line substitution which allow you to easily open a picture with a different tag file group. With in-line substitution, if only a small part of a tag name changes between any two data sources, you only have to replace that part. The tag groups used in this picture have only two entries: the node name and the equipment ID (which is the filter number). Notice also that the Sample System is a single node application. We could have used only one entry. Therefore, if you choose a good tag naming convention, it is possible to have very few entries in your tag group file for a picture with many tags.

For example, the influent valve has the following data source:

\[ \text{Fix32.@NODE_NAME@.IFIX1_H2O_@EQUIPMENT_ID@_INLS0305.A_TAG} \]

Where @Node_Name@, substitute the node name, and where @Equipment_ID@, substitute the filter number (BW1, BW2, or BW3). So, for Filter 1 on the node called Thisnode, the link is:

\[ \text{Fix32.THISNODE.IFIX1_H2O_BW1_INLS0305.A_TAG} \]

For more information on creating tag groups, refer to the Using Tag Groups in Pictures chapter in the Creating Pictures manual.

The following are some ways to explore tag groups and pop-up pictures in the Wastewater demo:

<table>
<thead>
<tr>
<th>Do this....</th>
<th>And notice...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Chemical Feed button, then click one of the three pumps to open the picture as a pop-up.</td>
<td>A pop-up picture that is used to control the pumps. Notice that if you keep the pop-up picture open and click on a different pump on the main picture, a new tag group is loaded in the pop-up picture without having to first close it. For more information about the objects in the pop-up window, click the browse (...) button in the pop-up window, then click on any object in the pop-up window.</td>
</tr>
</tbody>
</table>
Using the iFIX Sample System

Do this.... | And notice...
---|---
Click the Backwash Filter button. | The entire picture uses tag groups. Clicking on one of the Backwash Filter buttons loads a different tag group and causes the same picture to display different tags. Deciding which tag group file loads when you click on a valve or blower (which opens a pop-up) is also based on tag groups.

Quick Tour of the Chemical Demo

The Chemical demo shows some of the various tank, pipe, and valve Dynamos in iFIX. The tank levels, mixers, temperatures, and valve positions come from simulation I/O points in the real-time database using Analog Input (AI) and Digital Input (DI) blocks. The pipe flows are calculated using calculation (CA) blocks. All of the pipe colors come from a global color threshold table that contains a single set of color definitions for values of 0 – 100%.

This demo demonstrates picture layers, ToolTips, VisiconX, alarms, and reports. This section guides you through exploring picture layers, ToolTips, and VisiconX. For a detailed look at alarms, alarm counters, and trending, refer to the Exploring Alarms and Alarm Counters and Exploring Trending sections.

Exploring Picture Layers

Picture layers are a fast way to show or hide objects in a picture based upon the object's layer. A picture can have up to 30 layers, and an object can have one or more layers assigned to it. So, for example, if all the pipes in a picture are assigned to layer 5, they are only displayed when the picture's visible layer includes level 5. Objects can also belong to more than one layer, so if pipes belong to layer 5 and layer 10, they are displayed when either of those two layers are displayed.

The following are some ways to view picture layers in the Chemical demo:

<table>
<thead>
<tr>
<th>Do this...</th>
<th>And notice...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Select Layers to Show button.</td>
<td>A dialog box appears that allows you to show or hide different objects in the picture. The objects have layer numbers assigned from 1 through 13. Some objects, like the buttons, have no layer assigned because we want them to always display. Notice also that all check boxes are selected and all layers are displayed.</td>
</tr>
<tr>
<td>Clear the check box next to one of the objects in the dialog box.</td>
<td>The object is hidden from view instantly.</td>
</tr>
</tbody>
</table>
Understanding iFIX

<table>
<thead>
<tr>
<th>Do this...</th>
<th>And notice...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the check box next to the same object again.</td>
<td>The object is instantly displayed.</td>
</tr>
</tbody>
</table>

Picture layers are also used in the Waster & Wastewater demo. To view the use of picture layers in the Water & Wastewater demo, click the Wastewater button from the Chemical demo, and select the Backwash Filter button. Click the Show Tags button and notice the tag names for the various objects appear on the screen. This was done by changing the picture display layer. Notice also that as you change different filters, the tag names change also.

For more information on picture layers, refer to the Creating Complex Objects section in the Creating Pictures manual.

Exploring ToolTips

You can add a ToolTip for each object on a screen. A ToolTip is a small window that appears over an object when you hold your mouse over the object for a few seconds. To view a ToolTip, place your mouse over any object, for example, the Select Layers to Show button. Notice the small window of information that appears.

To add a ToolTip in configure mode:

1. Press CTRL+W to switch to configure mode.
2. Right-click on the object for which you want to add the ToolTip, then select Animations from the right-click menu.
3. In the Descriptions field, enter the ToolTip.
4. Click on the Enable ToolTips check box and click OK.
5. Press CTRL+W to switch to run mode, then place your mouse over the object to see the ToolTip displayed.

Exploring VisiconX

VisiconX is a set of ActiveX controls developed by GE Intelligent Platforms to bring data from an OLE or ODBC database (for example, SQL, Oracle, and Microsoft Access) into the Proficy iFIX WorkSpace. Click on the Batch Data button to view the Batch and CIP summary screens which use VisiconX. You can also view an Alarm History screen, populated from an Access database. For more information about any object on any of these screens, click the browse (...) button, then click on the object.

For more information about using VisiconX, refer to the Using VisiconX manual.

Batch Data Summary Screen

To view the Batch Summary screen, click the Batch Data button. The batch summary screen shows a sample product line with some profit and production values from a Microsoft Access database. All the data is returned and evaluated using only VisiconX data controls.
Using the iFIX Sample System

To see how VisiconX is used in this picture, select a product in the Available Products grid to the left of the picture. Notice that the batch summary grid updates automatically to show the information for that particular product. This is done automatically because the two grids are linked together by animating the ADO Records property of the Batch Summary grid to the selected entry of the Available Products grid.

You can also change the unit cost of a selected product in the Available Products grid to the left of the picture, then click the Commit button to write the new value to the database and re-calculate the production totals.

For more information about any object or grid on this screen, click the browse (...) button, then click the object or grid.

Clean In Place (CIP) Summary Screen

To view the CIP Summary screen, click the CIP button from the Batch Data screen. This screen shows a sample Clean In Place (CIP) summary for a specialty chemical/batch process. The data comes from a Microsoft Access database that was populated using the SQL Trigger (SQT) and SQL Data (SQD) database blocks in the real-time process database.

To see how VisiconX is used in this picture, select a different CIP route, and notice that the usage summary, batches produced, CIP supplier information and statistics data are updated. All the data is returned and evaluated using only VisiconX data controls. All data controls are linked together so that as one updates, any dependent controls automatically re-query the database to get the latest information.

For more information about any object or grid on this screen, click the browse (...) button, then click the object or grid.

Alarm History Screen

To view the Alarm History screen, click on the Alarm Hist button on the CIP Summary screen. The Alarm History screen demonstrates the Alarm ODBC driver and VisiconX. The Alarm ODBC driver is a service that sends all alarms and system events to a relational database, such as Microsoft Access, SQL and Oracle. The picture uses two VisiconX data controls to let you select the alarms from either all the tags or a specific tag based on your selection in the drop-down combo box.

To see how VisiconX is used in this picture, click on the drop-down box and choose a tag. Notice that the alarm history changes each time you select a different tag in the drop-down box.

You can also manipulate the data in the grid in the following ways:

- Click the Create SQL Wizard button to create your own custom SQL expression and display it in a grid. When you click this button, a series of dialog boxes display from which you can select a table, row, a selection criteria and sort order.
- Select the Merge Rows check box to merge the information in each column that is the same.

For more information on any object or grid on the screen, click the browse (...) button, then click the object or grid.
Quick Tour of the Pharmaceutical Demo

The Pharmaceutical demo shows a high shear mixing machine picture. This demo shows how to use electronic signatures to sign for database changes and alarm acknowledgements. It also shows an audit trail containing electronic signature data.

To get started with the Pharmaceutical demo, select the mixer you want to work with by clicking the appropriate button, High Shear Mixer 1 or High Shear Mixer 2. The name of the mixer you select displays in the upper-left corner of the picture.

Modifying Controls

You can perform the following activities by clicking the indicated button:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load/Unload Mixing Bowl</td>
<td>Load or unload the mixing bowl from the mixer.</td>
</tr>
<tr>
<td>Change/Remove Mixing Bowl</td>
<td>Change or remove the mixing bowl from the mixer.</td>
</tr>
<tr>
<td>Start/Stop</td>
<td>Start or stop the mixer.</td>
</tr>
<tr>
<td>Cut Away</td>
<td>Display or hide the mixing blades in the mixing bowl.</td>
</tr>
</tbody>
</table>

The current state of the mixer displays and changes as you use these controls.

Modifying Temperatures

The mixer temperature controls featured in this demo allow you to change the temperature setpoint using any of these Experts:

- Data Entry
- Slider
- Ramp

Using Electronic Signatures

This demo requires that you enter electronic signatures for these actions:

- When you start or stop a mixer, you must enter a Performed By and a Verified By signature.
- When you use any one of the Experts to change the setpoint temperature, you need to enter only a Performed By signature.
- When you acknowledge an alarm, you need to enter only a Performed By signature.

For the purposes of this demo, fictitious users were created and assigned corresponding security areas and application feature privileges. You can display this information in the User Security Matrix picture.
by clicking the Users button at the top of the Pharmaceutical demo picture. The following table shows these users, their passwords, and their designated security areas and application features.

<table>
<thead>
<tr>
<th>User Full Name</th>
<th>User Name</th>
<th>Password</th>
<th>Security Area</th>
<th>Application Feature(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>George Clark</td>
<td>GCLARK</td>
<td>GC</td>
<td>Mixer 1</td>
<td>Electronic Signature - Perform By.</td>
</tr>
<tr>
<td>Thomas White</td>
<td>TWHITE</td>
<td>TW</td>
<td>Mixer 1 and Mixer 2</td>
<td>Electronic Signature - Perform By. Electronic Signature - Verify By.</td>
</tr>
<tr>
<td>Peter Smith</td>
<td>PSMITH</td>
<td>PS</td>
<td>Mixer 2</td>
<td>Electronic Signature - Perform By.</td>
</tr>
<tr>
<td>Laura Jones</td>
<td>LJONES</td>
<td>LJ</td>
<td>Mixer 2</td>
<td>Electronic Signature - Perform By. Electronic Signature - Verify By.</td>
</tr>
</tbody>
</table>

**Signing When Starting and Stopping the Mixer**

You should experiment with the users available in the User Security Matrix interchangeably to sign for an action you perform. To maximize your understanding of how signing privileges work, sign for an action with a valid user, and then sign for that same action with an invalid user. The following three scenarios suggest how you may want to try signing for your actions in the Pharmaceutical demo.

**Scenario 1**

Start or stop Mixer 1. You must enter a Perform By and Verify By user. Enter George Clark as the Perform By user; enter Thomas White as the Verify By user. According to the User Security Matrix, these are valid users, and the electronic signature works.

**Scenario 2**

Start or stop Mixer 2. You must enter a Perform By and Verify By user. Enter George Clark as the Perform By user. George is not qualified to sign for Mixer 2, so an unauthorized access attempt message appears. Now enter Peter Smith as the Perform By user and Laura Jones as the Verify By user. These are valid users, and the electronic signature works.

**Scenario 3**

Start or stop Mixer 2. You must enter a Perform By and Verify By user. Enter Laura Jones as the Perform By user and as the Verify By user. Although Laura Jones has permission to perform and verify a signed action for Mixer 2, the same user can never sign both signatures for the same action. A message displays to indicate this condition, and you are prompted to enter a different user name. Enter Thomas White as the Verify By user. These are valid users, and the electronic signature works.
Understanding iFIX

Continue to experiment with a variety of users to test the power of electronic signatures.

**Signing When Using an Expert**

You can change the temperature setpoint of the mixer using the Data Entry, Slider, or Ramp Expert, as indicated on the Mixer Temperature picture. Each time you change a value using one of these Experts, you have to enter a Perform By signature.

Refer to the User Security Matrix picture for a list of authorized users. If you sign with an unauthorized user's name or an invalid password, an error message displays.

**Signing When Acknowledging Alarms**

You can acknowledge an alarm from the Alarm Summary object, located at the bottom of the Pharmaceutical demo, or you can click the Alarms button to display a full-screen view of the Alarm Summary object.

When you double-click an alarm in this demo, the Performed By electronic signature box appears. All alarms are configured to require the perform by signature only. All users listed in the User Security Matrix picture are authorized to acknowledge an alarm. If you sign with an unauthorized user's name or an invalid password, an error message displays.

**Acknowledging All Alarms**

The Electronic Signature option does not support Acknowledge All alarms capability. When you click the Acknowledge All button, you are actually acknowledging the alarms on the displayed page only.

If you select Acknowledge All from the right-mouse menu, a warning message displays, indicating that one or more alarms require electronic signature. In these instances, alarms that are not connected to tags that require electronic signature are acknowledged. You must acknowledge the remaining alarms individually.

**Viewing the Audit Trail from a Relational Database**

The Pharmaceutical demo provides a VisiconX object that displays audit trail records in a relational database. When an operator signs for an action or alarm acknowledgement, the Alarm ODBC driver sends information about that action to a relational database. This information can include information about the users, such as the Perform By operator's full name and optional comment, and the Verify By operator's full name and optional comment.

The information can also include information about the data that changed, such as the data source identifier, its original value, and its new value. You can sort and search the records of the audit trail by batch ID or users.

**Exploring Trending**

The Trending screen shows some of the power and flexibility of the iFIX chart object. One of its main features is the ability to display real-time process data, historical/archived data, and lab data from a file or database. You can customize most properties, from colors to scroll directions, in the configure or run-time environment. To begin exploring the trending feature, click the Trending button from the Chemical or Wastewater demo. The following are examples of ways that you can explore the trending
feature:

<table>
<thead>
<tr>
<th>Do this...</th>
<th>And notice...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a tag from the Historical pens list, then click the Add Pen button.</td>
<td>A pen is added to the chart. This pen shows data for the tag you selected. It shows the values of the tag or process.</td>
</tr>
<tr>
<td>Select a tag in the real-time Pens list, then click the Add Pen button.</td>
<td>A second pen is added to the chart that shows the real-time values of the tag or process.</td>
</tr>
<tr>
<td>NOTE: Each pen you add is given a different color and the corresponding tag is listed at the bottom of the chart in the same color as the pen.</td>
<td></td>
</tr>
<tr>
<td>Choose the trending criteria:</td>
<td>When you choose the date, time, interval, and duration, the dates and times at the bottom of the chart changes accordingly.</td>
</tr>
<tr>
<td>• Click the Start Date/Time button to choose the date and time from which to begin showing data.</td>
<td></td>
</tr>
<tr>
<td>• Click one of the Duration times to specify the time period for which to display data.</td>
<td></td>
</tr>
</tbody>
</table>

The following table provides examples of what happens when you manipulate the grid in the indicated manner.

<table>
<thead>
<tr>
<th>Manipulate the grid like this...</th>
<th>And notice...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the Change Colors button to change the pen color.</td>
<td>The color of the pen and legend information changes.</td>
</tr>
<tr>
<td>Click the Scroll Left To Right button to change the scroll direction.</td>
<td>The direction in which the data scrolls changes.</td>
</tr>
<tr>
<td>Click the Multiple Times and Multiple Values button to simultaneously display times and values for each pen on the chart.</td>
<td>The time and value legend for each pen displays at the same time. To return to the default, click these buttons again.</td>
</tr>
<tr>
<td>Click the tag name in the lower left corner of the chart to view the time and value legend for each pen.</td>
<td>The color of the time and value legend changes to reflect the tag you clicked.</td>
</tr>
<tr>
<td>Manipulate the grid like this...</td>
<td>And notice...</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Change zoom directions and percentage.</td>
<td>The data on the chart sizes accordingly. Click Reset Zoom to return to the default setting.</td>
</tr>
<tr>
<td>Click the Delete Pen button to delete a pen.</td>
<td>The currently selected pen is deleted. The currently selected pen is the pen whose time and value legends are currently displayed.</td>
</tr>
<tr>
<td>Click the arrow buttons to move forward or backward by 25 or 50%.</td>
<td>The data on the chart moves accordingly.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> You can also double-click the chart to display the Chart Configuration dialog box, which contains many of these functions.</td>
<td></td>
</tr>
<tr>
<td>Click the Lab Data from the MS Access button to retrieve data from a relational database.</td>
<td>A third pen is added that shows the lab data.</td>
</tr>
</tbody>
</table>

**Exploring Alarms and Alarm Counters**

You can explore alarms and alarm counters in all industry demos. However, we recommend that you use either the Chemical or Wastewater demo because they contain more alarms which will allow you to more fully explore the alarm functionality.

All industry demos use the same alarm summary screen. In this Sample System, we separate each of the four industries into four different alarm areas: Water_WasteWater, Batch_Production, Discrete_Mfg, and Pharm_Process. Therefore, when you are in the Water & Wastewater demo, you only see alarms for the Wastewater picture. Similarly, all of the alarm counters are also filtered based on the particular alarm area. As you change industries, the same picture shows different information.

While there are many ways of doing this, in the Sample System, every time the alarm summary picture opens it loads the appropriate Tag Group file to filter the alarms and restrict the alarm counters to the specific area you are in.

The alarm summary screen shows several features of alarming including: alarm areas, alarm counters, and the alarm summary object.

The alarm summary object, sometimes referred to as the alarm summary OCX (ActiveX control), is the grid that you view that allows you to filter and sort the alarms based on your preferences. Alarm areas allow you to filter the alarms in the grid so that an operator can see and acknowledge them based on a physical or logical method of grouping equipment. Alarm counters enable you to get a quick summary of the number and type of alarms in your plant. The alarm counter summary is located at the bottom of the Alarm Summary screen.

The alarm summary object is shown at the bottom of each picture in a minimized screen. To display the Alarm summary in full screen view, click on the Alarms button.
The following are some ways to explore alarms and alarm counters:

<table>
<thead>
<tr>
<th>Do this...</th>
<th>And notice...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click on one alarm in the alarm summary grid, then click the Acknowledge Alarms button. You can also select multiple alarms by pressing and holding Ctrl while clicking additional alarms.</td>
<td>When you click the Acknowledge Alarm button, the alarm is acknowledged and a check mark appears to the left of the alarm. (By default, acknowledged alarms are deleted from the alarm summary, however, you can change this feature in the SCU.) Notice also that the alarm counter summary totals change to reflect the acknowledged alarm.</td>
</tr>
<tr>
<td>Sort the alarms by clicking on the Sort field (located in the lower right corner of the screen) and choosing a sort criteria. You can also right-click on the alarm summary and select Sort from the right-click menu, or click the column name to perform a quick sort.</td>
<td>The alarms are sorted according to the sort criteria you chose. Notice also that when you change the sort criteria, the summary bar at the bottom of the alarm summary object (to the left of the alarm summary status) changes to reflect the new sort criteria.</td>
</tr>
<tr>
<td>Right-click on the alarm summary and select Pause Alarm Read to pause the alarm summary. You can also pause the alarm summary by selecting multiple alarms.</td>
<td>The alarm summary status indicator changes to reflect the state of the alarm summary. When the alarm summary is paused, no new alarms are displayed.</td>
</tr>
<tr>
<td>Click the Enable Alarm Horn button to enable the Alarm horn.</td>
<td>The alarm horn beeps through your PC’s speakers.</td>
</tr>
</tbody>
</table>

The alarm counter summary at the bottom of the Alarm screen shows at a glance the number of acknowledged and unacknowledged alarms by alarm priority (CRITICAL, HIHI, HIGH, MEDIUM, LOW, LOLO, INFO) for a particular alarm area. Click the browse (...) button, then click on a field in the alarm counter grid for an explanation of that field. You can also press Ctrl+W to see how the grid was created.

You can also enable or disable alarms for a particular object (pump, tank, and so forth) as demonstrated in the Wastewater demo. Click on the Wastewater button to switch to the Wastewater demo, then click on the Alarm Inhibit button. A dialog box displays a list of objects for which you can enable or disable alarms. Select one or more objects, then click Exit. Alarms are disabled for the selected objects. Notice that when you disable alarms, the Alarm Inhibit button turns yellow to alert you that there are disabled alarms. To view the number of disabled alarms, refer to the Disabled column in the Alarm Counter summary at the bottom of the Alarms screen.

For more information on the alarms and alarm counters, refer to the Implementing Alarms and Messages manual.
Index

A

acknowledging alarms

  signing for alarms in the Pharmaceutical demo ....................................................... 236

acknowledging alarms .................................... 236

ActiveX

  in iFIX ............................................................ 6
  integrating documents .................................. 27
  support .......................................................... 10

ActiveX ............................................................ 10

ActiveX controls

  iFIX as a container .......................................... 6
  in iFIX ............................................................ 5

ActiveX controls ................................................. 5

adding

  buttons to a toolbar ....................................... 55
  toolbar buttons to a category ........................ 56
  toolbar categories .......................................... 56

adding ............................................................... 56

adding a button to a category .................................. 167

adding a button to a toolbar .................................. 162

adding a category ............................................ 166

adding an OPC server ........................................... 169

alarm areas

  defined ........................................................... 17

alarms

  as a system function ...................................... 23
  in iFIX ........................................................ 16

alarms ............................................................ 16

alarms and alarm counters

  exploring in Sample System .................................. 238

alarms and alarm counters .................................. 238

application

  functions ........................................................ 26
  starting .......................................................... 50
  toolbar ........................................................... 53

application ........................................................ 53

applying a filter to the tag list ......................... 149

architecture

  open .............................................................. 25
  system .......................................................... 8

architecture ........................................................ 8

archiving data .................................................. 153

arranging
Understanding iFIX

toolbar buttons .............................................. 55
arranging ........................................................... 55
arranging buttons on a toolbar ........................ 163
audit trail
viewing from a relational database in the Pharmaceutical demo .............................. 236
audit trail ........................................................ 236
automatic save ................................................. 130
automatically open pictures .............................. 129

B
backing up data ............................................... 153
backup and restore .......................................... 177
Backup and Restore Wizard ........................... 153
backup files
Backup and Restore Wizard ....................... 177
saving ........................................................... 78
backup files ....................................................... 78
blind SCADA server ........................................... 8
block alarms
defined .......................................................... 17
block alarms ..................................................... 17
block messages ................................................. 17
blocks
chains ............................................................ 11
primary ......................................................... 11
secondary ...................................................... 11
blocks .............................................................. 11
browsing the process database ....................... 147
building an expression ................................. 147

buttons
configuring ...................................................... 56
creating for toolbars ...................................... 56
deleting from a category .................................. 56
modifying ....................................................... 56
modifying properties ..................................... 56

C
categories ........................................................ 167
centralized processing ..................................... 16
chains ............................................................. 11
Change Management ..................................... 151
changing paths ................................................ 150
chart preferences ............................................. 144
charts
setting preferences .......................................... 78
charts ............................................................ 78

Chemical demo
exploring picture layers .................................. 231
exploring ToolTips .......................................... 232
exploring VisiconX ........................................... 232
overview ....................................................... 231

Chemical demo ............................................... 231
closing folders ............................................... 127
COM ............................................................. 5
command line parameters for WorkSpace ......... 28
communicating to a remote OPC server
from the WorkSpace ................................... 170
Component Object Model (COM) ...................... 5
components
iFIX .......................................................... 3
components......................................................... 3
configuration environment
described ................................................................ 50
configuration environment ................................. 3
configure mode
using in Sample System ...................................... 221
configure mode ............................................... 221
configuring
buttons .................................................................. 56
electronic books .............................................. 210
run-time preferences .............................................. 78
the picture path ............................................... 174
your local computer ........................................... 173
configuring ............................................................. 173
control .................................................................. 23
copying
toolbar categories .............................................. 57
copying ............................................................. 57
copying an object
electronic books .............................................. 214
copying an object .............................................. 127
Create New Picture wizard .............................. 128
creating
dynamo sets ...................................................... 52
new document ....................................................... 52
new pictures ........................................................ 52
new schedules ..................................................... 52
toolbar buttons ...................................................... 56
toolbar categories .................................................. 56
toolbars .............................................................. 55
creating .................................................................. 55
creating a Dynamo set ........................................ 128
creating a new file .............................................. 128
creating a new picture ........................................ 128
creating a new schedule ...................................... 128
creating a toolbar ............................................... 164
creating backup copies ........................................ 144
creating files ....................................................... 128
Crystal Reports
using with iFIX ................................................... 24
Crystal Reports ................................................... 24
D
data
accessing ................................................................ 9
archiving ........................................................... 24
flow .................................................................... 10
retrieving ........................................................... 21
data ................................................................. 21
Data Server Installer .......................................... 5
data sources
defined ............................................................. 9
data sources ........................................................ 9
Understanding iFIX

data transfer on demand.............................15
database control strategies.......................11
DCOM.........................................................6
deadband..................................................148
defining the active iBatch project...............155
deleting
  buttons from a category .......................56
document from the system tree...............52
toolbar categories.................................56
toolbars..................................................55
deleting..................................................55
deleting a button from a category ............167
deleting a category..................................167
deleting a toolbar...................................165
deleting an OPC server............................169
deleting files.........................................131
disabling
  error dialog boxes.............................51
  Proficy Historian errors.......................51
disabling................................................51
disabling environment protection.............135
disabling toolbar docking.......................163
Discrete Manufacturing demo
  overview..............................................229
Discrete Manufacturing demo..................229
display the WorkSpace full-screen..............145
displaying
  system tree path..................................46
displaying..............................................46
displaying a system tree path..................126
displaying the Visual Basic Editor.............131
distributed processing...........................14
docking.................................................163
documents
  creating.............................................52
deleing and renaming................................52
  integrating with iFIX from other programs ..................................27
  opening.............................................52
  saving................................................52
  working with......................................52
do dents.................................................52
drawing options
  setting preferences.........................78
drawing options.................................78
drawing preferences............................144
dropping and dragging objects.................127
dynamic connection.............................14
dynamo sets
  creating.............................................52
dynamo sets.........................................52
E
editing the script of a toolbar button........166
electronic books
  accessing information.........................209
  buttons..............................................209
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>changing the color of search hits</td>
<td>215</td>
</tr>
<tr>
<td>Contents tab</td>
<td>210</td>
</tr>
<tr>
<td>copying and pasting text</td>
<td>214</td>
</tr>
<tr>
<td>display options</td>
<td>214</td>
</tr>
<tr>
<td>features</td>
<td>209</td>
</tr>
<tr>
<td>Index tab</td>
<td>211</td>
</tr>
<tr>
<td>Locate button</td>
<td>213</td>
</tr>
<tr>
<td>printing</td>
<td>214</td>
</tr>
<tr>
<td>Search tab</td>
<td>211</td>
</tr>
<tr>
<td>electronic books</td>
<td>211</td>
</tr>
<tr>
<td>enabling environment protection</td>
<td>135</td>
</tr>
<tr>
<td>enabling picture caching</td>
<td>143</td>
</tr>
<tr>
<td>enabling toolbar docking</td>
<td>163</td>
</tr>
<tr>
<td>environment protection</td>
<td>51</td>
</tr>
<tr>
<td>environments</td>
<td></td>
</tr>
<tr>
<td>changing the start-up</td>
<td>79</td>
</tr>
<tr>
<td>configuration</td>
<td>50</td>
</tr>
<tr>
<td>described</td>
<td>50</td>
</tr>
<tr>
<td>run-time</td>
<td>50</td>
</tr>
<tr>
<td>switching between</td>
<td>50</td>
</tr>
<tr>
<td>environments</td>
<td>133</td>
</tr>
<tr>
<td>exception-based processing</td>
<td>13</td>
</tr>
<tr>
<td>Experts</td>
<td></td>
</tr>
<tr>
<td>and the Task Wizard</td>
<td>57</td>
</tr>
<tr>
<td>using signing in the Pharmaceutical demo</td>
<td>236</td>
</tr>
<tr>
<td>Experts</td>
<td>236</td>
</tr>
<tr>
<td>exploring Trending</td>
<td>236</td>
</tr>
<tr>
<td>expression builder</td>
<td>147</td>
</tr>
<tr>
<td>expressions</td>
<td>147</td>
</tr>
<tr>
<td><strong>F</strong></td>
<td></td>
</tr>
<tr>
<td>file server</td>
<td></td>
</tr>
<tr>
<td>using to share files among nodes</td>
<td>173</td>
</tr>
<tr>
<td>file server</td>
<td>173</td>
</tr>
<tr>
<td>files</td>
<td></td>
</tr>
<tr>
<td>backing up and restoring</td>
<td>177</td>
</tr>
<tr>
<td>saving backup</td>
<td>78</td>
</tr>
<tr>
<td>sharing</td>
<td>15</td>
</tr>
<tr>
<td>sharing among nodes</td>
<td>173</td>
</tr>
<tr>
<td>storing</td>
<td>15</td>
</tr>
<tr>
<td>files</td>
<td>128</td>
</tr>
<tr>
<td>filtering data sources</td>
<td>148</td>
</tr>
<tr>
<td>finding data</td>
<td>152</td>
</tr>
<tr>
<td>folders</td>
<td>127</td>
</tr>
<tr>
<td>full screen</td>
<td>145</td>
</tr>
<tr>
<td>globally translating picture text</td>
<td>142</td>
</tr>
<tr>
<td><strong>G</strong></td>
<td></td>
</tr>
<tr>
<td>hiding the system tree</td>
<td>127</td>
</tr>
<tr>
<td>hiding toolbars</td>
<td>162</td>
</tr>
<tr>
<td>HMI</td>
<td></td>
</tr>
<tr>
<td>functions</td>
<td>22</td>
</tr>
<tr>
<td>HMI</td>
<td>22</td>
</tr>
<tr>
<td><strong>I</strong></td>
<td></td>
</tr>
<tr>
<td>I/O drivers</td>
<td></td>
</tr>
<tr>
<td>using the OPC Toolkit</td>
<td>10</td>
</tr>
<tr>
<td>I/O drivers</td>
<td>21</td>
</tr>
<tr>
<td>Component</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------</td>
<td>------</td>
</tr>
<tr>
<td>iBatch</td>
<td>155</td>
</tr>
<tr>
<td>iClient</td>
<td>8</td>
</tr>
<tr>
<td>components</td>
<td>3</td>
</tr>
<tr>
<td>enabling</td>
<td>5</td>
</tr>
<tr>
<td>enabling</td>
<td>5</td>
</tr>
<tr>
<td>plug-in</td>
<td>4</td>
</tr>
<tr>
<td>components</td>
<td>3</td>
</tr>
<tr>
<td>iClient components</td>
<td>3</td>
</tr>
<tr>
<td>enabling</td>
<td>5</td>
</tr>
<tr>
<td>enabling</td>
<td>5</td>
</tr>
<tr>
<td>plug-in</td>
<td>4</td>
</tr>
<tr>
<td>importing</td>
<td>168</td>
</tr>
<tr>
<td>importing a</td>
<td>168</td>
</tr>
<tr>
<td>toolbar</td>
<td></td>
</tr>
<tr>
<td>electronic</td>
<td>211</td>
</tr>
<tr>
<td>books</td>
<td></td>
</tr>
<tr>
<td>Internet</td>
<td>4</td>
</tr>
<tr>
<td>iWebServer</td>
<td>4</td>
</tr>
<tr>
<td>Internet</td>
<td>4</td>
</tr>
<tr>
<td>iVisualize</td>
<td>4</td>
</tr>
<tr>
<td>working with iF</td>
<td>4</td>
</tr>
<tr>
<td>iVisualize</td>
<td>4</td>
</tr>
<tr>
<td>iWebServer</td>
<td>4</td>
</tr>
<tr>
<td>working with iF</td>
<td>4</td>
</tr>
<tr>
<td>iWebServer</td>
<td>4</td>
</tr>
<tr>
<td>K</td>
<td></td>
</tr>
<tr>
<td>keyboard</td>
<td>34</td>
</tr>
<tr>
<td>virtual</td>
<td>34</td>
</tr>
<tr>
<td>keyboard</td>
<td>34</td>
</tr>
<tr>
<td>keyless entry</td>
<td>34</td>
</tr>
<tr>
<td>L</td>
<td></td>
</tr>
<tr>
<td>local node</td>
<td>8</td>
</tr>
<tr>
<td>Locate button</td>
<td>213</td>
</tr>
<tr>
<td>login, security</td>
<td>19</td>
</tr>
<tr>
<td>M</td>
<td></td>
</tr>
<tr>
<td>message</td>
<td></td>
</tr>
<tr>
<td>routing</td>
<td>18</td>
</tr>
<tr>
<td>types</td>
<td>17</td>
</tr>
<tr>
<td>message</td>
<td>17</td>
</tr>
<tr>
<td>modifying</td>
<td></td>
</tr>
<tr>
<td>button properties</td>
<td>56</td>
</tr>
<tr>
<td>modifying</td>
<td>56</td>
</tr>
<tr>
<td>modifying</td>
<td>168</td>
</tr>
<tr>
<td>modifying</td>
<td>165</td>
</tr>
<tr>
<td>modifying an OPC server</td>
<td>169</td>
</tr>
<tr>
<td>monitoring</td>
<td>22</td>
</tr>
<tr>
<td>moving an object</td>
<td>127</td>
</tr>
<tr>
<td>N</td>
<td></td>
</tr>
<tr>
<td>navigating</td>
<td>221</td>
</tr>
<tr>
<td>through the</td>
<td></td>
</tr>
<tr>
<td>Sample System</td>
<td></td>
</tr>
<tr>
<td>demos</td>
<td></td>
</tr>
<tr>
<td>networking</td>
<td>14</td>
</tr>
<tr>
<td>nodes</td>
<td></td>
</tr>
<tr>
<td>blind SCADA</td>
<td>8</td>
</tr>
<tr>
<td>server</td>
<td></td>
</tr>
<tr>
<td>iClient</td>
<td>8</td>
</tr>
<tr>
<td>local</td>
<td>8</td>
</tr>
<tr>
<td>remote</td>
<td>8</td>
</tr>
<tr>
<td>run-time</td>
<td>8</td>
</tr>
<tr>
<td>SCADA server</td>
<td>8</td>
</tr>
<tr>
<td>stand alone</td>
<td>8</td>
</tr>
<tr>
<td>nodes</td>
<td>8</td>
</tr>
</tbody>
</table>
O

ODEC ................................................................. 9

OLE

using to access data ........................................ 9

OLE .............................................................. 10

OLE for Process Control (OPC) ....................... 5

on-demand data transfer ................................ 15

one-shot processing ...................................... 13

OPC

using with iFIX ............................................... 5

OPC ............................................................... 170

opc connection ............................................. 148

OPC connections ......................................... 146

OPC error preferences ................................ 146

OPC server

customizing error strings ............................... 79

OPC server .................................................. 169

OPC Toolkit ................................................ 10

open architecture ......................................... 25

Open Database Connectivity (ODBC) ............. 10

opening

document ..................................................... 52

opening ....................................................... 52

opening backup files .................................... 129

opening files .............................................. 129

opening folders ......................................... 127

operator messages ..................................... 17

overview

Chemical demo ........................................... 231

Discrete Manufacturing demo ....................... 229

of sample system ....................................... 217

Pharmaceutical demo .................................. 234

Water & Wastewater demo ......................... 229

overview .................................................... 229

P

passwords

entering ...................................................... 34

paths

specifying network path as iFIX path ........... 173

Pharmaceutical demo

overview .................................................... 234

signing when acknowledging alarms ............ 236

signing when starting and stopping the mixer 235

signing when using an Expert ..................... 236

viewing the audit trail from a relational database ...................... 236

Pharmaceutical demo .................................. 236

Pharmaceutical Manufacturing Demo ............ 226

picture caching ............................................. 143

picture layers

exploring in the Chemical demo ................... 231

exploring in the Water & Wastewater demo .... 231

picture layers .............................................. 231
Understanding iFIX

picture preferences .......................................... 142
picture text
  translating ................................................... 142
picture text ...................................................... 142
pictures
  creating ......................................................... 52
  setting preferences ........................................ 78
pictures ........................................................... 152
plug-in components, iFIX ................................... 4
pop-up window .................................................... 28
preferences
  animation error ............................................. 79
  charts ............................................................ 78
  configuring run-time ..................................... 78
  drawing options ............................................ 78
pictures ........................................................... 78
saving backup files ....................................... 78
setting in WorkSpace ...................................... 77
shapes ........................................................... 78
start-up environment ...................................... 79
primary blocks
  electronic books ........................................... 214
primary blocks .................................................. 11
process data flow .......................................... 10
process database ........................................... 11
process databases ........................................... 147
processing
  centralized .................................................... 16
  distributed ..................................................... 14
distributed ..................................................... 14
exception-based ............................................. 13
one-shot ....................................................... 13
time-based ..................................................... 13
processing ........................................................ 13
Proficy Batch Execution
  specifying a project ....................................... 207
  working with iFIX ......................................... 4
Proficy Batch Execution ....................................... 4
Proficy Historian
  disabling errors ........................................... 51
  working with iFIX ......................................... 4
Proficy Historian ................................................ 4
Proficy iFIX WorkSpace ..................................... 3
Proficy Machine Edition .................................... 4
Proficy Plant Applications
  working with iFIX ......................................... 4
Proficy Plant Applications .................................... 4
Proficy Real-Time Information Portal .................... 4
R
  refresh rate ................................................... 148
  remote node .................................................. 8
removing
  toolbar buttons ........................................... 55
removing ....................................................... 55
removing a button to a toolbar ............................ 163
renaming
  document in the system tree ......................... 52
toolbar categories ............................................ 56
renaming ............................................................ 56
renaming a category ........................................... 166
renaming files .................................................... 131
replacing data ..................................................... 153
reporting ............................................................. 24
resetting a standard toolbar ............................... 164
resetting filters .................................................... 149
restoring
files ..................................................................... 177
restoring ............................................................ 177
run mode
using in the Sample System ............................... 221
run mode ............................................................. 221
running Experts .................................................. 132
running schedules in the background ............... 146
run-time environment
configuring preferences ..................................... 78
described .......................................................... 50
run-time environment ......................................... 133
run-time node ...................................................... 8
run-time preferences .......................................... 145
S
SAC .................................................................. 12
Sample System
accessing other desktop applications ............... 220
exploring alarms and alarm counters ............... 238
exploring ToolTips ............................................. 232
exploring trending ............................................. 236
exploring VisiconX ............................................. 232
features demonstrated ..................................... 217
main menu ....................................................... 219
overview ........................................................ 217
requirements .................................................... 217
restrictions ....................................................... 217
starting ............................................................ 219
user account requirement ................................. 217
using configure and run modes ....................... 221
using Help ....................................................... 220
using with a Terminal Server ......................... 217
Sample System demos
navigating ........................................................ 221
understanding the alarm summary, Trending chart and reporting screens ........ 220
working with ................................................... 220
Sample System demos ........................................ 220
Sample System Help
displaying ToolTips ........................................... 220
getting Help for an object or picture ................. 220
Sample System Help ........................................... 220
save preferences ................................................. 144
saving
backup files ..................................................... 78
document ......................................................... 52
saving ............................................................. 52
saving backup files ........................................... 144
Understanding iFIX

saving files ...................................................... 130
saving files automatically ............................... 130

SCADA server .................................................... 8

Scan, Alarm, and Control program ............... 12
Scheduler .......................................................... 13

schedules
 creating ......................................................... 52
schedules ........................................................ 152

scripting
 in iFIX ............................................................ 5
using VBA ...................................................... 5
scripting .............................................................. 5

scripts ............................................................. 166

SCU
 configuring your local computer ............. 173
path definitions for system tree .............. 46
starting ........................................................ 173

SCU ............................................................... 150

Search tab
 electronic books ............................. 211
Search tab ....................................................... 211

searching data ............................................. 152
secondary blocks ........................................... 11
secure containment ................................. 5
security
 areas.......................................................... 18

configuration ................................................. 19
login .............................................................. 19

security ........................................................ 18
selecting a data source .............................. 147
sessions .......................................................... 14

setting chart preferences .......................... 144
setting drawing preferences ..................... 144
setting OPC connection error preferences ..... 146
setting picture preferences ....................... 142

setting preferences ........................................

WorkSpace ................................................... 77
setting shape preferences ......................... 143

setting up DCOM support in the WorkSpace . 170
shape preferences ........................................... 143

shapes
 setting preferences ....................................... 78
shapes ............................................................. 78

sharing
 files among nodes ...................................... 173
sharing ........................................................... 173
sharing files ............................................... 150
showing the system tree.............................. 127
showing toolbars ........................................... 162

sorting fields in the tag list....................... 149
Specialty Chemical Demo ....................... 224
specify the tolerance ................................. 148

specifying
 network path as iFIX path ......................... 173
| Specifying                                      | 173 |
| Specifying the deadband                        | 148 |
| Specifying the refresh rate                    | 148 |
| SQL                                            | 10  |
| Stand alone node                               | 8   |
| Starting and stopping the mixer                | 235 |
| Signing in the Pharmaceutical demo             | 235 |
| Starting iFIX applications                     | 131 |
| Starting in the configuration environment      | 134 |
| Starting in the run-time environment           | 133 |
| Starting sample system                         | 219 |
| Start-up                                        | 79  |
| Changing the environment                       | 79  |
| Structured Query Language                      | 10  |
| Supervisory control                            | 23  |
| Switching                                      | 50  |
| Between WorkSpace environments                 | 50  |
| Switching                                      | 50  |
| Switching environments                         | 133 |
| System applications                            | 26  |
| System messages                                | 17  |
| System tree                                    | 44  |
| Item description                               | 44  |
| Navigating                                     | 47  |
| Paths                                          | 46  |
| Resizing                                       | 46  |
| Right-clicking                                 | 49  |
| Showing and hiding                             | 46  |
| Starting an application                        | 50  |
| System tree                                    | 126 |

**T**

| Tag groups                                      | 230 |
| Tag groups                                     | 230 |
| Tag list                                       | 149 |
| Task Wizard                                    | 132 |
| Terminal Server                                | 217 |
| Using with Sample System                       | 217 |
| Time-based processing                          | 13  |
| Tolerance                                      | 148 |
| Toolbar buttons                                | 162 |
| Toolbar categories                             |     |
| Adding                                         | 56  |
| Adding buttons                                 | 56  |
| Copying                                        | 57  |
| Defined                                        | 55  |
| Deleting                                       | 56  |
| Renaming                                       | 56  |
Understanding IFIX

toolbar categories ........................................... 167

toolbars

adding buttons .............................................. 55
adding categories .......................................... 56
application .................................................... 53
arranging buttons .......................................... 55
configuring buttons ....................................... 56
copying categories ........................................ 57
creating ......................................................... 55
creating buttons ............................................ 56
customizing .................................................. 55
deleting ......................................................... 55
deleting buttons from a category .................. 56
deleting categories ........................................ 56
importing ...................................................... 57
modifying a button's properties .................... 56
modifying properties .................................... 55
owners .......................................................... 54
removing buttons .......................................... 55
renaming categories ...................................... 56
resetting ........................................................ 55
sharing ........................................................ 57
showing and hiding ....................................... 54
utilities .......................................................... 53
WorkSpace ................................................... 53
toolbars ........................................................... 162

ToolTips

exploring in the Chemical demo ............... 232

toolTips ...........................................................232
touch-screen environment ......................... 34

translations ...................................................... 142
trending ........................................................... 236
troubleshooting OPC server installations ..... 170

U

Universal Data Access .................................... 9
user applications ............................................... 26
user configuration applications ......................... 26

using configure and run modes in sample system ...........................................221
using Help in Sample System .......................... 220

utilities toolbar ..................................................53

V

VBA

using the Visual Basic Editor ....................... 27

writing scripts ............................................... 79

VBA ................................................................. 5
VBE ................................................................. 5

virtual keyboard ................................................ 34

VisiconX

exploring in the Chemical demo ............... 232

VisiconX ........................................................... 232

Visual Basic Editor
<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>described</td>
<td>27</td>
</tr>
<tr>
<td>displaying</td>
<td>79</td>
</tr>
<tr>
<td>Visual Basic Editor</td>
<td>131</td>
</tr>
<tr>
<td>Visual Basic Editor (VBE)</td>
<td>5</td>
</tr>
<tr>
<td>Visual Basic for Applications (VBA)</td>
<td>5</td>
</tr>
<tr>
<td>Water &amp; Wastewater Demo</td>
<td>222</td>
</tr>
<tr>
<td>Water &amp; Wastewater Demo</td>
<td>222</td>
</tr>
<tr>
<td>work area</td>
<td>33</td>
</tr>
<tr>
<td>WorkSpace</td>
<td>52</td>
</tr>
<tr>
<td>WorkSpace command line parameters</td>
<td>28</td>
</tr>
<tr>
<td>customizing toolbars</td>
<td>55</td>
</tr>
<tr>
<td>displaying full screen</td>
<td>50</td>
</tr>
<tr>
<td>enabling environment protection</td>
<td>51</td>
</tr>
<tr>
<td>iFIX</td>
<td>3</td>
</tr>
<tr>
<td>moving objects</td>
<td>49</td>
</tr>
<tr>
<td>saving backup files</td>
<td>78</td>
</tr>
<tr>
<td>setting animation error preferences</td>
<td>79</td>
</tr>
<tr>
<td>setting user preferences</td>
<td>77</td>
</tr>
<tr>
<td>specifying an iBatch project</td>
<td>207</td>
</tr>
<tr>
<td>starting</td>
<td>27</td>
</tr>
<tr>
<td>starting an application</td>
<td>50</td>
</tr>
<tr>
<td>start-up options</td>
<td>79</td>
</tr>
<tr>
<td>system tree</td>
<td>32</td>
</tr>
<tr>
<td>toolbar</td>
<td>53</td>
</tr>
<tr>
<td>working with documents</td>
<td>52</td>
</tr>
</tbody>
</table>